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Using Avaya FPM 
Overview 

Introduction to Avaya Fault and Performance Manager 
Avaya Fault and Performance Manager (FPM) lets you monitor and manage all of your voice 
systems from a single point.  

• FPM alerts you when voice system faults and performance problems occur. 

• FPM helps you isolate and identify fault and performance problems. 

• FPM provides tools to help you fix fault and performance problems.  

FPM collects configuration, fault, and performance data from your systems according to a 
schedule that you specify. FPM keeps a database of system exceptions and performance 
measurements, and it allows you to run reports on that data. You can present the data as text, 
tables, and graphs. 

In addition to monitoring your voice systems, FPM also provides alarm management (not 
performance monitoring) for several adjuncts related to your voice systems including INTUITY 
Audix, DEFINITY Audix, Call Management System (CMS), Conversant, and INTUITY 
Interchange.  

FPM supports up to 300 systems (with three servers) in a distributed environment.  

Features 

Fault and Performance Manager provides the following features: 

• Alarm Reception and Forwarding — Detects alarms from your voice system (or other 
Avaya system) and relays them to the Avaya Technical Service Center. 

• Configuration Display — Enables you to browse the configuration and administered 
properties of managed nodes. 

• Notes Page for each Voice System — Enables you to create your own knowledge 
database. 

• Cut Through — Provides access to your voice systems to perform routine maintenance 
and administrative tasks. 

• System Status Reporting — Creates reports about the status of your voice systems. 
Includes information such as connection state, connect times, attempts, requests, errors, 
and alarms forwarded. You can define a wide variety of tabular and graphical reports 
covering performance, configuration, and exception data from any combination of 
systems. You can restrict reports to components of interest; for example, a specific 
hardware location or a list of trunk groups. 

• Report Scheduling — Enables you to schedule when each report runs. Reports can be 
printed or saved to a file. 

• Data Collection — Enables you to specify the types of data to collect from each system, 
the schedule for collecting the data, and how long to store the data. 

• Exception Logging — Enables you to specify conditions for exception logging. This 
includes performance thresholds and fault or error conditions. 

• Exception Alerting — Enables you to specify an alert level for each exception. The level 
and location of the alert are displayed in the Configuration and Status window as long as 
the condition persists. 
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Related Topics 

• Data Flow 

• Screen Organization 
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Data Flow 
Data Flow 

FPM has four data sources that provide the basis for all monitoring and reporting: 

• Configuration data is collected at intervals that you specify. 

• Performance data is collected according to specified data type and collection interval. 
Data can be collected for hourly values, daily peak, or weekly peak. 

• Adjunct Exceptions are collected in real-time. You specify which data to collect, and how 
to process that data. 

• Voice System Exceptions are collected in real-time. You define a set of filters that 
specifies which data to collect, and how to process that data. 

Only the specified data is stored in the database. 
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The Configuration and Status screen and the System Detail screen display status and 
performance based on the configuration, performance, and exception data in the database. 
Accurate status depends upon the necessary exceptions having been processed and saved. 
Accurate performance data depends upon the necessary performance data having been 
collected and saved. 

The Report Manager defines and schedules reports using inventory, performance, and exception 
data from the database. Accurate reporting depends upon the necessary performance and 
exception data having been processed and saved. 

Related Topics 

• Default and Custom System Parameters (Configuration Collection Panel, Performance 
Collection Panel) 

• Configuration Collection Panel 

• Performance Collection Panel 

• Alarms/Errors Panel 

• Alarm Filter Panel 

• Report Manager Screen 

• Report Definition Screen 

• Scheduled Reports 

• Report Types (Inventory, Performance, Exception) 
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Screen Organization 
FPM initially displays the Configuration and Status screen.  

 

 

 

The Configuration and Status screen divides your voice systems into convenient system groups. 
The highest alert level (critical, major, minor, warning) found in any member of a system group 
displays at the group level. 

• Within each system group, individual systems are listed. The highest alert level found in 
any component of a system displays at the system level. Selecting a system displays a 
summary report for that system. The summary report includes counts of critical, major, 
minor, and warnings within the system. The summary report also provides basic 
performance and status information for that system. 

• The Detail button on the system summary report provides access to configuration 
information for that system. Clicking Detail opens the System Detail screen. The kinds of 
configuration details available depends on the type of the selected system, but detail is 
generally available all the way down to the lowest level (usually individual ports). 

• The Exceptions button on the system summary report (or on any system detail screen) 
provides a list of exceptions for the system. Clicking Exceptions opens the Voice System 
Exceptions screen. Two lists of exceptions are controlled by a drop-down list: exceptions 
in the selected system (or component), and exceptions involving FPM communication 
with the selected system (or component). 

From the File menu of the Configuration and Status screen you can select File > 
Administration... to open the FPM Administration screen or File > Report Manager... to open 
the FPM Report Manager screen. 
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• The FPM Administration screen has two functions: 

 The FPM Administration screen defines how the system fault and performance 
data is collected and stored by FPM.  

You can define a system-wide template of default parameter values. Each 
system can use the default template or can override the template with values 
specific to that system. Parameters include the data to collect, the collection 
schedule, and the filtering to apply to exceptions to create alarms. 

 The FPM Administration screen defines the system views available through FPM. 

You can define the group names and membership for multiple views of your 
network based on system groups, IP or DCS trunk groups, or clusters.  

• The FPM Report Manager screen provides: 

 Report Definitions 

You can select report types, systems, and other parameters for each report. You 
can schedule when reports are run on a regular basis. You can create ad-hoc 
reports and run them immediately when investigating a problem. You can also 
define reports, but not run them until needed to get specific information while 
trouble shooting. 

 Scheduled Reports 

You can select any  regularly scheduled report that has been saved to a file and 
display it or print it. 

 Trunk Group Lists 

You can define trunk group lists for reports that are based on network 
performance rather than system performance. 

Related Topics 

• Main Configuration and Status Screen 

• System Detail Screen 

• Administration Screen 

• Report Manager Screen 

 

 



Using Avaya FPM 

7 

Configuration and Status 
Main Configuration and Status Screen 

FPM initially displays the Configuration and Status screen. This screen divides your voice 
systems into convenient system groups. The highest alert severity level (critical, major, minor, 
warning) found in any member of a system group displays at the group level. 

 

 

The tabs select 
different types of 
system grouping. 
Within each group, 
individual systems 
are listed. The 
highest alert level 
found in any 
component of a 
system displays at 
the system level. The 
display for system 
groups is shown. The 
displays for DCS 
Trunk Connectivity 
groups, IP Trunk 
Connectivity groups, 
and Clusters are 
similar. 
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The tabs select 
different types of 
system grouping. 
Within each group, 
individual systems 
are listed. The 
highest alert level 
found in any 
component of a 
system displays at 
the system level. The 
display for system 
groups is shown. The 
displays for DCS 
Trunk Connectivity 
groups, IP Trunk 
Connectivity groups, 
and Clusters are 
similar. 

 

Selecting a voice 
system displays a 
summary report for 
that system. The 
summary report 
includes counts of 
critical, major, minor, 
and warnings within 
the system. The 
summary report also 
provides basic 
performance and 
status information for 
that system. 

The change status 
drop-down selects 
whether the 
connection status is 
maintained UP, set 
OFF, or 
Dynamic(ally) 
connected and 
disconnected as 
needed. 

Additional information 
panels are not 
shown. 
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The tabs select 
different types of 
system grouping. 
Within each group, 
individual systems 
are listed. The 
highest alert level 
found in any 
component of a 
system displays at 
the system level. The 
display for system 
groups is shown. The 
displays for DCS 
Trunk Connectivity 
groups, IP Trunk 
Connectivity groups, 
and Clusters are 
similar. 

 

Selecting a voice 
adjunct displays a 
summary report for 
that adjunct. The 
summary report 
includes counts of 
critical, major, minor, 
and warnings within 
the system. The 
summary report also 
provides basic 
performance and 
status information for 
that system. 

 

The Configuration and Status screen provides access to all other system functions. The tabs 
determine what type of groups display in the Navigation panel. The Display panel shows group 
members or a summary for a selected system. 

Navigation to other screens is shown and described below. 
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• File > Administration... opens the FPM Administration screen. 

• File > Report Manager... opens the FPM Report Manager screen. 

• View > Capacity... generates and opens the Capacity Report. 

• View > Performance Data... opens the New Report dialog box. 

• View > Inventory... generates and opens the Board Inventory Report. 

• View > Boards... generates and opens the Board Report. 

• File > LaunchApps > <application name> launches the selected cut-through 
application. 

• The Detail button on the system summary report provides access to configuration 
information for that system. Clicking Detail opens the System Detail screen. The kinds of 
configuration details available depends on the type of the selected system, but detail is 
generally available all the way down to the lowest level (usually individual ports). 

• The Exceptions button on the system summary report (or on any system detail screen) 
provides a list of exceptions for the system. Clicking Exceptions opens the Voice System 
Exceptions screen. Two lists of exceptions are controlled by a drop-down list: exceptions 
in the selected system (or component), and exceptions involving FPM communication 
with the selected system (or component). 

• Selecting a specific exception and then selecting Tools > TroubleShoot > Helper from 
the Voice System Exceptions screen displays the Communication Manager help page 
related to the selected exception type.  

• A quick cut through to the selected system is available by selecting Tools > 
TroubleShoot > SAT Connection... from the Voice System Exceptions screen. 
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Group Type Tabs 

A tab bar appears near the top of the Configuration and Status screen. Selecting a tab 
determines how the systems are grouped. You may select whatever tab provides the most 
convenient view. 

• System Groups 

The Systems Groups Tab provides user defined groups of systems for convenience in 
viewing network status and performance. 

• DCS Trunk Connectivity 

The DCS Trunk Connectivity Tab provides systems grouped by DCS trunk connectivity 
for convenience in viewing network status and performance. 

• IP Trunk Connectivity 

The IP Trunk Connectivity Tab provides systems grouped by IP trunk connectivity for 
convenience in viewing network status and performance. 

• Clusters 

The Clusters Tab provides access to ESS or LSP information. 

Related Topics 

• Administration Screen. 

• Report Manager Screen. 

• Cut-Through Applications. 

• System Detail screen. 

• Voice System Exceptions screen. 

• Board Inventory Report 

• Board Report 

• New Report Dialog Box 
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Group Type Tabs 

System Groups Tab 

The Systems Groups Tab provides user defined groups of systems for convenience in viewing 
network status and performance. 

When viewing by system groups, the object tree uses the following hierarchy:  

System Group (graphic or tabular display) 

System  

Sever Status 

System Status  

Cabinets  

Carriers  

Boards (or ATM Boards) 

Ports (general, data module, or trunk) 

MGStacks  

Stack 

MediaGateway  

Media Module  

Ports (if applicable) 

Port Networks  

Port Network Connectivity (if applicable) 

DCS Links  

Stations with Exceptions  

Data Modules  

Trunk Groups  

Routing Patterns  

External Devices  

Bulletin Board  

Related Topics 

• DCS Trunk Connectivity Tab  

• IP Trunk Connectivity Tab  

• Clusters Tab  
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DCS Trunk Connectivity Tab 

The DCS Trunk Connectivity Tab provides systems grouped by DCS trunk connectivity for 
convenience in viewing network status and performance. 

When viewing by DCS trunk connectivity, the object tree uses the following hierarchy:  

System Group (graphic or tabular display) 

System  

System Status  

Sever Status 

Cabinets  

Carriers  

Boards (or ATM Boards) 

Ports (general, data module, or trunk) 

MGStacks  

Stack 

MediaGateway  

Media Module  

Ports (if applicable) 

Port Networks  

Port Network Connectivity (if applicable) 

DCS Links  

Stations with Exceptions  

Data Modules  

Trunk Groups  

Routing Patterns  

External Devices  

Bulletin Board  

Related Topics 

• System Groups Tab  

• IP Trunk Connectivity Tab  

• Clusters Tab  
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IP Trunk Connectivity Tab 

The IP Trunk Connectivity Tab provides systems grouped by IP trunk connectivity for 
convenience in viewing network status and performance. 

When viewing by IP trunk connectivity, the object tree uses the following hierarchy:  

 

System Group (graphic or tabular display) 

System  

System Status  

Sever Status 

Cabinets  

Carriers  

Boards (or ATM Boards) 

Ports (general, data module, or trunk) 

MGStacks  

Stack 

MediaGateway  

Media Module  

Ports (if applicable) 

Port Networks  

Port Network Connectivity (if applicable) 

DCS Links  

Stations with Exceptions  

Data Modules  

Trunk Groups  

Routing Patterns  

External Devices  

Bulletin Board  

Related Topics 

• System Groups Tab  

• DCS Trunk Connectivity Tab  

• Clusters Tab  



Using Avaya FPM 

15 

Clusters Tab 

The Clusters Tab provides access to ESS or LSP information. 

When viewing by cluster information, the object tree uses the following hierarchy: (click a link 
below to learn about that screen) 

For Clusters, the tree uses the following hierarchy:  

Cluster Groups (graphic or tabular display) 

ESS Clusters 

ESS Configuration 

LSP Clusters 

LSP Configuration 

Related Topics 

• System Groups Tab  

• IP Trunk Connectivity Tab  

• DCS Trunk Connectivity Tab  
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System Detail Screen 

The System Detail screen displays information about components of a system or adjunct. The 
Detail button on the system summary report of the main Configuration and Status screen opens 
the System Detail screen.  The Navigation panel shows the breakdown of available information.  
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The kinds of configuration details available depend on the 
type of the selected system, but detail is generally available 
all the way down to the lowest level (usually individual 
ports). 

 

Navigation to other screens is described below. 

• The Detail button appears on some system detail screens. Clicking Detail provides 
additional information when available. 

• The Exceptions button appears on some system detail screens. It provides a list of 
exceptions for the system component currently displayed. Clicking Exceptions opens the 
Voice System Exceptions screen. Two lists of exceptions are controlled by a drop-down 
list: exceptions in the selected system (or component), and exceptions involving FPM 
communication with the selected system (or component). 

• Selecting a specific exception and then selecting Tools > TroubleShoot > Helper from 
the Voice System Exceptions screen displays the Communication Manager help page 
related to the selected exception type.  

• A quick cut through to the selected system is available by selecting Tools > 
TroubleShoot > SAT Connection... from the Voice System Exceptions screen. 

• File > Administration... opens the FPM Administration screen. 

• File > Report Manager... opens the FPM Report Manager screen. 

• File > LaunchApps > <application name> launches the selected cut-through 
application. 

Related Topics 

• Voice System Exceptions screen 

• Administration Screen 

• Report Manager Screen 

• Cut-Through Application 
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Configuration and Status Display 

Fault and Performance Manager’s main window displays status and configuration information 
about your Avaya network.  

FPM can also forward status information to a general purpose Network Management System 
(NMS). Usually, however, general purpose NMS's cannot display detailed configuration 
information. 

The table below shows objects in your network that you can view. 

 

To view Do this 

ATM boards • Open the System Group 

• Select the Voice System 

• Click Details 

• Select the Cabinet 

• Select the Carrier 

• Click a board 

boards (including  
IP SERVER INTFC 
boards) 

• Open the System Group 

• Select the Voice System 

• Click Details 

• Select the Cabinet 

• Select the Carrier 

• Click a board 

Bulletin boards • Open the System Group 

• Select the Voice System 

• Click Details 

• Click Bulletin Board 

cabinets • Open the System Group 

• Select the Voice System 

• Click Details 

• Click a cabinet 

DCS connectivity • Open the System Group 

• Select the Voice System 

• Click Details 

• Click DCS Links 

DCS links • Open the System Group 

• Select the Voice System 

• Click Details 

• Click DCS Links 
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To view Do this 

data modules • Open the System Group 

• Select the Voice System 

• Click Details 

• Click Data Modules 

external devices • Open the System Group 

• Select the Voice System 

• Click Details 

• Click External Devices 

media gateway stacks • Open the System Group 

• Select the Voice System 

• Click Details 

• Click MGStacks 

media gateway • Open the System Group 

• Select the Voice System 

• Click Details 

• Select MGStacks 

• Click the media gateway 

media servers • Open the System Group 

• Select the Voice System 

• Click Details 

• Click the media server  

ports • Open the System Group 

• Select the Voice System 

• Click Details 

• Select the Carrier 

• Select the Cabinet 

• Click the port 

port networks • Open the System Group 

• Select the Voice System 

• Click Details 

• Click Port Networks 

system groups • Click the System Group 

trunk groups • Open the System Group 

• Select the Voice System 

• Click Details 

• Click Trunk Groups  
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To view Do this 

voice system • Open the System Group 

• Click the Voice System 

 

Related Topics 

• Main Configuration and Status Screen 

• System Detail Screen 
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Troubleshooting 

Voice System Exceptions Screen (Online) 

Voice system exceptions display when you click Exceptions on any screen on which it appears. 
The exceptions shown will be limited to current exceptions appropriate for the selected item on 
the screen containing the Exceptions button. 

You can also run or schedule Voice System Exception reports from the Report Manager screen. 
When run from Report Manager screen, you can specify the contents and time period to be 
covered. NOTE: the data displayed is different when this report is run from the Report Manager. 
Please see Exceptions: Voice System. 

 

Fields 

There are two types of exceptions shown, depending on the setting of the drop-down list: 

 



Avaya Fault & Performance Manager User Guide 

22 

• Voice System Exceptions (primary data) occur on the voice system itself. The following 
fields display: 

Column Contains 

Severity Alert Severity (key) 

Type Type (key) 

Voice System Voice System (key) 

Location Hardware Location (key) 

Equip Type Equipment Type 

Equip ID Equipment ID 

Voice System Start Voice System Start Date and Time (key) 

Voice system End Voice system End Date and Time (key) 

Description The Description field may contain trap data fields as well as a 
brief description of the problem. 

AlmNum Alarm number 

Alert Alert 

Exc DB ID Exception Database ID 

• Fault/Performance Manager Exceptions occur when there are communication events 
or difficulties between FPM and a voice system. The following fields display: 

Column Contains 

Severity Alert Severity (key) 

Type Type (key) 

Voice System Voice System (key) 

NMS Start NMS Start Date and Time (key) 

NMS End NMS End Date and Time (key) 

Alert Alert 

Description Description 

Exc DB ID Exception Database ID 
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Configuration 

You can view the configuration associated with an exception by clicking on the exception to 
highlight it and then selecting Tool > Configuration. 

 

This opens a window showing the configuration associated with the highlighted exception. 
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Performance Threshold Records 

You can view the performance threshold records associated with an exception by clicking on the 
exception to highlight it and then selecting Tool > Performance Threshold Records. 
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This opens a window showing the specific performance threshold records associated with the 
highlighted exception. 

 

Associated Errors 

You can view the errors associated with an exception by clicking on the exception to highlight it 
and then selecting Tool > Associated Errors.  

 

This opens the Errors for Alarm # screen showing the specific errors associated with the 
highlighted exception. 
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DEFINITY Error Description 

From the Errors for Alarm # display, double click on any entry for a description of the error. 

 

You can enter notes in the Notes box. To save your notes, click Save.  
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Notes are tied to a specific Maintenance Name, Error Code, and Aux Data. For Example: 

Maintenance Object: DIG-LINE  
Error Code: 2817 
Aux Data: 0  

You can enter customer notes, and when a Digital Line 2817 error code, with aux data 0 occurs 
on some other station or switch, and you double-click on the error entry, it will show what you 
entered and saved from before.  

To close the dialog box, click Close. 

Help Desk Feature 

You can view additional information about an exception by clicking on the exception to highlight it 
and then selecting Tool > TroubleShoot > Helper. This opens the Communication Manager 
manual page describing the selected exception. The manual page may suggest additional tests 
or corrective actions that can be accomplished using the SAT. 

 

 

You can get directly to the SAT by selecting Tool > TroubleShoot > SAT Connection.... This 
opens the Login dialog box for the selected system. You must have a user account and password 
on the selected system to use the SAT connection. 

 

For some hardware types, you can use the automated assistant to automatically run additional 
test and/or corrective actions by simulating the SAT. You activate the Assistant by selecting Tool 
> TroubleShoot > Assistant. 
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For additional information, please see Help Desk Feature. 

Related Topics 

• Cut-Through Applications 

• Exceptions: Voice System 

• Help Desk Feature 
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Help Desk Feature 

When you have highlighted an exception by clicking on its row, you can invoke the Help Desk 
Feature. 

 

 

Help Desk Helper 

You can view additional information about an exception by clicking on the exception to highlight it 
and then selecting Tool > TroubleShoot > Helper. This opens the Communication Manager 
manual page describing the selected exception. The manual page may suggest additional tests 
or corrective actions that can be accomplished using the SAT. 
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Help Desk SAT Connection 

You can get directly to the SAT by selecting Tool > TroubleShoot > SAT Connection.... This 
opens the Login dialog box for the selected system. You must have a user account and password 
on the selected system to use the SAT connection. 

 

 

Help Desk Assistant 

For some hardware types, you can use the Help Desk Assistant to automatically run additional 
test and/or take corrective actions by simulating the SAT. You activate the Assistant by selecting 
Tool > TroubleShoot > Assistant.  

  Note: 

If the hardware type you wish assistance troubleshooting is not currently 
supported by the assistant, you will get a message box indicating that the module 
for that hardware type is not available. 
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The Assistant displays its actions as they are taken. 

 

 

Click display rules to see the specific rules for automated troubleshooting. 
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The results of each test are reported as the test completes. 

 

 

When the Assistant finishes, it reports its conclusions about the problem as a configuration and 
status display for the selected device. 
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You may then take additional action as you feel necessary. 

Related Topics 

• Cut-Through Applications 
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Board Inventory Report (Online) 

The Online Board Inventory Report shows all boards (circuit packs) by type, code, and vintage. It 
is generated from the Configuration and Status screen or the System Detail screen by selecting 
View > Inventory. The inventory include all boards appropriate for the currently selected location. 

 

Fields 

Column  Contains 

Voice System Voice System name 

Type Board type 

Code Hardware and Firmware vintage codes 

Vintage Board vintage code 

Count Count of boards of same type, code, and vintage. 
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Related Topics 

• Configuration Board Inventory Report 
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Board Report (Online) 

The Online Board Report shows a list of installed boards (circuit packs). It is generated from the 
Configuration and Status screen or the System Detail screen by selecting View > Boards.... It 
includes all boards appropriate for the currently selected location. 

 

Fields 

Column Contains 

Severity Alert severity Icon 

Voice System Voice System name 

Location Board Location 

Code Board Code and Suffix 

Vintage Hardware and Firmware versions 
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Column Contains 

Type Board Type 

AssignPorts Count of assigned ports 

UnassignPorts Count of unassigned ports 

TTIPorts Count of TTI ports 

PSAPorts Count of PSA ports 

TotPorts Total number of ports 

PN/SN Port Network or Switch node number 

SigType Signalling Type 

Name Board Name 

CSU ID CSU module ID 

Related Topics 

• Configuration Board Report 
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Capacity Report (Online) 

The Capacity Report provides used and available capacity information for a switch. The inventory 
is filtered automatically based on the current position in the Configuration and Status or System 
Detail screen. 

 

Fields 

Column Contains 

Name Voice System name 

Switch Type Voice System type 

Building Location Voice System Location 

# if Cabinets Number of cabinets 

# of Carriers (in use) Number of carriers in use 

# of Unused Carriers Number of spare carriers 

Total Slot Total slots available 

Used Slot Number of slots used 

Spare Slot Number of slots available 

Total Digital Ports Total digital ports 

Used Digital Ports Number of digital ports used 

Spare Digital Ports Number of digital ports available 

Total Analog Ports Total analog ports 
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Column Contains 

Used Analog Ports Number of analog ports used 

Spare Analog Ports Number of analog ports available 

Total License Ports Total licensed ports 

Used Licensed Ports Number of licensed ports used 

Spare Licensed Ports Number of licensed ports available 

Total X Mobility  

Used X Mobility  

Spare X Mobility  

Total IP Stations Total IP stations 

Used IP Stations Number of IP stations used 

Spare IP Stations Number of IP stations available 

Total DS1s Total DS1 trunks 

Total Trunk Ports Total trunk ports 

Total Station Total stations 

ACD License ACD license included 

Related Topics 

• Configuration Capacity Report 
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Performance Report (Online) 

Selecting View > Performance Data... from the Configuration and Status screen or the System 
Detail screen takes you directly to the New Report dialog box where you can define the 
performance report you want and run it immediately. 

Related Topics 

• New Report dialog box 
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Cut-Through Applications 

You can directly access network management systems through the LaunchApps menu on the 
Configuration and Status screen. 

 

 

The available applications depend on your network components. 

• ASA — Avaya Site Administration 

• MgDeviceMgr — Avaya Media Gateway Device Manager 

• MSA — Multi-Site Administration 

• SMON — Switch Monitoring 

• VAM — Voice Announcement Manager 

• VMM — Voice over IP Monitoring Manager  

Related Topics 

• Help Desk Feature 

• Voice System Exceptions 
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Administration 
Administration Screen 

From the File menu of the Configuration and Status screen you can select File > 
Administration... to open the FPM Administration screen. 

  Note: 

A submenu displays when you select File > Administration... and there is more 
than one administration server available. The submenu lists the primary 
administration server IP address at the top followed by any other available 
administration servers. After you select one of the servers, the FPM 
Administration screen opens. 

 

 

The FPM Administration screen has two functions: 

• The FPM Administration screen defines how the system fault and performance data is 
collected and stored by FPM.  

You can define a system-wide template of default parameter values. Each system can 
use the default template or can override the template with values specific to that system. 
Parameters include the data to collect, the collection schedule, and the filtering to apply 
to exceptions to create alarms. The following parameter groups can be defined: 

 Configuration Collection 

 Trunk Exceptions 

 Alarms/Errors 

 Performance Collection 

 Processor Occupancy 

 Trunk Group Exceptions 

 Adjunct Alarms/Errors 
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• The FPM Administration screen defines the system views available through FPM. 

You can define the group names and membership for multiple views of your network 
based on system groups, IP or DCS trunk groups, or clusters. The following parameter 
groups can be defined: 

 System Exceptions 

 System Groups 

 DCS Groups 

 IP Trunk Groups 
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Collecting Data 

Filtering Alarms (Alarm Filter Panel) 

The Alarm Filter Panel gives you detailed control of alarm collection and processing. You specify 
a set of parameters to filter out a selected set of alarms. Additional parameters define how often 
alarm collection occurs, and what actions to take when an alarm is received. 

Use this panel to View, Add, Modify, and Delete parameters for alarm filtering. 

• Default Alarm/Error Panel 

The default Alarm/Error panel appears under Administration Root > Default 
Parameters > Alarms/Errors.  

The default alarm filters apply to all systems except those where custom alarm filters have been 
defined. 

• Custom Alarm/Error Panel 

The custom Alarm/Error panel appears under Administration Root > Voice System 
Parameters > [system name] > Alarms/Errors.  

For each voice system, collection can be on or off. Each voice system can use either the 
default alarm filter parameter values, or custom alarm filter parameters.  

Viewing Alarm Filters 

Defined alarm filters are displayed as a scrolling list: 
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Selecting an alarm filter (or clicking Add) opens the selected filter (or a new filter) in the Alarm 
Filter Configurator.  

 

 

Filter Parameters: These parameters are shown in each row of the Alarm Filters panel, and in 
the upper section of the Alarm Filter Configurator used to define or edit alarm filters. 

• Filter Type: Select the type of alarm to be filtered: 

 Definity Alarms: Alarms collected from the Communication Managers and 
maintenance objects in the Communication Managers. 

 Note: 

Definity Alarms now includes the previous filter type: Traps. Selection 
of Definity Alarms now provides both filtering on FPM and setting filters 
on the platform. Traps is no longer available. 

 Restart Alarms: Restarts of the Communication Managers. 

 Note: 

Restart Alarms now includes the previous filter type: Restarts. 
Selection of Restart Alarms now provides both filtering on FPM and 
setting filters on the platform. Restarts is no longer available. 

 Server Alarms: Alarms collected from the Linux servers that hosts the 
Communication Managers. 

 Note: 

Server Alarms now includes the previous filter type: Platform. Selection 
of Server Alarms now provides both filtering on FPM and setting filters 
on the platform. Platform is no longer available. 

 Errors: Errors collected from the Communication Managers. 



Avaya Fault & Performance Manager User Guide 

46 

 Board Conflicts: Board conflicts detected in the Communication Managers 
(detected as conflicts between what is administered and what is actually plugged 
in). 

• Severity: Select the severity of alarm to be filtered: 

 Major 

 Minor 

 Warning (custom filters only) 

 Critical 

 Resolved (custom filters only) 

 All 

 None (this field does not apply to this filter) 

 Notes: 

 To receive traps for Warning and Resolved alarms, the Communication 
Manager must be release 3.0 or above, and Use Custom Values must 
be selected. 

 The filters for warning and resolved alarms are sent to the 
Communication Manager g3Agent using SNMP. The agent must be 
properly setup and the SNMP write community strings must be 
provided when requested. 

 There are a huge number of warning alarms. It is counterproductive to 
turn on all warning alarms on all maintenance objects. The intent of 
warning severity is to allow notification of events of particular interest on 
a limited number of crucial Maintenance Objects. 

• Collection Frequency: select the frequency of alarm filtering:  

 None (this field does not apply to this filter) 

 Daily 

 Hourly  

 Note: 

This field is only used for Filter Type values Definity Alarms, Server Alarms, 
and Errors — those types that are collected on a schedule from the 
Communication Manager. This field does not apply to Board Conflicts or 
Restart Alarms. 

• Category: Categories are groups of Maintenance Object types. (For example, when the 
Filter Type is Definity Alarms, the default Equipment-Type category expands to the MO 
group {MediaGateways, Cabinets, Boards, Ports, Extensions, and Trunks}. When a 
Category is chosen, the MO-Type contains the corresponding expanded list of 
Maintenance Objects. 

This field is only used for Filter Type values Definity Alarms, Server Alarms, Platform, 
Errors and Traps. This field does not apply to Board Conflicts, and Restarts. 
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• MO-Type: The Maintenance Object type can be selected from an appropriate list of 
Maintenance Objects within each Category. If a specific Maintenance Object is chosen, 
the filter applies only to Maintenance Objects of that type. If the value All is chosen, the 
filter applies to all Maintenance Objects in the Category. 

• MO-Location: The default All applies the filter to all locations for the chosen MO-Type. If 
a location is specified, the filter applies only to that location. 

 Note: 

When the MO-Type is specified as Error, the MO-Location field contains the 
Error Code. 

Action Parameters: These parameters are shown in each row of the Alarm Filters panel, and in 
the lower section of the Alarm Filter Configurator used to define or edit alarm filters. 

• Alert/Store as: Select the level of severity at which to alert and store. 

 Store only: The alarm/trap information is stored in the database, but not 
displayed. 

 Critical, Major, Minor, Warning: The alarm/trap information is stored in the 
database and displayed with the selected severity. 

 None: The alarm/trap information is neither stored nor displayed. 

• ARS Script: The fully qualified name of any applicable ARS Script. The default is None. 

• Send Mail To: The address to which to send email notification. The default is None. 

• Trap Level: select the level of severity at which to set an SNMP trap for another 
monitoring system. 

 None: Do not forward/generate a trap for this alarm/trap. 

 Critical, Major, Minor, Warning: Generate/forward a trap to the HP/OV NMS 
system. The default is Major. 

Specifying Default Filters 

The default Alarm/Error panel appears under Administration Root > Default Parameters > 
Alarms/Errors.  

The default alarm filters apply to all systems except those where custom alarm filters have been 
defined. 

Specifying Custom Filters 

The custom Alarm/Error panel appears under Administration Root > Voice System 
Parameters > [system name] > Alarms/Errors.  

For each voice system, collection can be on or off. Each voice system can use either the default 
alarm filter parameter values, or custom alarm filter parameters.  

Adding, Modifying, and Deleting Alarm Filters 

When the alarm filter panel is displayed, you can add, change, and delete filters using the buttons 
at the bottom of the panel: 

• Add: Click Add to open the Alarm Filter Configurator with a blank form for a new filter. 

• Modify: Select an existing filter by clicking on its row. Then click Modify to open the 
Alarm Filter Configurator with the selected filter parameters filled in for editing. 

• Delete: Select one or more existing filters by clicking on their rows. Then click Delete to 
delete the selected filters. Multiple filters can be selected by clicking the first filter and 
then holding down the <shift> key and clicking the last filter. 
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• Save: The Save button becomes active when any changes are mode to the panel. Click 
the Save button to save the changes to the database. Attempting to close the panel 
without saving requires a confirm dialog to save or discard the changes. 

• Reset: The Reset button becomes active when any changes are mode to the panel. 
Click the Reset button to discards any changes to the panel and reloads the panel from 
the database. 

Generating Test Traps 

The Test Trap button at the bottom of the Alarm Filter Panel generates a test trap. 

• At the default level the Test Trap button is always enabled. FPM determines which voice 
systems have CM4.0 (load 730.0 and above) and sets those systems to generate a trap. 

• At the voice system level clicking the Test Trap button generates a trap for that voice 
system. The Test Trap button is enabled only if the voice system has CM4.0 (load 730.0 
and above). 

If an appropriate alarm filter (Type = Trap, Severity = Warning or All) exists, the resulting traps 
display in the Voice System Exception Report. The Description indicates that this is a customer 
alarm test. 
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Default and Custom System Parameters 

The following parameters can be defined. Each voice system and adjunct may use the default 
values or may define specific values that apply only to that voice system or adjunct. 

Default Parameters 

• Voice System Parameters: 

 Configuration Collection 

 

Specifies how often to collect 
configuration data. 

 

Specifies when to collect 
configuration data. 
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 Trunk Exceptions 

 

Specifies what to do for 
ACA referrals for long 
and short holding times. 

 

Specifies how often to 
collect trunk exception 
data. 



Using Avaya FPM 

51 

 

Specifies when to collect 
trunk exception data. 

 

Specifies what to do with 
lightly used trunk 
exceptions. 
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Specifies what to do with 
trunk outage exceptions. 
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 Alarms/Errors 

 

Specifies what to do 
with each alarm. 

 

Specifies when to 
collect alarm 
information. 

 

 Performance Collection 

 

Specifies which data 
fields to perform 
threshold checks upon. 
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Specifies when to 
collect performance 
data. 

 

Specifies how long to 
keep performance 
data. 

 

Specifies when to 
collect performance 
data. 
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 Processor Occupancy 

 

Specifies the threshold 
(%) for a processor 
occupancy exception. 

 

Specifies what to do for a 
processor occupancy 
exception. 
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 Trunk Group Exceptions 

 

Specifies what to do with 
trunk group exception 
data. 

 

Specifies how to calculate 
grade of service. 
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• Adjunct Parameters 

 Adjunct Alarms/Errors 

 

Specifies what to do with 
warning alarms from 
adjuncts. 

 

Specifies what to do with 
Inads alarms from 
adjuncts. 
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Specifies what to do with 
major alarms from 
adjuncts. 

 

Specifies what to do with 
Minor alarms from 
adjuncts. 
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Custom Parameters 

• Voice System Parameters: 

 

Each custom parameter panel has the same format as 
the corresponding default parameter panel. When you 
select a parameter panel for a specific system, you can 
turn collection on or off. If collection is on, you can 
specify default values or custom values. When you 
specify custom values, the custom values will apply for 
the selected parameter panel only. 

Trunk Group Exceptions has a different format. It represents multiple trunk groups in a 
list. Default or Custom can be selected for each trunk group independently.  

 

 

• Adjunct Parameters 

 

Each custom parameter panel has the same format as 
the corresponding default parameter panel. When you 
select a parameter panel for a specific adjunct, you can 
specify default values or custom values. When you 
specify custom values, the custom values will apply for 
the selected parameter panel only. 
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Performance Data 

FPM collects the following performance data about your voice system. For most of this data, you 
can control whether FPM collects hourly counts, daily peaks, and/or weekly peaks. You can also 
control the length of time FPM retains each type of data in its database. (From other tabs related 
to the use of the data.) 

 

Description Hourly Daily Peak Weekly Peak Other 

Trunk Groups Yes Yes Yes  

Wideband Trunk Groups Yes Yes Yes  

ISDN Cal-by-Call Trunk 
Groups 

Yes — —  

Processor Occupancy Yes Yes Yes  

Port Networks Yes Yes Yes  

Inter-Port Network 
Connections 

Yes Yes Yes  

Security Violations — — — Daily 
Counts 

Attendant Groups Yes Yes Yes  

Routing Patterns Yes Yes Yes  

Hunt Groups Yes Yes Yes  

Coverage Paths Yes Yes Yes  

Principal Data Yes Yes Yes  

Switch Node Links Yes Yes Yes  

Tone Receivers Yes Yes Yes  

IP Codecs Yes Yes Yes  

IP DSP Resources Yes Yes Yes  

IP Signalling Groups Yes Yes Yes  

Announcements Yes Yes Yes  
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Description Hourly Daily Peak Weekly Peak Other 

Clan Sockets Yes Yes Yes  

Clan Ethernets Yes    

Clan PPP Links Yes    

Calibrate Voice Yes Yes Yes  

Calibrate Data Yes Yes Yes  

Calibrate Service Link Yes Yes Yes  

Calibrate Multimedia Yes Yes Yes  

Calibrate Total Yes Yes Yes  

Multimedia Interface Yes    

Expansion Services Module    Weekly 
Counts 

Voice Conditioners Yes Yes Yes  

Denial Events Yes Yes Yes  

CAC/BL Status Yes    

 

Exception Data 

FPM can collect the following exception data about your voice system. For most of this data, you 
can control the length of time FPM retains each type of data in its database, the severity it 
assigns to each type of exception, and whether it should alert you when an exception of that type 
occurs. You can set the thresholds for processor occupancy exceptions and trunk group grade-of-
service violations.  

• Alarms and Errors 

• Board Conflicts 

• CAC/BL Denial Events 

• Lightly-Used Trunks 

• Long Trunk Holding Times 

• Processor Occupancy Threshold Violations 

• Restarts 

• Short Trunk Holding Times 

• Trunk Group Grade-of-Service Violations 

• Trunk Outages 

Related Topics: 
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• Default Performance Collection, Data Types Tab 
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Threshold Alarm Panel 

The Threshold Alarm Panel gives you detailed control of threshold alarm collection and 
processing. You specify a set of parameters to define threshold variables and values. Additional 
parameters define what actions to take when an alarm is received. 

Use this panel to View, Add, Modify, and Delete parameters for threshold alarms. 

• Default Threshold Panel 

The default Threshold panel appears under Administration Root > Default Parameters 
> Performance Collection.  

The default Threshold panel applies to all systems except those where custom thresholds 
have been defined. 

• Custom Threshold Panel 

The custom Threshold panel appears under Administration Root > Voice System 
Parameters > [system name] > Performance Collection.  

For each voice system, collection can be on or off. Each voice system can use either the 
default threshold parameter values, or custom threshold parameters.  

Viewing Threshold Settings 

Defined threshold settings are displayed as a scrolling list: 

     

 

Selecting a threshold setting and clicking Modify (or clicking Add) opens the selected threshold 
(or a new threshold) in the Performance Threshold Configurator.  
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Threshold Parameters: These parameters are shown in each row of the Thresholds panel, and 
in the upper section of the Performance Threshold Configurator used to define or edit threshold 
settings. 

• Performance Type: Select the type of threshold to be set: 

Attendant Groups 

Hunt Groups 

Coverage Paths 

Principal Data 

Inter-Port Network Latency 

Port Networks 

Processor Occupancy 

Routing Patterns 

Security Violations 

Switch Node Links 

Tone Receivers 

Trunk Groups 

Trunk Groups, ISDN-PRI 
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Attendant Groups 

Trunk Groups, Wideband 

IP Codecs 

IP DSP Resources 

IP Signalling Groups 

Announcements 

CLAN Sockets 

CLAN Ethernet 

CLAN PPP 

Call Rate 

Multimedia Interface 

Expansion Services Module 

Voice Conditioners 

Denial Events 

CAC/BL Status 

 

• Field: Select the data field to be tested for a threshold value: 

The fields available depend on the Performance Threshold selected. For each 
Performance Threshold type, all available data fields are listed. 

• Collection Frequency: Select the frequency of threshold testing:  

 None (this field does not apply) 

 Hourly 

 Daily 

 Weekly 

• Operation: Select the method of threshold testing: 

 None (this field does not apply) 

 > (data value is greater than threshold value) 

 >= (data value is greater than or equal to threshold value) 

 = (data value is equal to threshold value) 

 < (data value is less than threshold value) 
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 <= (data value is less than or equal to threshold value) 

• Threshold: Enter a numeric value to be used for comparison to the data value. 

Action Parameters: These parameters are shown in each row of the Thresholds panel, and in 
the lower section of the Performance Threshold Configurator used to define or edit threshold 
settings. NOTE: Routing to Network Management Systems outside of Fault and Performance 
Manager is on a concealed list of check boxes activated by the NMS button. 

• Alert/Store as: Select the level of severity at which to alert and store. 

 Store only: The threshold information is stored in the database, but not 
displayed. 

 Critical, Major, Minor, Warning: The threshold information is stored in the 
database and displayed with the selected severity. 

• ARS Script: The fully qualified name of any applicable ARS Script. The default is None. 

• Send Mail To: The address to which to send email notification. The default is None. 

• Trap Level: Select the level of severity at which to set an SNMP trap for another 
monitoring system. 

 None: Do not forward/generate a trap for this alarm/trap. 

 Critical, Major, Minor, Warning: Generate/forward a trap to the HP/OV NMS 
system. The default is Major. 

• NMS: Select routing to any or all Network Management Systems in the list of check 
boxes revealed by clicking the NMS button. 

Specifying Default Thresholds 

The default Thresholds panel appears under Administration Root > Default Parameters > 
Performance Collection.  

The default thresholds apply to all systems except those where custom thresholds have been 
defined. 

Specifying Custom Thresholds 

The custom Thresholds panel appears under Administration Root > Voice System Parameters 
> [system name] > Performance Collection.  

For each voice system, collection can be on or off. Each voice system can use either the default 
threshold parameter values, or custom threshold parameters.  

Adding, Modifying, and Deleting Thresholds 

When the Thresholds panel is displayed, you can add, change, and delete thresholds using the 
buttons at the bottom of the panel: 

• Add: Click Add to open the Performance Threshold Configurator with a blank form for a 
new threshold. 

• Modify: Select an existing threshold by clicking on its row. Then click Modify to open the 
Performance Threshold Configurator with the selected threshold parameters filled in for 
editing. 

• Delete: Select one or more existing thresholds by clicking on their rows. Then click 
Delete to delete the selected thresholds. Multiple thresholds can be selected by clicking 
the first threshold and then holding down the <shift> key and clicking the last threshold. 

• Save: The Save button becomes active when any changes are mode to the panel. Click 
the Save button to save the changes to the database. Attempting to close the panel 
without saving requires a confirm dialog to save or discard the changes. 
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• Reset: The Reset button becomes active when any changes are mode to the panel. 
Click the Reset button to discards any changes to the panel and reloads the panel from 
the database. 
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FPM Parameters 

The FPM parameters apply to how systems are grouped and where data is stored. The following 
parameters can be defined: 

• System Exceptions 

 

Specifies what to do with data 
collection failure exceptions. 
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Specifies what to do with 
scheduled report failure 
exceptions. 
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• System Groups 

 

Assigns voice systems to 
named system groups. The 
drop-down list shows all 
defined groups. 

Voice systems are grouped 
as specified on the 
Configuration and Status 
screen when the System 
Groups tab is selected. 

Use the New Group button 
to add a new group. 

 

Each group name defined 
is included in the drop-
down list for system 
groups. 
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• DCS Groups 

 

Assigns voice systems to 
the DCS group selected 
in the tree in the left 
panel. Check each 
system to be included in 
the group.  

Voice systems are 
grouped as specified on 
the Configuration and 
Status screen when the 
DCS Trunk 
Connectivity tab is 
selected. 

Use the New Group 
button to add a new 
group. 

 

Each group name 
defined is included in the 
drop-down list for DCS 
trunk connectivity groups. 
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• IP Trunk Groups 

 

Assigns voice systems to 
the IP Trunk group 
selected in the tree in the 
left panel. Check each 
system to be included in 
the group.  

Voice systems are 
grouped as specified on 
the Configuration and 
Status screen when the 
IP Trunk Connectivity 
tab is selected. 

Use the New Group 
button to add a new 
group. 

 

Each group name 
defined is included in the 
drop-down list for IP trunk 
groups. 
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Report Manager 
Report Manager Screen 

From the File menu of the Configuration and Status screen you can select File > Report 
Manager... to open the FPM Report Manager screen. 
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The FPM Report Manager screen provides: 

• Report Definitions 

The Report Definitions panel lists all currently defined reports. 

For new reports, you can select report type, systems, and other parameters. You can 
schedule when reports are run on a regular basis. You can create ad-hoc reports and run 
them immediately when investigating a problem. 

For the types of reports you can define, see Report Types in the following topic. 

• Scheduled Reports 

You can select any  regularly scheduled report that has been saved to a file and display it 
or print it. 

• Trunk Group Lists 

You can define trunk group lists for reports that are based on network performance rather 
than system performance. 

Related Topics 

• New Report Dialog Box 

• Report Types 

• Defined Reports 

• Scheduled Reports 

• Trunk Group Lists 
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Reports Types 

 Note: 

Selection of a report type does not determine whether or not you have collected and 
saved the necessary information for the report. See Filtering Alarms, Default and Custom 
System Parameters, and Performance Data for data collection information. 

FPM produces many types of reports. The report types are listed below: 

 Notes: 

 If the value in the Time Scale column is "N/A", the report is not tied to 
any time scale. There are two different types of Time tabs, one for the 
exception reports and one for performance reports. On some of the 
performance reports, there are limited options on the Time tab. 

 The available tabs are listed under Component Selection. 

 If the value in the Secondary Data column is anything other than "N/A", 
the Report Output dialog box has a drop-down list where you can choose 
to display primary data, or one or more types of secondary data. 

• Configuration Reports 

Configuration reports can be run from the View menu (online) on the main Configuration 
and Status screen or System Detail screen as well as from the Report Manager screen. 
While the online and Report Manager reports are similar, they are not identical. 

 

Report Type 

 

Description 

Time  
Scales 

Component 
selection 

Secondary data 

Board Inventory 
(table format 
only) 

Board Inventory shows a 
count of boards (circuit 
packs) by type, code, suffix, 
and vintage. The inventory 
may include all boards or 
only selected systems or 
locations. 

N/A Systems tab 

Location tab 

 

N/A 

Board Report 
(table format 
only) 

Board Report shows a list 
of installed boards (circuit 
packs). The report may 
include all boards, or it may 
be filtered by system, type, 
code, or location. 

N/A Location tab 

Board Type tab 

 

N/A 

Capacity Report 
(table format 
only) 

Capacity Report provides 
used and available capacity 
information for a switch. 
The report displays 
information for the selected 
switches. 

N/A Systems tab N/A 
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Report Type 

 

Description 

Time  
Scales 

Component 
selection 

Secondary data 

Board Inventory 
(online) 

Board Inventory shows a 
count of boards (circuit 
packs) by type, code, suffix, 
and vintage. The inventory 
is filtered automatically 
based on the current 
position in the 
Configuration and Status or 
System Detail screen. 

N/A Automatic N/A 

Board Report 
(online) 

Board Report shows a list 
of installed boards (circuit 
packs). The inventory is 
filtered automatically based 
on the current position in 
the Configuration and 
Status or System Detail 
screen. 

N/A Automatic N/A 

Capacity Report 
(online) 

Capacity Report provides 
used and available capacity 
information for a switch. 
The inventory is filtered 
automatically based on the 
current position in the 
Configuration and Status or 
System Detail screen. 

N/A Automatic N/A 

• Exception Reports 

Some exception reports can be run from the View menu (online) on the main 
Configuration and Status screen or System Detail screen as well as from the Report 
Manager screen. While the online and Report Manager reports are similar, they are not 
identical. 

Report Type Description Time  
Scales 

Component 
selection 

Secondary 
data 

Exceptions: 
Adjunct Systems  
(table format only) 

Adjunct Exceptions shows 
adjunct-related exceptions, 
for example, alarms or 
traps. Exceptions may be 
filtered by system or by 
time. 

Time tab 
(Excptns) 

Systems tab 

 

N/A 
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Report Type Description Time  
Scales 

Component 
selection 

Secondary 
data 

Exceptions: 
Fault/Performance 
Manager 
(table format only) 

Network Manager 
exceptions shows 
exceptions related to this 
application, for example, 
failure to collect data or run 
a scheduled report. 
Exceptions may be filtered 
by type or time. 

Time tab 
(Excptns) 

N/A N/A 

Exceptions: Voice 
System 
(table format only) 

Voice System Exceptions 
shows voice system-related 
exceptions, for example, 
alarms or TG GOS 
violations. Exceptions may 
be filtered by system, type, 
location, or time. 

Time tab 
(Excptns) 

Systems tab 

Types tab 

Location tab 

N/A 

Exceptions: Voice 
System 
(online) 

Voice System Exceptions 
shows voice system-related 
exceptions. The exceptions 
are filtered automatically 
based on the current 
position in the Configuration 
and Status or System Detail 
screen. 

N/A Automatic N/A 

Exceptions: 
Transaction Logs 

Transaction Logs shows all 
transactions in FPM such as 
logins and busyouts and 
releases on media modules 
and ports.  

Time tab 
(Excptns) 

Systems tab N/A 

• Performance Reports 

Performance reports run only from the Report Manager. However, you can go directly to 
the New Report dialog box from View > Performance Data on the main Configuration 
and Status screen. 

Report Type Description Time  
Scales 

Component 
selection 

Secondary data 

Performance: 
Announcements 

Announcements 
performance shows 
maximum in-region and out-
region play requests queued, 
requested, and dropped. 
Records may be filtered by 
system time. 

Time tab Systems tab 

 

 

N/A 
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Report Type Description Time  
Scales 

Component 
selection 

Secondary data 

Performance: 
Attendant 
Groups 

Attendant Group 
performance shows call 
counts and usage for the 
group and for individual 
attendants. Records may be 
filtered by system and time. 

Time tab Systems tab 

 

Attendants 

Performance:  
CAC/BL Status 

Call Admission Control / 
Bandwidth Limitation 
performance shows source 
and destination region, 
connection type and status, 
bandwidth limit value and 
units, transmission and 
reception bandwidth and 
number of connections, and 
number of denials. 

Time tab Systems tab N/A 

Performance: 
Call Rate 

Call Rate performance 
shows busiest hour and 
interval. May be filtered by 
system and time.  

Time tab Systems tab 

Call Rate 
Types tab 

 

N/A 

Performance:  
CLAN Ethernet 

CLAN Ethernet performance 
shows CLAN ethernet crc 
counts, and delta by board. 
May be filtered by system 
and time. 

Time tab Systems tab N/A 

Performance: 
CLAN PPP 

CLAN PPP performance 
shows CLAN PPP crc counts 
and delta by board. May be 
filtered by system and time. 

Time tab Systems tab 

Board Type tab 

 

N/A 

Performance: 
CLAN Sockets 

CLAN Sockets performance 
shows CLAN socket usage, 
and denial counts and 
percentages by boards and 
regions. May be filtered by 
system and time.  

Time tab Systems tab N/A 

Performance: 
Coverage Paths 

Coverage Paths 
performance shows 
configuration, usage, and 
call counts. Records may be 
filtered by system, coverage 
path, and time. 

Time tab Systems tab 

Coverage 
Paths tab 

 

N/A 
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Report Type Description Time  
Scales 

Component 
selection 

Secondary data 

Performance: 
Denial Events 

Denial Events performance 
shows event type, 
description, event data, first 
occurrence, last occurrence, 
and event count. May be 
filtered by system and time. 

Time tab Systems tab N/A 

Performance: 
Expansion 
Services Module 

Expansion Service Module 
performance shows available 
ports/usage, total 
usage/allocation, denials, out 
of service, and blockage. 
May be filtered by system 
and time. 

Time tab Systems tab N/A 

Performance:  
Hunt Groups 

Hunt Group performance 
shows configuration, usage, 
and call counts. May be 
filtered by system, hunt 
group, and time. 

Time tab Systems tab 

Hunt Groups 
tab 

 

N/A 

Performance:  
Inter-Port  
Network 
Latency 

Inter-Port Network Latency 
shows PN connection 
requests and ATM setup 
requests with average delay 
in milliseconds. Records may 
be filtered by system, PN 
pairs, and time. 

Time tab Systems tab 

PN 
Connections 
tab 

 

N/A 

Performance: 
IP Codecs 

IP Codecs performance 
shows G.711/G.732/G.729 
codec usage, in CCS or 
Erlangs for IP codecs. 
Records may be filtered by 
system, IP codec type, and 
time. 

Time tab Systems tab N/A 

Performance: 
IP DSP 
Resources 

IP DSP Resources 
performance shows 
configuration, usage, and 
peg counts for IP DSP 
resources. Records may be 
filtered by system and time. 

Time tab Systems tab N/A 

Performance: 
IP Signaling 
Groups 

IP Signaling Groups 
performance shows packet 
latencies, and packets sent 
and lost for IP Signaling 
Groups. Records may be 
filtered by system and time. 

Time tab Systems tab N/A 
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Report Type Description Time  
Scales 

Component 
selection 

Secondary data 

Performance: 
Multimedia 
Interface 

Multimedia Interface 
performance shows available 
ports/usage, total 
usage/allocation, denials, out 
of service, and blockage. 
May be filtered by system 
and time. 

Time tab Systems tab N/A 

Performance:  
Port Networks 

Port Networks performance 
shows usage and peg 
counts. Records may be 
filtered by system, PN pair, 
and time. 

Time tab Systems tab 

Port Networks 
tab 

N/A 

Performance: 
Principal Data 

Principal Data performance 
shows configuration, usage, 
and call counts. Records 
may be filtered by system, 
principal data, and time. 

Time tab Systems tab 

Principal Data 
tab 

 

N/A 

Performance:  
Processor 
Occupancy 

Processor Occupancy shows 
occupancy and call counts. 
May be filtered by system 
and time. 

Time tab Systems tab N/A 

Performance:  
Routing 
Patterns 

Routing Patterns 
performance shows call 
counts for routing patterns 
and trunk groups within 
routing patterns. Records 
may be filtered by system, 
routing pattern, and time. 

Time tab Systems tab 

Routing 
Patterns tab 

 

Trunk groups 

Performance:  
Security 
Violations 

Security Violations includes 
valid and invalid attempts by 
port type and by system. 
Records may be filtered by 
system and time. 

Time tab Systems tab Port types 

Performance:  
Switch Node 
Links 

Switch Node Link 
performance shows usage 
and peg counts. Records 
may be filtered by system, 
SN link, and time. 

Time tab Systems tab 

Switch Node 
Links tab 

 

N/A 
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Report Type Description Time  
Scales 

Component 
selection 

Secondary data 

Performance:  
Tone Receivers 

Tone receiver performance 
shows peg counts for each 
tone receiver type and port 
network. Records may be 
filtered by system, tone 
receiver type, and time. 

Time tab Systems tab 

Tone 
Receivers tab 

 

Port networks 

Performance:  
Trunk Groups 

Trunk Group performance 
shows usage, peg count, 
and grade-of-service.  

Time tab Systems tab 

Trunk Groups 
tab 

 

Primary Data or 
Average Data 

Performance:  
Trunk Groups  
ISDN-PRI CBC 

ISDN-PRI performance 
shows configuration, usage, 
and counts for ISDN TG  

Time tab Systems tab 

Trunk Groups 
tab 

ISDN services 
or features, and 
usage 
allocation plans 

Performance:  
Trunk Groups, 
Wideband 

Wideband Trunk 
performance shows 
configuration, usage, and 
peg counts for wideband 
TGs. Records may be filtered 
by system, TG or TG list, and 
time. 

Time tab Systems tab 

Trunk Groups 
tab 

N/A 

Performance: 
Voice 
Conditioner 

Voice Conditioner 
performance shows available 
counts/usage, 
H320/voice/total 
usage/allocation/denials, out-
of-service, and blockage. 
May be filtered by system 
and time. 

Time tab Systems tab N/A 
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Defined Reports 

The Defined Reports panel lists all reports that have been defined.  

 

The first column (unlabeled) is an alert indicator if there is a report run failure 

You can define reports independently of scheduling them to run. This allows you to create (or 
reuse) special reports for trouble shooting. As long as you have collected the necessary data for 
a trouble shooting report, you can select it from the list of defined reports and run it immediately, 
or schedule it for any time. 

You can define and run ad-hoc reports at any time by clicking New. 

Buttons: 

• New — Opens the New Report dialog box to define a new report. 

• Open — Highlight a row by clicking on it. Then click Open. The existing report definition 
displays in the Report Definition screen. 

• Exceptions — Shows report failure exceptions related to the selected report(s). 

• Delete — Highlight a row by clicking on it. Then click Delete. The existing report is 
deleted. 

Related Topics 

• Report Definition Screen 

• Exceptions 

• Scheduling Reports 
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New Report Dialog Box 

Selecting View > Performance Data... from the Configuration and Status screen or the System 
Detail screen opens the New Report Dialog Box. You may also open the New Report Dialog Box 
by clicking New on the Report Definition screen. The New Report Dialog Box is used to select a 
report type and assign a report name. 

 

To define a new report, follow these steps: 

1. Select the report type from the available list.  

FPM displays a description of the selected report type in the information box below the 
report type list box. 

2. Enter a unique name for the new report in the Enter Report Name text box. 

3. Click OK to create the new report. 
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FPM displays the Report Definition Dialog Box. This dialog box contains different tabs 
depending on the type of report you are creating. 

Related Topics 

• Report Definition Dialog Box 

• Report Definition screen 

• How To Create a New Report  

• How To Run or Schedule a Report  

• How To View a Report  

• How To Print a Report  
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Report Definition Dialog Box 

The Report Definition screen has a variable number of tabs depending on the Report Type 
selected. There are six types of tabs. All reports have Systems, Fields, Sort, and Destination 
tabs. Other tabs are present when appropriate to the individual report. 

• Systems Tab — allows you to select the systems included in the report. 

• Component selection tabs, if any, appear here. See list below: 

 Board Type Tab — allows you to select the boards included in the report. 

 Hunt Groups Tab — allows you to select the hunt groups included in the report. 

 IP Codecs Tab — allows you to specify which IP codec types are included in the 
report. 

 Location Tab (Board Report) — allows you to specify the board information at all 
locations or at one location included in the report. 

 Location Tab (Exceptions Report) — allows you to specify the exceptions at all 
locations or at one location included in the report. 

 PN Connections Tab — allows you to select the port network connections 
included in the report. 

 Port Networks Tab — allows you to select the port networks included in the 
report. 

 Routing Patterns Tab — allows you to select the routing patterns included in the 
report. 

 Switch Node Links Tab — allows you to select the switch node links included in 
the report. 

 Time Tab (general) — allows you to set time options for the report. (Hourly 
counts, Daily peaks, or Weekly peaks; previous period, or fixed interval.) 

 Time Tab (Exceptions Report) — allows you to specify exception time options in 
your report. (Show current exceptions, or Show exception history.) 

 Tone Receivers Tab — allows you to select the type of tone receivers included 
in the report. 

 Trunk Groups Tab — allows you to select trunk groups included in the report. 

 Types tab (Voice System Exceptions Report) — allows you to select the types of 
exceptions included in the report. 

• Format Tab — allows you to select "table" or "chart," and specify chart properties. This 
tab does not appear for "table form only" reports. 

 Chart Properties Dialog Box — Allows you to specify type of chart, 3D 
properties of the chart, and the fields to plot along the X and Y axes. 

• Fields Tab — allows you to select the data fields included in the report and specify the 
order of the fields. 

• Sort Tab — allows you to specify up to three levels of sorting based on the included 
fields. 

• Destination Tab — allows you to direct the report output to the screen, a printer, or a file. 

 Print Properties Dialog Box — allows you to find networked printers and specify 
print properties. 
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Report Definition Tabs 

Systems Tab 

This tab allows you to select the systems to include in your report. 

 Note: 

You can only select systems for which you have administrative privileges. 

 

 

To select systems, follow these steps: 

1. From the Systems tab, select one or more systems to include in the report.  

 Use the Select All button to select all systems.  

 Use the Clear All button to clear any selections. 

2. After selecting the systems, click another tab to continue defining the report, or click one 
of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Component Selection Tabs 

Board Type Tab 

This tab allows you to specify the boards to include in your report. 

 

To make board selections, follow these steps: 

1. On the Select Board Types box, complete the following fields: 

 Include only boards with unassigned ports: Check or clear as desired. 

 All boards: Select to include all boards in your report. 

 Note: 

If you want a more selective report, select either Types including 
or Codes including below.  

If you do not select All boards, then you must enter up to six 
sub-strings to match against board types or board codes plus 
suffixes. The report includes boards that match any one of the 
sub-strings you enter.  

 Types including: Enter up to six sub-strings of board types to include in your 
report. 
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For example if you enter type "line", the report includes boards of types ANALOG 
LINE, BRI LINE, DATA LINE, DIGITAL LINE, and PDATA LINE.  

 Note: 

Types are always uppercase, but the matching ignores case. 

 Codes including: Enter up to six sub-strings of board codes to include in your 
report.  

For example, if you enter code "TN76", the report includes TN760, TN765, and 
TN765C. 

 Note: 

Codes are always uppercase, but the matching ignores case. 

2. After selecting the board types, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Call Rate Tab  

This tab allows you to specify the call rate types to include in your report. 

 

To make call rate selections, follow these steps: 

1. Select the call rate types to include. 

2. Use the Select All button to select all call rate groups.  

3. Use the Clear All button to clear any selections. 

4. After selecting the call rate types, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Call Rate Tab  

This tab allows you to select the coverage paths to include in your report. 

 

To select the coverage paths, follow these steps: 

1. Select the coverage paths to include in the report. 

Use the Select All button to select all systems.  

Use the Clear All button to clear any selections. 

2. After selecting the connections, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 



Using Avaya FPM 

93 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Hunt Groups Tab 

This tab allows you to select the hunt groups to include in your report. 

 

To select hunt groups, follow these steps: 

1. Select the Hunt Groups to include in the report.  

Fault and Performance Manager displays a list of hunt groups for the systems selected 
on the Systems tab. The list includes the system name, the hunt group number, and the 
hunt group name, if known. Note that it is possible that Fault and Performance Manager 
may receive performance data for a new hunt group before Fault and Performance 
Manager receives configuration data. In this case, the hunt group name is not shown until 
configuration data is collected. (See Configuration Collection for more information.) 

 Use the Select All button to select all hunt groups.  

 Use the Clear All button to clear any selections. 

2. After selecting the hunt groups, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 
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 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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IP Codecs tab 

This tab allows you to specify which IP codec types to include in your report.  

 

If you select all systems on the Systems tab, then the IP Codecs tab does not allow you to make 
selections. 

To select IP Codecs, follow these steps: 

1. Select the IP Codecs to include in the report.  

Fault and Performance Manager displays a list of IP codecs for the systems selected on 
the Systems tab. The list includes the system name and the codec name. 

 Use the Select All button to select all hunt groups.  

 Use the Clear All button to clear any selections. 

2. After selecting the IP Codecs, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 
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 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Location Tab for Board Report 

This tab allows you to specify the board information at all or one location to be included in your 
report. 

 

To select exception locations, follow these steps: 

1. In the Select Location box, specify either all boards or specific hardware, port networks, 
or switch nodes at one location. 

 All boards, regardless of location: Select to include all boards. 

 Hardware location: Enter a valid hardware location. (The system does not 
validate this entry. Make sure the spelling is correct.) The report includes all 
exceptions for hardware locations beginning with the specified location string. For 
example, if you enter a carrier location such as 02B, the report includes 
exceptions for that carrier location and exceptions at all boards and ports 
contained in that carrier. 

 Port network number: Enter a valid port network number. (The system does not 
validate this entry. Make sure the number is correct.) 

 Switch node number: Enter a valid switch node number. (The system does not 
validate this entry. Make sure the number is correct.) 
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2. After selecting the location, click another tab to continue defining the report, or click one 
of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Location Tab for Voice System Exceptions Report 

This tab allows you to specify the exceptions at all or one location to be included in your report. 

 

To select exception locations, follow these steps: 

1. In the Select Location box, specify either all exceptions or exceptions at one location. 

 All exceptions, regardless of location: Select to include all exceptions. 

 Hardware location:  

Enter a valid hardware location. (The system does not validate this entry. Make 
sure the spelling is correct.) The report includes all exceptions for hardware 
locations beginning with the specified location string. For example, if you enter a 
carrier location such as 02B, the report includes exceptions for that carrier 
location and exceptions at all boards and ports contained in that carrier. 

 Port network number:  

Enter a valid port network number. (The system does not validate this entry. 
Make sure the number is correct.) 
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 Switch node number:  

Enter a valid switch node number. (The system does not validate this entry. 
Make sure the number is correct.) 

 Trunk or Trunk Group:  

Enter a valid trunk group number or a trunk group and member in the format 
nnnn/mmmm. The report will include alarms, errors, trunk group GOS violations, 
restarts, board conflicts, processor occupancy exceptions, and the four trunk 
exception types, or a subset of these types as specified on the Types tab. (The 
system does not validate this entry. Make sure the entry is correct.) The report 
includes all exceptions that could cause an alert on the specified trunk or trunk 
group. 

 Object type and ID:  

For object type, enter a voice system maintenance name and for object ID, enter 
a voice system ALT name. Up to 12 characters can be entered, including 
alphanumeric, a dash (-), and forward slash (/). Lower case characters are 
converted to upper case. (The system does not validate this entry. Make sure the 
entry is correct.) The report includes all exceptions whose object type and ID 
exactly match the entry in this field. 

 Tips 

 To find all exceptions on a trunk group when you know the trunk group number: 

Select the Trunk or trunk group option button and enter the trunk group 
number, for example "1009". In this case, trunk group GOS violations on the 
specified trunk group, as well as alarms, errors, outages, light usage, and holding 
time exceptions for members of the trunk group, are included in your report. 

 To find all exceptions on a single trunk when you know the trunk group and 
member 

Select the Trunk or trunk group option button and enter the trunk group and 
member, for example "1009/235". In this case, alarms, errors, outages, light 
usage, and holding time exceptions for the specified trunk are included in your 
report. Trunk group GOS violations are not included, since they are trunk group 
alerts rather than trunk alerts. 

or 

If you know the trunk type and the corresponding maintenance name, for 
example "CO-TRK" or "AUX-TRK", select the Object type and ID option button, 
and enter the maintenance name for the object type and the trunk ID for the 
object ID. In this case, only alarms and errors are included in your report, since 
the other exceptions are detected by the application, which assigns an object 
type of "TRUNK". 

 To find exceptions on all trunks of a specific type when you know the 
maintenance name corresponding to the specified type: 

Select the Object type and ID option button and enter the maintenance name for 
the object type. Leave the object ID blank. In this case, all alarms and errors on 
trunks of the specified type are included in your report. Application-detected 
exceptions like trunk outages are not included in your report, since they have 
object type "TRUNK". 

 To find exceptions on a single extension when you know the line type and its 
corresponding maintenance name: 
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Select the Object type and ID option button and enter the maintenance name for 
the object type, for example"ANL-16-L" or "DIG-LINE", and the digits of the 
extension for the object ID. In this case, alarms and errors on the port serving 
that extension are included in your report. 

2. After selecting the location, click another tab to continue defining the report, or click one 
of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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PN Connections Tab 

This tab allows you to select the port network connections to include in your report. 

 

To select the port network connections, follow these steps: 

1. Select the port network connections to include in the report. 

The list shows only connections for which Fault and Performance Manager has collected 
performance data. This will not be all connections, since the voice system limits 
performance data collection to at most 20 connections at a time. 

 Use the Select All button to select all systems.  

 Use the Clear All button to clear any selections. 

2. After selecting the connections, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Principal Data Tab 

This tab allows you to select the principal data to include in your report. 

 

To select the principal data, follow these steps: 

1. Select the principal data to include in the report. 

The list shows only principal data for which Fault and Performance Manager has 
collected performance data.  

 Use the Select All button to select all principal data.  

 Use the Clear All button to clear any selections. 

2. After selecting the principal data, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Port Networks Tab 

This tab allows you to select the port networks to include in your report. 

 

To select the port networks, follow these steps: 

1. Select the port networks to include in the report. 

 Use the Select All button to select all systems.  

 Use the Clear All button to clear any selections. 

2. After selecting the port networks, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Routing Patterns Tab 

This tab allows you to select the routing patterns to include in your report. 

 

To select routing patterns, follow these steps: 

1. Select the routing patterns to include in the report.  

 Use the Select All button to select all systems.  

 Use the Clear All button to clear any selections. 

2. After selecting the routing patterns, click another tab to continue defining the report, or 
click one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Switch Node Links Tab 

This tab allows you to select the switch node links to include in your report. 

 

To select switch node links, follow these steps: 

1. Select the switch node links to include in the report.  

 Use the Select All button to select all switch node links.  

 Use the Clear All button to clear any selections. 

2. After selecting the switch node links, click another tab to continue defining the report, or 
click one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Time Tab 

This tab allows you to set time options for your report. 

 

To set time options, follow these steps: 

1. Select the time scale from the drop-down list box: Hourly counts, Daily peaks (default), 
or Weekly peaks. 

 Tips 

 If you select Daily or Weekly peaks, all time windows start and end at 
midnight and the hour field is inactive.  

 If you select Weekly peaks, all time windows start and end at a week 
boundary, Monday 00:00. You can specify a different day; in this case 
when the report is run, the time window expands to the week boundary 
before and after the time window defined. 
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1. Choose the time period by selecting one of the following options:  

 Show data for the previous 

Enter the duration in the corresponding text box. The duration unit is hours, days, 
or weeks depending on the time scale selected. The default is 7 days. 

 Show data for the fixed interval 

Enter the start and end times and days. The end time must be later than the start 
time. The time is in 24-hr. format. Select the time zone: DEFINITY time zone or 
Use Network Manager time zone. DEFINITY time zone refers to the time at 
each monitored voice system. Use Network Manager time zone refers to the time 
on the network management station running the application.  

 Note: 

Reports defined with Daily or Weekly peaks and Show data for the fixed 
interval should also use the voice system time zone. This ensures that if 
a voice system is in a different time zone, all peaks are reported within 
the time window. 

3. After selecting the time information, click another tab to continue defining the report, or 
click one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Time Tab for Exception Report 

This tab allows you to select exception time options in your report. 

 

To set exception time options, follow these steps: 

1. In the Select current exceptions or exception history drop-down list box, select Show 
current exceptions or Show exception history. 

 Note: 

When Show current exceptions is selected, all the other controls in this tab are 
inactive. 

2. Choose the time period by selecting one of the following options:  

 Show data for the previous 

Enter the duration in the corresponding text box. The duration unit is days. The 
default is 7 days. 
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 Show data for the fixed interval 

Enter the start and end times and days. The end time must be later than the start 
time. The time is in 24-hr. format. 

 Select Time zone 

Only applies to a DEFINITY Exception Report. Does not apply to a 
Fault/Performance Manager Exception Report. If you select a fixed window for a 
DEFINITY Exception report, select the time zone. DEFINITY time zone refers to 
the time at each monitored voice system. Network Manager time zone refers to 
the time on the network management station running the application. 

3. After selecting the time information, click another tab to continue defining the report, or 
click one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Tone Receivers Tab 

This tab allows you to select the type of tone receivers to include in your report. 

 

To select tone receiver types, follow these steps: 

1. Select the tone receiver types to include in the report. 

 Use the Select All button to select all systems.  

 Use the Clear All button to clear any selections. 

2. After selecting the tone receiver types, click another tab to continue defining the report, or 
click one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Trunk Groups Tab 

This tab allows you to select trunk groups in your report. 

 

To select trunk groups, follow these steps: 

1. Select one of the following options: 

 Trunk Groups to choose one or more trunk groups.  

The displayed list includes the trunk groups for systems selected on the Systems 
tab. The list includes the system name, the trunk group number, and the trunk 
group name, if known. It is possible that Fault and Performance Manager may 
receive performance data for a new trunk group before it receives configuration 
data. In this case, the trunk group name is not shown until configuration data is 
collected. (See Configuration Collection for more information.) 

 Trunk Group Lists to choose one or more trunk group lists.  

The displayed list includes the trunk group lists for systems selected on the 
Systems tab. The list includes the system name and the trunk group list name. 
(See Trunk Group Lists to view and edit the contents of a trunk group list.) 
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 Use the Select All button to select all trunk groups.  

 Use the Clear All button to clear any selections. 

 Note: 

If more trunk group lists are subsequently added, they will not be automatically 
included. You must edit the Report Definition to include the new lists.  

2. After selecting the trunk groups, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Types Tab 

This tab allows you to select the types of exceptions to include in your report. 

 

To select the types of exceptions, follow these steps: 

1. Select the types of exceptions that you want to include in your report by selecting each 
one in the Select Exception Types list box. (At least one type must be selected.) 

 Use the Select All button to select all exception types.  

 Use the Clear All button to clear any selections. 

2. After selecting the exception types, click another tab to continue defining the report, or 
click one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Format Tab 

This tab allows you to select the output format for your report. 

 

 Note: 

Scheduling takes place on the Linux server. To create graphics, the X-windowing system 
MUST be started, and must be running when the report runs. 

 

To set output format options, follow these steps: 

1. Choose the output format for the report by selecting either the Table option button 
(default) or the Chart option button. 

2. If you select the Chart option button, click the Chart options button to specify the Chart 
Properties and click Close when you are done. 

For help completing the fields, click Help on that screen. 
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3. After selecting the report format, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 

Related Topics 

• Chart Properties Dialog Box 
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Chart Properties Dialog Box 

This dialog box allows you to set charting options for your report. It is accessed by clicking Chart 
on the Format tab of the Report Definition dialog box. 

 

  Note: 

Scheduling takes place on the Linux server. To create graphics, the X-windowing system 
MUST be started, and must be running when the report runs. 

 

To set chart options, complete the following steps: 

1. Set the chart format by filling in the following fields: 

Field Description 

Chart Type Select the type of chart: Bar, Stacked Bar, Line, or Pie 



Avaya Fault & Performance Manager User Guide 

126 

Field Description 

3D Settings Set the appearance of the chart in three dimensions:  

Elevation - sets the position of the observer above the horizontal 
axis from -45? to +45?. A negative elevation positions the observer 
below the horizontal axis. (Default is 0 for a two-dimensional graph 
only.) 
Depth - sets the depth of the graph as a percent of the width from 
0 - 500%. (Default is 0 for a two-dimensional graph only. In this 
case, both Elevation and Rotation are ignored.) 
Rotation - sets the position of the observer to the right or left of the 
vertical axis from -45? to +45?. (Positive rotation positions the 
observer to the right of the vertical axis; negative rotation positions 
the observer to the left of the vertical axis.) 

Notes: If both Elevation and Rotation are zero (0), the graph is 
two-dimensional and the Depth is ignored. If the Depth is a non-
zero value, and either Elevation or Rotation is a non-zero value, 
then the graph is three-dimensional, but the effect is somewhat flat. 

Tip: To achieve the best 3D effect, each of the above settings 
should be a non-zero value. 

 

X Axis Set the X-axis to one of the Key fields previously defined for the 
report. The default is the voice system date and time. 

Hide Collection Gaps Check to delete gaps in the data. For example, if data collection is 
scheduled only during business hours (9:00 a.m. to 5:00 p.m.), 
setting this option ensures that gaps during off-hours and 
weekends are deleted. 

Create Grouping 

 

Check to group measurements according to the values of one 
grouping field. 

Group By If Create Grouping is checked, select one field from the key fields 
selected on the Fields tab. The default is the voice system name. 

 

Y Axis If Create Grouping is checked, select one Y-axis measurement 
from the non-key numeric fields selected on the Fields tab. The 
default is the first non-key numeric field. 
If Create Grouping is not checked, select up to 10 Y-axis 
measurements from the non-key numeric fields selected on the 
Fields tab. 

Tip: The fields available on the X- and Y-axes are the fields 
selected on the Fields tab. If you set chart properties here and 
then go back and change the selections on the Fields tab, this may 
change the chart in unpredictable ways. 

2. Click Close to close the Chart Properties dialog box. 
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Related Topics 

• How to print a report  
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Fields Tab 

This tab allows you to select the data fields to include in your report. 

 

The list of fields depends on the report type. All fields available in the data records used for the 
report are listed. 

To select the data fields, follow these steps: 

1. Select the data fields to include in the report (by default all data fields are selected.)  

The order of the fields in the report is the same as the order the fields in this list. The 
fields selected here determine the fields that are available for sorting and charting on the 
Sort tab and Format tab respectively. The word "key" in parentheses identifies Key fields. 
These are the fields that uniquely identify a record, for example, date and time, system 
name, and sometimes component identifier (trunk group number). Each report should 
include at least one key field. Some report types have "secondary" data fields. For 
example, a Routing Pattern report has an hourly record for each routing pattern, which is 
called the "primary" record. The data fields in this record are the primary data fields. In 
addition, each primary record has a number of "secondary" records, one for each trunk 
group in the routing pattern. The "secondary" data fields appear in the selection list after 
the primary data fields, and are indicated by a different background color. If you include 
both primary and secondary data fields in a report, the report output shows several tables 
and charts. 
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 Use the Select All button to select all fields.  

 Use the Clear All button to clear any selections. 

2. To select the units in which traffic usage measurements are presented, select one of the 
following options: 

 Note: 

These buttons are only available for Performance reports. 

 Show traffic in CCS 

 Show traffic in Erlangs 

3. After selecting the fields, click another tab to continue defining the report, or click one of 
the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Sort Tab 

This tab allows you to select the sort options in your report. 

 

To set sorting options, follow these steps: 

1. From the Sort tab, select how to sort the data rows in the report: 

 Sort first by: select the first sort option from the drop-down list box, and then 
select the Ascending or Descending option button 

 Then by: select the second sort option from the drop-down list box, and then 
select the Ascending or Descending option button 

 Then by: select the third sort option from the drop-down list box, and then select 
the Ascending or Descending option button 

 Note: 

The fields you can sort on are the fields selected on the Fields tab. If you set sort 
fields here and then go back and change the selections on the Fields tab, this 
may change the sort in unpredictable ways. 
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 Tips 

 Sort dates in descending order to get the most recent first. 

 Sort severity in descending order to get the most critical first. 

 Most other fields are usually sorted in ascending order. 

 You can also sort rows after you run the report. 

2. Enter the maximum number of records to be included in the report in the Specify 
maximum records in a report field.  

The default is 1000. 

3. After selecting the sort options, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Destination Tab 

This tab allows you to select the report output destination and print the reports. 

 

To set the report output destination, follow these steps: 

1. Select one or more of the following report destinations:  

 Screen to send the report to the screen display. 

 Print to send the report to the specified print destination.  

Click the Setup button to specify a print command or a printer for the report or to 
specify height and width of the text on the page.  

 File to send the report to the specified file destination.  

Click the Save As button to specify the directory, file name, and file format 
(ASCII or HTML (default)). 



Using Avaya FPM 

133 

 Note: 

The ASCII file format is intended primarily as input to other applications; 
for example, expert systems or spreadsheet programs.  

Select one of the following options: 

 Replace to overwrite the file with the latest data, or  

 Automatically append time stamp to file to create a new report each 
time the report is run  

 E-Mail to send the report to a specified email address. Enter one or more email 
addresses. 

 Note: 

Spaces are invalid in the email address field. If you use internal type 
addresses (such as first initial and last name), specify the first initial, a 
dot, and the last name rather than using spaces. Separate multiple 
entries with commas but no spaces. 

 Note: 

Even when only email output is desired, File must be checked and a 
valid directory on the Linux server is required in the associated text box. 
Click Save As to save the report under a specific name. If you do not 
check File and supply a valid Linux server directory, the resulting file will 
have an incorrect extension. 

If you select E-Mail, you can also select Attachment Type in the Attachment Type 
dialog box: 

 

Selecting HTML (default) generates the report as a web browser readable table. 
Selecting any of the ASCII formats gives delimited fields suitable for importing 
into a spread sheet. For reports that are formatted as charts, an additional choice 
(GIF) is available to present the chart as a picture. 

2. After selecting the output destinations, click another tab to continue defining the report, or 
click one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Note: 

File must be checked and a local PC directory is required in the 
associated text box. Click Save As to save the report under a specific 
name. 

 Schedule 

Opens the Schedule Report dialog box. 

 Note: 

File must be checked and a valid directory on the Linux server is 
required in the associated text box. Click Save As to save the report 
under a specific name. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Scheduled Reports 

The Scheduled Reports panel lists all reports that have been scheduled for later execution.  

 

Buttons: 

• Exceptions — Shows report failure exceptions related to the selected report(s). 

• Reschedule — Highlight a row by clicking on it. Then click Reschedule. The existing 
report is opened in the Schedule Report dialog box. 

• Delete — Highlight a row by clicking on it. Then click Delete. The existing report is 
deleted. 

• Help: Displays a help screen for this panel. 

Related Topics 

• Schedule Report Dialog Box 

• Exceptions 
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Schedule Report Dialog Box 

 Note: 

You can complete administration functions such as scheduling a report only from the 
server application GUI. Administration functions are not available from the Web client. 

 Note: 

Scheduling takes place on the Linux server. To create graphics, the X-windowing system 
MUST be started, and must be running when the report runs. 

 

This dialog lets you specify when you want a report to run. 

 

1. Select an option button and complete the corresponding fields to define the schedule: 

 Run once at: Enter the date in dd/mm/yy format, and enter the time start time in 
military format (24 hr.) 

 Run daily: Enter the start time in military format (24 hr.) 

 Run weekly: Select a day of the week, and enter the start time in military format 
(24 hr.) 

 Run monthly: Select a day of the month, or select the last day of the month. 

2. Click Save to save your changes or Reset to reset the fields to their previous values. 

3. Select the Start and Stop tab. 
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4. Select the Start Schedule on check box and enter a start date in dd/mm/yy format. 

5. Select the Stop Schedule on check box and enter a stop date in dd/mm/yy format. 

6. Click Save to save your changes or Reset to reset the fields to their previous values. 

Related Topics 

• How to run or schedule a report 
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Trunk Group Lists 

Trunk group lists are a convenient way of specifying multiple trunk groups without having to list 
each member each time. 

 

Buttons: 

• New — Opens the New Trunk Group List dialog box to define a new trunk group list. 

• Open — Highlight a row by clicking on it. Then click Open. The members of the trunk 
group list display on the Trunk Group List Definition dialog box. 

• Delete — Highlight a row by clicking on it. Then click Delete. The existing trunk group list 
is deleted. 

Related Topics 

• New Trunk Group List 

• Trunk Group List Definition 
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New Trunk Group List Dialog Box 

Clicking New on the Trunk Group Lists display of the Report Manager screen opens the New 
Trunk Group List dialog box. 

 

A trunk group list applies to one system. 

1. Select the system. 

2. Enter a name for the list. 

3. Click OK. 

The Trunk Group List Definition dialog box opens. 

Related Topics 

• Trunk Group List Definition dialog box 

• Trunk Group Lists 
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Trunk Group List Definition dialog box 

The Trunk Group List Definition dialog box displays when you click Open on the Trunk Group List 
display, or when you click OK on the New Trunk Group List dialog box. 

 

All trunk groups on the system associated with this trunk group list are displayed. 

1. Check any or all of the trunk groups. 

2. Click Save. 

Related Topics 

• New Trunk Group Lists dialog box 

• Trunk Group Lists 
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Task Help 
How To View Your Network 
You can view your network in one of two ways: 

• Using a general purpose Network Management System (NMS) (if you have one). 

• Using Fault and Performance Manager's Network Monitor. 

Viewing your network using an NMS 

To view your network using your NMS, refer to the documentation that came with your NMS. 

Viewing your network using Fault and Performance Manager 

To view your network using Fault and Performance Manager's Network Monitor, complete the 
following steps:  

1. Display the Network Monitor. 

This window displays by default when you open Fault and Performance Manager. 
Depending on the object selected in the left pane, the right pane displays appropriate 
information.  

 Note: 

The Network Monitor window has four tabs just below the menu bar. The highest 
level item in the left pane will have a name similar to the selected tab. 

Tab Highest Level Item 

System Groups System Groups 

DCS Trunk Connectivity DCS Groups 

IP Trunk Connectivity IPT Groups 

Clusters Cluster Groups 

 

If you see the Administration window or Report Manager window (no tabs, and the 
highest level item in the left pane is Administration Root or Report Manager), close or 
minimize them to see the Network Monitor. 

2. Select one of the tabs. 

 System Groups: Displays voice systems in user-defined groups. 

 DCS Trunk Connectivity: Displays voice systems in groups based on DCS 
trunk connectivity. 

 IP Trunk Connectivity: Displays voice systems in groups based on IP trunk 
connectivity. 

 Clusters: Displays information about ESS and LSP clusters. 

3. In the left pane, click the object you want to view. 
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The group or cluster will open to show individual systems in the left or icons for the 
individual systems in the right pane. 

4. In the left pane, click the system name, or in the right pane double-click the system icon. 

The System Detail screen opens, showing configuration and status information displays 
for the selected system. The left pane allows you to drill down for greater levels of detail. 

For additional information, please see: 

• System Groups Tab  

• DCS Trunk Connectivity Tab  

• IP Trunk Connectivity Tab  

• Clusters Tab  
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How To Set Data Collection Parameters 

 Note: 

You can complete administration functions such as setting data collection parameters 
only from the server application GUI. Administration functions are not available from the 
Web client. 

To specify data collection options for any of the data that FPM can collect, complete the following 
steps: 

1. Open the FPM Administration screen by selecting File>Administration. 

2. In the Navigation panel, select the object you want to collect data on. 

For example, select Default Parameters and then select System Exceptions.  

3. If you selected Voice System Parameters, select the system you want to set up data 
collection for. 

FPM expands the selected system and displays a list of data types for that system. 

4. Select the type of data you want to collect. 

FPM displays the appropriate administration tabs in the right pane. 

5. Select the appropriate tab. 

6. Complete the fields on that tab. 

For help understanding the fields, click the Help button on that screen. 

7. Click Save to save your changes or Reset to reset the fields to their previous values. 

Related Topics 

• Data that you can collect 
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How To Create a New Trunk Group List 
Creating a trunk group list within FPM does not affect your voice systems. It merely allows you to 
group trunks within FPM for your convenience. You might use this feature, for example, to group 
trunks by "usage area" and then run reports on the group, rather than the individual trunks. 

1. Open the Report Manager by choosing File>Report Manager. 

2. In the left pane, click Trunk Group Lists. 

3. In the right pane, click the New button.  

FPM displays the New Trunk Group List dialog box.  

4. Select the appropriate voice system from the list. 

5. Enter a unique name for the new Trunk Group List. 

6. Click OK to create the new trunk group list. 

FPM displays the Trunk Group List Definition dialog box. 

7. Select the trunk groups you want to add to the list.  

 Use the Select All button to select all trunk groups. 

 Use the Clear All button to clear all trunk groups. 

8. Click Save to save your changes or Reset to reset the fields to their previous values. 

9. Click Close to close the Trunk Group List Definition dialog box. 

Related Topics 

• How to add trunk groups to the trunk group list 
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How To Add Trunk Groups to the Trunk Group List 
If you arrived at this help topic by clicking the Help button on the Trunk Group List Definition 
screen, go to Step 4. Otherwise, start below. 

Adding trunk groups to the FPM trunk group list does not affect your voice system. It simply 
makes groups of trunks within FPM. You might use this feature, for example, to group trunks by 
"usage area" and then run reports on the group, rather than the individual trunks. 

1. Open the Report Manager by selecting File>Report Manager. 

2. In the left pane, click Trunk Group Lists. 

3. From the right pane, select a trunk group list and click the Open button.  

FPM displays the Trunk Group List Definition dialog box. The trunk groups that are 
currently in the list are selected.  

4. Select the trunk groups that you want to add to the list. (At least one trunk group must be 
selected.)  

 Use the Select All button to select all trunk groups. 

 Use the Clear All button to clear all trunk groups. 

5. Click Save to save your changes or Reset to reset the fields to their previous values. 

6. Click Close to close the Trunk Group List Definition dialog box. 

Related Topics 

• How to create a new trunk group list 
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How To Create a System Group 
FPM allows you to create system groups so that you can organize your systems logically 
according to the needs of your work. For example, you might group systems by location, by type, 
or by some other characteristic. The systems that you group together will appear in the Fault and 
Performance Manager main window under the System Group name that you specify in the 
following procedure. 

To create a system group, complete the following steps: 

1. Open the Administration window by choosing File>Administration. 

2. In the Navigation Pane, select System Groups. 

FPM displays a list of system groups. 

3. In the right pane, click the New Group button. 

FPM displays the New Group dialog box. 

4. Enter a unique system group name in the Enter Group Name field and click OK. 

5. In the right pane, use the drop-down list to change the system group for a particular 
system. 

6. Click Save to save your changes or Reset to reset the fields to their previous values. 

Related Topics 

• How to move a system to a new group 
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How To Move a System to a New Group 
Moving a system to a new group is similar to moving a file to a new folder or directory in your 
computer's file management system, except that the change affects only FPM windows. 

To move a system to a new system group, complete the following steps: 

1. Open the Administration window by choosing File>Administration. 

2. In the left pane, select System Groups. 

FPM displays a list of systems and the groups they belong to. 

3. In the right pane, locate the system that you want to move. 

4. From the drop-down box to the right of the system, choose a new group for the system to 
belong to. 

If you do not see the appropriate group in the list, it is because it does not exist. In that case, you 
can create a system group. 

Related Topics 

• How to create a system group 
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How To Change Alarm Levels 
FPM places colored symbols by the nodes in the tree on the FPM main window if there are 
exceptions in the branches beneath. By default, these symbols mean: 

Critical Alarm 

Major Alarm 

Minor Alarm 

Warning 

The highest level of alarm that has occurred anywhere in a branch will be represented at the 
parent node so that you can see the alarm even if the branch is closed. 

You can change what FPM reports as a critical, major, or minor alarm. To do so, complete the 
following steps: 

1. From the main window, choose File>Administration. 

FPM displays the Administration window. 

2. In the Administration window, click Voice System Parameters in the left pane.  

FPM displays the voice systems that it knows about. 

3. Select the voice system for which you want to set alarm icons. 

4. Select Alarms/Errors. 

5. Select the "Use custom values" radio button. 

6. Select the tab corresponding to the exception for which you want to redefine icons. 
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Filtering Alarms (Alarm Filter Panel) 
The Alarm Filter Panel gives you detailed control of alarm collection and processing. You specify 
a set of parameters to filter out a selected set of alarms. Additional parameters define how often 
alarm collection occurs, and what actions to take when an alarm is received. 

Use this panel to View, Add, Modify, and Delete parameters for alarm filtering. 

• Default Alarm/Error Panel 

The default Alarm/Error panel appears under Administration Root > Default 
Parameters > Alarms/Errors.  

The default alarm filters apply to all systems except those where custom alarm filters have been 
defined. 

• Custom Alarm/Error Panel 

The custom Alarm/Error panel appears under Administration Root > Voice System 
Parameters > [system name] > Alarms/Errors.  

For each voice system, collection can be on or off. Each voice system can use either the 
default alarm filter parameter values, or custom alarm filter parameters.  

Viewing Alarm Filters 

Defined alarm filters are displayed as a scrolling list: 
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Selecting an alarm filter (or clicking Add) opens the selected filter (or a new filter) in the Alarm 
Filter Configurator.  

 

 

Filter Parameters: These parameters are shown in each row of the Alarm Filters panel, and in 
the upper section of the Alarm Filter Configurator used to define or edit alarm filters. 

• Filter Type: Select the type of alarm to be filtered: 

 Definity Alarms: Alarms collected from the Communication Managers and 
maintenance objects in the Communication Managers. 

 Note: 

Definity Alarms now includes the previous filter type: Traps. Selection 
of Definity Alarms now provides both filtering on FPM and setting filters 
on the platform. Traps is no longer available. 

 Restart Alarms: Restarts of the Communication Managers. 

 Note: 

Restart Alarms now includes the previous filter type: Restarts. 
Selection of Restart Alarms now provides both filtering on FPM and 
setting filters on the platform. Restarts is no longer available. 

 Server Alarms: Alarms collected from the Linux servers that hosts the 
Communication Managers. 

 Note: 

Server Alarms now includes the previous filter type: Platform. Selection 
of Server Alarms now provides both filtering on FPM and setting filters 
on the platform. Platform is no longer available. 
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 Errors: Errors collected from the Communication Managers. 

 Board Conflicts: Board conflicts detected in the Communication Managers 
(detected as conflicts between what is administered and what is actually plugged 
in). 

• Severity: Select the severity of alarm to be filtered: 

 Major 

 Minor 

 Warning (custom filters only) 

 Critical 

 Resolved (custom filters only) 

 All 

 None (this field does not apply to this filter) 

 Notes: 

 To receive traps for Warning and Resolved alarms, the Communication 
Manager must be release 3.0 or above, and Use Custom Values must 
be selected. 

 The filters for warning and resolved alarms are sent to the 
Communication Manager g3Agent using SNMP. The agent must be 
properly setup and the SNMP write community strings must be 
provided when requested. 

 There are a huge number of warning alarms. It is counterproductive to 
turn on all warning alarms on all maintenance objects. The intent of 
warning severity is to allow notification of events of particular interest on 
a limited number of crucial Maintenance Objects. 

• Collection Frequency: select the frequency of alarm filtering:  

 None (this field does not apply to this filter) 

 Daily 

 Hourly  

 Note: 

This field is only used for Filter Type values Definity Alarms, Server Alarms, 
and Errors — those types that are collected on a schedule from the 
Communication Manager. This field does not apply to Board Conflicts or 
Restart Alarms. 

• Category: Categories are groups of Maintenance Object types. (For example, when the 
Filter Type is Definity Alarms, the default Equipment-Type category expands to the MO 
group {MediaGateways, Cabinets, Boards, Ports, Extensions, and Trunks}. When a 
Category is chosen, the MO-Type contains the corresponding expanded list of 
Maintenance Objects. 

This field is only used for Filter Type values Definity Alarms, Server Alarms, Platform, 
Errors and Traps. This field does not apply to Board Conflicts, and Restarts. 
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• MO-Type: The Maintenance Object type can be selected from an appropriate list of 
Maintenance Objects within each Category. If a specific Maintenance Object is chosen, 
the filter applies only to Maintenance Objects of that type. If the value All is chosen, the 
filter applies to all Maintenance Objects in the Category. 

• MO-Location: The default All applies the filter to all locations for the chosen MO-Type. If 
a location is specified, the filter applies only to that location. 

 Note: 

When the MO-Type is specified as Error, the MO-Location field contains the 
Error Code. 

Action Parameters: These parameters are shown in each row of the Alarm Filters panel, and in 
the lower section of the Alarm Filter Configurator used to define or edit alarm filters. 

• Alert/Store as: Select the level of severity at which to alert and store. 

 Store only: The alarm/trap information is stored in the database, but not 
displayed. 

 Critical, Major, Minor, Warning: The alarm/trap information is stored in the 
database and displayed with the selected severity. 

 None: The alarm/trap information is neither stored nor displayed. 

• ARS Script: The fully qualified name of any applicable ARS Script. The default is None. 

• Send Mail To: The address to which to send email notification. The default is None. 

• Trap Level: select the level of severity at which to set an SNMP trap for another 
monitoring system. 

 None: Do not forward/generate a trap for this alarm/trap. 

 Critical, Major, Minor, Warning: Generate/forward a trap to the HP/OV NMS 
system. The default is Major. 

Specifying Default Filters 

The default Alarm/Error panel appears under Administration Root > Default Parameters > 
Alarms/Errors.  

The default alarm filters apply to all systems except those where custom alarm filters have been 
defined. 

Specifying Custom Filters 

The custom Alarm/Error panel appears under Administration Root > Voice System 
Parameters > [system name] > Alarms/Errors.  

For each voice system, collection can be on or off. Each voice system can use either the default 
alarm filter parameter values, or custom alarm filter parameters.  

Adding, Modifying, and Deleting Alarm Filters 

When the alarm filter panel is displayed, you can add, change, and delete filters using the buttons 
at the bottom of the panel: 

• Add: Click Add to open the Alarm Filter Configurator with a blank form for a new filter. 

• Modify: Select an existing filter by clicking on its row. Then click Modify to open the 
Alarm Filter Configurator with the selected filter parameters filled in for editing. 
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• Delete: Select one or more existing filters by clicking on their rows. Then click Delete to 
delete the selected filters. Multiple filters can be selected by clicking the first filter and 
then holding down the <shift> key and clicking the last filter. 

• Save: The Save button becomes active when any changes are mode to the panel. Click 
the Save button to save the changes to the database. Attempting to close the panel 
without saving requires a confirm dialog to save or discard the changes. 

• Reset: The Reset button becomes active when any changes are mode to the panel. 
Click the Reset button to discards any changes to the panel and reloads the panel from 
the database. 

Generating Test Traps 

The Test Trap button at the bottom of the Alarm Filter Panel generates a test trap. 

• At the default level the Test Trap button is always enabled. FPM determines which voice 
systems have CM4.0 (load 730.0 and above) and sets those systems to generate a trap. 

• At the voice system level clicking the Test Trap button generates a trap for that voice 
system. The Test Trap button is enabled only if the voice system has CM4.0 (load 730.0 
and above). 

If an appropriate alarm filter (Type = Trap, Severity = Warning or All) exists, the resulting traps 
display in the Voice System Exception Report. The Description indicates that this is a customer 
alarm test. 
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Threshold Alarm Panel 
The Threshold Alarm Panel gives you detailed control of threshold alarm collection and 
processing. You specify a set of parameters to define threshold variables and values. Additional 
parameters define what actions to take when an alarm is received. 

Use this panel to View, Add, Modify, and Delete parameters for threshold alarms. 

• Default Threshold Panel 

The default Threshold panel appears under Administration Root > Default Parameters 
> Performance Collection.  

The default Threshold panel applies to all systems except those where custom thresholds 
have been defined. 

• Custom Threshold Panel 

The custom Threshold panel appears under Administration Root > Voice System 
Parameters > [system name] > Performance Collection.  

For each voice system, collection can be on or off. Each voice system can use either the 
default threshold parameter values, or custom threshold parameters.  

Viewing Threshold Settings 

Defined threshold settings are displayed as a scrolling list: 

     

 

Selecting a threshold setting and clicking Modify (or clicking Add) opens the selected threshold 
(or a new threshold) in the Performance Threshold Configurator.  
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Threshold Parameters: These parameters are shown in each row of the Thresholds panel, and 
in the upper section of the Performance Threshold Configurator used to define or edit threshold 
settings. 

• Performance Type: Select the type of threshold to be set: 

Attendant Groups 

Hunt Groups 

Coverage Paths 

Principal Data 

Inter-Port Network Latency 

Port Networks 

Processor Occupancy 

Routing Patterns 

Security Violations 

Switch Node Links 

Tone Receivers 

Trunk Groups 

Trunk Groups, ISDN-PRI 
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Attendant Groups 

Trunk Groups, Wideband 

IP Codecs 

IP DSP Resources 

IP Signalling Groups 

Announcements 

CLAN Sockets 

CLAN Ethernet 

CLAN PPP 

Call Rate 

Multimedia Interface 

Expansion Services Module 

Voice Conditioners 

Denial Events 

CAC/BL Status 

 

• Field: Select the data field to be tested for a threshold value: 

The fields available depend on the Performance Threshold selected. For each 
Performance Threshold type, all available data fields are listed. 

• Collection Frequency: Select the frequency of threshold testing:  

 None (this field does not apply) 

 Hourly 

 Daily 

 Weekly 

• Operation: Select the method of threshold testing: 

 None (this field does not apply) 

 > (data value is greater than threshold value) 

 >= (data value is greater than or equal to threshold value) 

 = (data value is equal to threshold value) 

 < (data value is less than threshold value) 
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 <= (data value is less than or equal to threshold value) 

• Threshold: Enter a numeric value to be used for comparison to the data value. 

Action Parameters: These parameters are shown in each row of the Thresholds panel, and in 
the lower section of the Performance Threshold Configurator used to define or edit threshold 
settings. NOTE: Routing to Network Management Systems outside of Fault and Performance 
Manager is on a concealed list of check boxes activated by the NMS button. 

• Alert/Store as: Select the level of severity at which to alert and store. 

 Store only: The threshold information is stored in the database, but not 
displayed. 

 Critical, Major, Minor, Warning: The threshold information is stored in the 
database and displayed with the selected severity. 

• ARS Script: The fully qualified name of any applicable ARS Script. The default is None. 

• Send Mail To: The address to which to send email notification. The default is None. 

• Trap Level: Select the level of severity at which to set an SNMP trap for another 
monitoring system. 

 None: Do not forward/generate a trap for this alarm/trap. 

 Critical, Major, Minor, Warning: Generate/forward a trap to the HP/OV NMS 
system. The default is Major. 

• NMS: Select routing to any or all Network Management Systems in the list of check 
boxes revealed by clicking the NMS button. 

Specifying Default Thresholds 

The default Thresholds panel appears under Administration Root > Default Parameters > 
Performance Collection.  

The default thresholds apply to all systems except those where custom thresholds have been 
defined. 

Specifying Custom Thresholds 

The custom Thresholds panel appears under Administration Root > Voice System Parameters 
> [system name] > Performance Collection.  

For each voice system, collection can be on or off. Each voice system can use either the default 
threshold parameter values, or custom threshold parameters.  

Adding, Modifying, and Deleting Thresholds 

When the Thresholds panel is displayed, you can add, change, and delete thresholds using the 
buttons at the bottom of the panel: 

• Add: Click Add to open the Performance Threshold Configurator with a blank form for a 
new threshold. 

• Modify: Select an existing threshold by clicking on its row. Then click Modify to open the 
Performance Threshold Configurator with the selected threshold parameters filled in for 
editing. 

• Delete: Select one or more existing thresholds by clicking on their rows. Then click 
Delete to delete the selected thresholds. Multiple thresholds can be selected by clicking 
the first threshold and then holding down the <shift> key and clicking the last threshold. 

• Save: The Save button becomes active when any changes are mode to the panel. Click 
the Save button to save the changes to the database. Attempting to close the panel 
without saving requires a confirm dialog to save or discard the changes. 
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• Reset: The Reset button becomes active when any changes are mode to the panel. 
Click the Reset button to discards any changes to the panel and reloads the panel from 
the database. 
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How To Use the Help Desk Feature 
The Help Desk feature provides: 

• Helper: Automatic access to the Communication Manager Maintenance Manual to assist 
in troubleshooting. The page displayed is keyed to the specific exception selected in the 
Voice System Exceptions display or in the Exceptions: Voice System report. 

• SAT Connection: Access to the SAT for the voice system on which the selected 
exception occurred. 

• Assistant: Automatic troubleshooting by a rule-based expert system. 

The Help Desk feature can be activated from the System Configuration panel or from an 
Exceptions: Voice System report. 

Access from System Configuration Panel 

Whenever a voice system is selected in the tree pane of the Configuration and Status monitor 
window, a System Configuration panel displays summary information for that voice system. 
Clicking Exceptions opens a Voice System Exceptions display for the selected voice system. 
Click any row to highlight it and then use the Tools menu to access the desired Help Desk 
feature. 

Access from a Voice System Exceptions Report 

The user may define a report of type “Exceptions: Voice System” for one or more voice systems. 
Whenever a report of this type is displayed, click any row to highlight it and then use the Tools 
menu to access the desired Help Desk feature. 

 Note: 

The name of this report is user specified and may not specifically indicate that voice 
system exceptions are reported. The type of the report, “Exceptions: Voice System” 
controls both the format of the report and the availability of the Help Desk feature. 

Using the Help Desk Feature 

You can view additional information about an exception by clicking on the exception to highlight it 
and then selecting Tool > TroubleShoot > Helper. This opens the Communication Manager 
manual page describing the selected exception. The manual page may suggest additional tests 
or corrective actions that can be accomplished using the SAT. 

 

 

You can get directly to the SAT by selecting Tool > TroubleShoot > SAT Connection.... This 
opens the Login dialog box for the selected system. You must have a user account and password 
on the selected system to use the SAT connection. 
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For some hardware types, you can use the automated assistant to automatically run additional 
test and/or corrective actions by simulating the SAT. You activate the Assistant by selecting Tool 
> TroubleShoot > Assistant. 

 

For additional information, please see Help Desk Feature. 
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Reports 
Reports Types 

 Note: 

Selection of a report type does not determine whether or not you have collected and 
saved the necessary information for the report. See Filtering Alarms, Default and Custom 
System Parameters, and Performance Data for data collection information. 

FPM produces many types of reports. The report types are listed below: 

 Notes: 

 If the value in the Time Scale column is "N/A", the report is not tied to 
any time scale. There are two different types of Time tabs, one for the 
exception reports and one for performance reports. On some of the 
performance reports, there are limited options on the Time tab. 

 The available tabs are listed under Component Selection. 

 If the value in the Secondary Data column is anything other than "N/A", 
the Report Output dialog box has a drop-down list where you can choose 
to display primary data, or one or more types of secondary data. 

• Configuration Reports 

Configuration reports can be run from the View menu (online) on the main Configuration 
and Status screen or System Detail screen as well as from the Report Manager screen. 
While the online and Report Manager reports are similar, they are not identical. 

 

Report Type 

 

Description 

Time  
Scales 

Component 
selection 

Secondary data 

Board Inventory 
(table format 
only) 

Board Inventory shows a 
count of boards (circuit 
packs) by type, code, suffix, 
and vintage. The inventory 
may include all boards or 
only selected systems or 
locations. 

N/A Systems tab 

Location tab 

 

N/A 

Board Report 
(table format 
only) 

Board Report shows a list 
of installed boards (circuit 
packs). The report may 
include all boards, or it may 
be filtered by system, type, 
code, or location. 

N/A Location tab 

Board Type tab 

 

N/A 
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Report Type 

 

Description 

Time  
Scales 

Component 
selection 

Secondary data 

Capacity Report 
(table format 
only) 

Capacity Report provides 
used and available capacity 
information for a switch. 
The report displays 
information for the selected 
switches. 

N/A Systems tab N/A 

Board Inventory 
(online) 

Board Inventory shows a 
count of boards (circuit 
packs) by type, code, suffix, 
and vintage. The inventory 
is filtered automatically 
based on the current 
position in the 
Configuration and Status or 
System Detail screen. 

N/A Automatic N/A 

Board Report 
(online) 

Board Report shows a list 
of installed boards (circuit 
packs). The inventory is 
filtered automatically based 
on the current position in 
the Configuration and 
Status or System Detail 
screen. 

N/A Automatic N/A 

Capacity Report 
(online) 

Capacity Report provides 
used and available capacity 
information for a switch. 
The inventory is filtered 
automatically based on the 
current position in the 
Configuration and Status or 
System Detail screen. 

N/A Automatic N/A 
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• Exception Reports 

Some exception reports can be run from the View menu (online) on the main 
Configuration and Status screen or System Detail screen as well as from the Report 
Manager screen. While the online and Report Manager reports are similar, they are not 
identical. 

 

Report Type Description Time  
Scales 

Component 
selection 

Secondary 
data 

Exceptions: 
Adjunct Systems  
(table format only) 

Adjunct Exceptions shows 
adjunct-related exceptions, 
for example, alarms or 
traps. Exceptions may be 
filtered by system or by 
time. 

Time tab 
(Excptns) 

Systems tab 

 

N/A 

Exceptions: 
Fault/Performance 
Manager 
(table format only) 

Network Manager 
exceptions shows 
exceptions related to this 
application, for example, 
failure to collect data or run 
a scheduled report. 
Exceptions may be filtered 
by type or time. 

Time tab 
(Excptns) 

N/A N/A 

Exceptions: Voice 
System 
(table format only) 

Voice System Exceptions 
shows voice system-related 
exceptions, for example, 
alarms or TG GOS 
violations. Exceptions may 
be filtered by system, type, 
location, or time. 

Time tab 
(Excptns) 

Systems tab 

Types tab 

Location tab 

N/A 

Exceptions: Voice 
System 
(online) 

Voice System Exceptions 
shows voice system-related 
exceptions. The exceptions 
are filtered automatically 
based on the current 
position in the Configuration 
and Status or System Detail 
screen. 

N/A Automatic N/A 

Exceptions: 
Transaction Logs 

Transaction Logs shows all 
transactions in FPM such as 
logins and busyouts and 
releases on media modules 
and ports.  

Time tab 
(Excptns) 

Systems tab N/A 
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• Performance Reports 

Performance reports run only from the Report Manager. However, you can go directly to 
the New Report dialog box from View > Performance Data on the main Configuration 
and Status screen. 

Report Type Description Time  
Scales 

Component 
selection 

Secondary data 

Performance: 
Announcements 

Announcements 
performance shows 
maximum in-region and out-
region play requests queued, 
requested, and dropped. 
Records may be filtered by 
system time. 

Time tab Systems tab 

 

 

N/A 

Performance: 
Attendant 
Groups 

Attendant Group 
performance shows call 
counts and usage for the 
group and for individual 
attendants. Records may be 
filtered by system and time. 

Time tab Systems tab 

 

Attendants 

Performance:  
CAC/BL Status 

Call Admission Control / 
Bandwidth Limitation 
performance shows source 
and destination region, 
connection type and status, 
bandwidth limit value and 
units, transmission and 
reception bandwidth and 
number of connections, and 
number of denials. 

Time tab Systems tab N/A 

Performance: 
Call Rate 

Call Rate performance 
shows busiest hour and 
interval. May be filtered by 
system and time.  

Time tab Systems tab 

Call Rate 
Types tab 

 

N/A 

Performance:  
CLAN Ethernet 

CLAN Ethernet performance 
shows CLAN ethernet crc 
counts, and delta by board. 
May be filtered by system 
and time. 

Time tab Systems tab N/A 

Performance: 
CLAN PPP 

CLAN PPP performance 
shows CLAN PPP crc counts 
and delta by board. May be 
filtered by system and time. 

Time tab Systems tab 

Board Type tab 

 

N/A 
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Report Type Description Time  
Scales 

Component 
selection 

Secondary data 

Performance: 
CLAN Sockets 

CLAN Sockets performance 
shows CLAN socket usage, 
and denial counts and 
percentages by boards and 
regions. May be filtered by 
system and time.  

Time tab Systems tab N/A 

Performance: 
Coverage Paths 

Coverage Paths 
performance shows 
configuration, usage, and 
call counts. Records may be 
filtered by system, coverage 
path, and time. 

Time tab Systems tab 

Coverage 
Paths tab 

 

N/A 

Performance: 
Denial Events 

Denial Events performance 
shows event type, 
description, event data, first 
occurrence, last occurrence, 
and event count. May be 
filtered by system and time. 

Time tab Systems tab N/A 

Performance: 
Expansion 
Services Module 

Expansion Service Module 
performance shows available 
ports/usage, total 
usage/allocation, denials, out 
of service, and blockage. 
May be filtered by system 
and time. 

Time tab Systems tab N/A 

Performance:  
Hunt Groups 

Hunt Group performance 
shows configuration, usage, 
and call counts. May be 
filtered by system, hunt 
group, and time. 

Time tab Systems tab 

Hunt Groups 
tab 

 

N/A 

Performance:  
Inter-Port  
Network 
Latency 

Inter-Port Network Latency 
shows PN connection 
requests and ATM setup 
requests with average delay 
in milliseconds. Records may 
be filtered by system, PN 
pairs, and time. 

Time tab Systems tab 

PN 
Connections 
tab 

 

N/A 

Performance: 
IP Codecs 

IP Codecs performance 
shows G.711/G.732/G.729 
codec usage, in CCS or 
Erlangs for IP codecs. 
Records may be filtered by 
system, IP codec type, and 
time. 

Time tab Systems tab N/A 
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Report Type Description Time  
Scales 

Component 
selection 

Secondary data 

Performance: 
IP DSP 
Resources 

IP DSP Resources 
performance shows 
configuration, usage, and 
peg counts for IP DSP 
resources. Records may be 
filtered by system and time. 

Time tab Systems tab N/A 

Performance: 
IP Signaling 
Groups 

IP Signaling Groups 
performance shows packet 
latencies, and packets sent 
and lost for IP Signaling 
Groups. Records may be 
filtered by system and time. 

Time tab Systems tab N/A 

Performance: 
Multimedia 
Interface 

Multimedia Interface 
performance shows available 
ports/usage, total 
usage/allocation, denials, out 
of service, and blockage. 
May be filtered by system 
and time. 

Time tab Systems tab N/A 

Performance:  
Port Networks 

Port Networks performance 
shows usage and peg 
counts. Records may be 
filtered by system, PN pair, 
and time. 

Time tab Systems tab 

Port Networks 
tab 

N/A 

Performance: 
Principal Data 

Principal Data performance 
shows configuration, usage, 
and call counts. Records 
may be filtered by system, 
principal data, and time. 

Time tab Systems tab 

Principal Data 
tab 

 

N/A 

Performance:  
Processor 
Occupancy 

Processor Occupancy shows 
occupancy and call counts. 
May be filtered by system 
and time. 

Time tab Systems tab N/A 

Performance:  
Routing 
Patterns 

Routing Patterns 
performance shows call 
counts for routing patterns 
and trunk groups within 
routing patterns. Records 
may be filtered by system, 
routing pattern, and time. 

Time tab Systems tab 

Routing 
Patterns tab 

 

Trunk groups 
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Report Type Description Time  
Scales 

Component 
selection 

Secondary data 

Performance:  
Security 
Violations 

Security Violations includes 
valid and invalid attempts by 
port type and by system. 
Records may be filtered by 
system and time. 

Time tab Systems tab Port types 

Performance:  
Switch Node 
Links 

Switch Node Link 
performance shows usage 
and peg counts. Records 
may be filtered by system, 
SN link, and time. 

Time tab Systems tab 

Switch Node 
Links tab 

 

N/A 

Performance:  
Tone Receivers 

Tone receiver performance 
shows peg counts for each 
tone receiver type and port 
network. Records may be 
filtered by system, tone 
receiver type, and time. 

Time tab Systems tab 

Tone 
Receivers tab 

 

Port networks 

Performance:  
Trunk Groups 

Trunk Group performance 
shows usage, peg count, 
and grade-of-service.  

Time tab Systems tab 

Trunk Groups 
tab 

 

Primary Data or 
Average Data 

Performance:  
Trunk Groups  
ISDN-PRI CBC 

ISDN-PRI performance 
shows configuration, usage, 
and counts for ISDN TG  

Time tab Systems tab 

Trunk Groups 
tab 

ISDN services 
or features, and 
usage 
allocation plans 

Performance:  
Trunk Groups, 
Wideband 

Wideband Trunk 
performance shows 
configuration, usage, and 
peg counts for wideband 
TGs. Records may be filtered 
by system, TG or TG list, and 
time. 

Time tab Systems tab 

Trunk Groups 
tab 

N/A 

Performance: 
Voice 
Conditioner 

Voice Conditioner 
performance shows available 
counts/usage, 
H320/voice/total 
usage/allocation/denials, out-
of-service, and blockage. 
May be filtered by system 
and time. 

Time tab Systems tab N/A 
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Running Reports 
How to view a list of existing reports 

There are two types of "existing reports" in FPM: 

• Reports that have been defined but may or may not have been run. 

• Reports that have been run, generating output. 

To view a list of defined reports 

1. Open the Report Manager by choosing File>Report Manager. 

2. In the left pane, click Report Definitions. 

The list of defined reports appears in the right pane. 

To view a list of output (or view the report output) 

 Note: 

Usually, all report output is stored in the same directory. If you know the directory name, 
you can skip steps 1 through 4. 

 

To view the list of report files, follow these steps. 

1. Open the Report Manager by choosing File>Report Manager. 

2. In the left pane, click Report Definitions. 

3. In the right pane, select the report you are interested in and click Open. 

The Report Definition dialog box opens.  

4. Click the Destination tab. 

The folder containing report output is listed in the text box under the File checkbox. 

5. Using Windows Explorer, navigate to the folder where you (or others) may have stored 
output. This folder may not be on your machine, and may not be accessible. 

6. Double click the report you want to view to open it in Internet Explorer. The report output 
has the name requested when the report was defined, possibly followed by a date. The 
file is in HTM format. If the report has both principal and secondary data, both are printed 
in separate sections. To print a copy of the HTML report, use Internet Explorer's print 
function. 

Related Topics 

• How To View Report Settings  

• How To View a Report  
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How To View or Change Report Settings 
To view the settings of an existing report, complete the following steps: 

1. Open the Report Manager by selecting File>Report Manager. 

2. In the left pane, click Report Definitions. 

3. In the right pane, click the report with the settings you want to view or change.  

4. Click Open.  

FPM displays the report in the Report Definition Dialog Box. 

5. To view the report settings, click the tabs. 

6. To change the report settings, enter new values in the appropriate fields. 

For help completing any of the tabs, click Help on that screen. 

7. Do one of the following: 

 To overwrite the settings of the old report, click Save. 

 To create a new report definition with your new settings and leave the old 
settings intact, change the name of the report and then click Save. 

8. When you are finished viewing or changing the report settings, do one of the following: 

 Click Run Now to run the report immediately. 

 Click Schedule and complete the Schedule Report Dialog Box to schedule the 
report to run later. 

For help completing the Schedule Report Dialog Box, click Help on that screen.  

 Click the "X" in the upper right corner to close the Report Definition dialog box. 

Related Topics 

• How To Create a New Report  

• How To View a Report  

• How To Print a Report  
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How To Create a New Report 
To create a new report:  

• Define the report 

• Run or Schedule the report 

• View or print the report 

What do you want to do? 

• View a list of existing reports  

• Define a new report  

• View or change the settings of an existing report  

• Run or schedule a report  

• View a report  

• Print a report  
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How To Define a New Report 
When you "define" a new report, you specify the information that FPM needs in order to run and 
store the report. Once you define the report and save the definition, you need to run or schedule 
the report, and then view it or print it. 

To define a new report, complete the following steps: 

1. Open the Report Manager by choosing File>Report Manager. 

2. In the left pane, click Report Definitions. 

3. In the right pane, click the New button.  

FPM displays the New Report Dialog Box 

4. Select the report type from the available list.  

FPM displays a description of the selected report type in the information box below the 
report type list box. 

5. Enter a unique name for the new report in the Enter Report Name text box. 

6. Click OK to create the new report. 

FPM displays the Report Definition Dialog Box. This dialog box contains different tabs 
depending on the type of report you are creating. 

7. In the screen that appears, click the tabs and complete the fields to define the report.  

For help completing any of the tabs, click Help on that screen. 

8. Click Save to save the report to run at a later date or set up for scheduling. 

Related Topics 

• How To Create a New Report  

• How To Run or Schedule a Report  

• How To View a Report  

• How To Print a Report  
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How To Run or Schedule a Report 

 Note: 

You can complete administration functions such as printing a report only from the server 
application GUI. Administration functions are not available from the Web client. 

 Note: 

Scheduling takes place on the Linux server. To create graphics, the X-windowing system 
MUST be started, and must be running when the report runs. 

 Note: 

Scheduling a report does not necessarily print the report. When the report runs, whether 
or not FPM prints the report is determined by the settings you specify in the Report 
Definitions Dialog Box on the Destinations tab. 

Scheduling a report gives FPM the information it needs to run the report on the day and at the 
time you specify. You can schedule a report to run immediately or later.  

1. Open the Report Manager by choosing File>Report Manager. 

2. In the left pane, click Report Definitions. 

3. In the right pane, select the report you want to schedule. 

If the report you want is not on the list, you may not have created it yet. Create it and then 
return to this topic when you want to schedule it. 

4. Click the Open button.  

FPM displays the Report Definition Dialog Box. 

5. Click the Destination tab and verify that the report output is directed to a printer or a file. 

6. To run the report immediately, click the Run Now button. 

7. To schedule the report to run later, do the following: 

 Give the report definition a unique name and click the Save button. 

 Click the Schedule button. 

FPM displays the Schedule Report Dialog Box. 

 Complete the Schedule Report dialog box.  

For help completing the fields, click the Help button on that screen. 

Related Topics 

• How To Create a New Report  

• How To View a Report  

• How To Print a Report  
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How To View a Report 

 Note: 

Usually, all report output is stored in the same directory. If you know the directory name, 
you can skip steps 1 through 4. 

First, view the list of report files: 

1. Open the Report Manager by choosing File>Report Manager. 

2. In the left pane, click Report Definitions. 

3. In the right pane, select the report you are interested in and click Open. 

The Report Definition Dialog Box opens.  

4. Click the Destination tab. 

The folder containing report output is listed in the text box under the File checkbox. 

5. Using Windows Explorer, navigate to the folder where you (or others) may have stored 
output. This folder may not be on your machine, and may not be accessible. 

6. Double click the report you want to view to open it in Internet Explorer. The report output 
has the name requested when the report was defined, possibly followed by a date. The 
file is in HTM format. If the report has both principal and secondary data, both are printed 
in separate sections. You can print the HTML version of the report using the Internet 
Explorer print function. 

Related Topics 

• How To Create a New Report  

• How To Schedule a Report  

• How To Print a Report  
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How To Print a Report 

 Note: 

You can complete administration functions such as printing a report only from the server 
application GUI. Administration functions are not available from the Web client. 

Before you can print a report, you have to create it (unless it already exists) and run it. In addition, 
your printer must be on, properly configured, and capable of printing Postscript files.  

After you create and run the report, you can print it by completing the following steps: 

1. Open the Report Manager by choosing File>Report Manager. 

2. In the left pane, click Report Definitions. 

3. In the right pane, select the report you are interested in and click Open. 

The Report Definition Dialog Box opens.  

4. Click the Destination tab. 

5. Check Print and enter a destination (printer). 

6. Click Run Now to generate and print the report. 

Related Topics 

• How To Create a New Report  

• How To Run or Schedule a Report  

• How To View a Report  
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Report Descriptions 
Report Manager Screen 

From the File menu of the Configuration and Status screen you can select File > Report 
Manager... to open the FPM Report Manager screen. 

 

 

The FPM Report Manager screen provides: 

• Report Definitions 
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The Report Definitions panel lists all currently defined reports. 

For new reports, you can select report type, systems, and other parameters. You can 
schedule when reports are run on a regular basis. You can create ad-hoc reports and run 
them immediately when investigating a problem. 

For the types of reports you can define, see Report Types in the following topic. 

• Scheduled Reports 

You can select any  regularly scheduled report that has been saved to a file and display it 
or print it. 

• Trunk Group Lists 

You can define trunk group lists for reports that are based on network performance rather 
than system performance. 

Related Topics 

• New Report Dialog Box 

• Report Types 

• Defined Reports 

• Scheduled Reports 

• Trunk Group Lists 
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Report Definition Dialog Box 

The Report Definition screen has a variable number of tabs depending on the Report Type 
selected. There are six types of tabs. All reports have Systems, Fields, Sort, and Destination 
tabs. Other tabs are present when appropriate to the individual report. 

• Systems Tab — allows you to select the systems included in the report. 

• Component selection tabs, if any, appear here. See list below: 

 Board Type Tab — allows you to select the boards included in the report. 

 Hunt Groups Tab — allows you to select the hunt groups included in the report. 

 IP Codecs Tab — allows you to specify which IP codec types are included in the 
report. 

 Location Tab (Board Report) — allows you to specify the board information at all 
locations or at one location included in the report. 

 Location Tab (Exceptions Report) — allows you to specify the exceptions at all 
locations or at one location included in the report. 

 PN Connections Tab — allows you to select the port network connections 
included in the report. 

 Port Networks Tab — allows you to select the port networks included in the 
report. 

 Routing Patterns Tab — allows you to select the routing patterns included in the 
report. 

 Switch Node Links Tab — allows you to select the switch node links included in 
the report. 

 Time Tab (general) — allows you to set time options for the report. (Hourly 
counts, Daily peaks, or Weekly peaks; previous period, or fixed interval.) 

 Time Tab (Exceptions Report) — allows you to specify exception time options in 
your report. (Show current exceptions, or Show exception history.) 

 Tone Receivers Tab — allows you to select the type of tone receivers included 
in the report. 

 Trunk Groups Tab — allows you to select trunk groups included in the report. 

 Types tab (Voice System Exceptions Report) — allows you to select the types of 
exceptions included in the report. 

• Format Tab — allows you to select "table" or "chart," and specify chart properties. This 
tab does not appear for "table form only" reports. 

 Chart Properties Dialog Box — Allows you to specify type of chart, 3D 
properties of the chart, and the fields to plot along the X and Y axes. 

• Fields Tab — allows you to select the data fields included in the report and specify the 
order of the fields. 

• Sort Tab — allows you to specify up to three levels of sorting based on the included 
fields. 

• Destination Tab — allows you to direct the report output to the screen, a printer, or a file. 

 Print Properties Dialog Box — allows you to find networked printers and specify 
print properties. 
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Report Output Window 

This window provides the following information: 

• Report name 

• Run date and time 

• Time interval covered by the report (Start date and time and End date and time) 

• Primary data/Secondary data combo selection box (if the report type contains secondary 
data types) 

Menu Options 

The Report Output Window includes the following menu options: 

• File: 

 Open>Chart: Shows the selected report output in chart format (if supported by 
the report type). 

 Open>Table: Shows the selected report output in table format. 

 Save As: Opens a dialog box that lets you save the report as an HTML file. 

 View as HTML: Opens the report output in Internet Explorer. 

 Close: Closes the Report Output window. 

• Tools: 

 Sort: Opens a dialog box that lets you choose sorting options. 

 Acknowledge: Enabled only for an exception report. Acknowledges all 
exceptions on the list. (The exceptions are removed from the list as they have 
presumably been processed.) 

 Configuration: Opens a configuration screen for the hardware highlighted in the 
Report Output Window. (Typical shown below.) 
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 Error Description: Provides an error description for the highlighted error on the 
Error Report. See Associated Errors (next).  

This window provides the following information about selected voice system 
errors: 

 The Maintenance Name. 

 The Error Code. 

 The Alt Name/Aux Data. 

 The Error Description corresponding to the maintenance name/error 
code/Alt Name if supplied by the voice system. If there is no supplied 
description, then "Not Available" appears in the Error Description box.) 

 A Notes text box in which any previous notes are displayed with the date 
and time of the last update, and in which you can enter notes pertaining 
to the error in question. 
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 Command buttons: 

o Save: Saves any modifications. 

o Close: Closes the window. 

o Help: Displays a help window. 

 Associated Errors: Enabled only for an exception report. Opens the Error 
Report for the highlighted alarm. This shows all errors associated with the 
highlighted alarm. 

 

 TroubleShoot > Helper: Enabled only for an exception report. Opens the 
Communication Manager manual page describing the selected exception. The 
manual page may suggest additional tests or corrective actions that can be 
accomplished using the SAT. 

 TroubleShoot > SAT Connection: Enabled only for an exception report. Opens 
the Login dialog box for the selected system. You must have a user account and 
password on the selected system to use the SAT connection. 

• Help 

 Help Topics: Displays the Help Table of Contents 

 Current Pane: Accesses help on the panel in the display pane 

 About: Displays information about Fault and Performance Manager 
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Scheduled Reports 

The Scheduled Reports panel lists all reports that have been scheduled for later execution.  

 

Buttons: 

• Exceptions — Shows report failure exceptions related to the selected report(s). 

• Reschedule — Highlight a row by clicking on it. Then click Reschedule. The existing 
report is opened in the Schedule Report dialog box. 

• Delete — Highlight a row by clicking on it. Then click Delete. The existing report is 
deleted. 

• Help: Displays a help screen for this panel. 

Related Topics 

• Schedule Report Dialog Box 

• Exceptions 
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Schedule Report Dialog Box 

 Note: 

You can complete administration functions such as scheduling a report only from the 
server application GUI. Administration functions are not available from the Web client. 

 Note: 

Scheduling takes place on the Linux server. To create graphics, the X-windowing system 
MUST be started, and must be running when the report runs. 

 

This dialog lets you specify when you want a report to run. 

 

1. Select an option button and complete the corresponding fields to define the schedule: 

 Run once at: Enter the date in dd/mm/yy format, and enter the time start time in 
military format (24 hr.) 

 Run daily: Enter the start time in military format (24 hr.) 

 Run weekly: Select a day of the week, and enter the start time in military format 
(24 hr.) 

 Run monthly: Select a day of the month, or select the last day of the month. 

2. Click Save to save your changes or Reset to reset the fields to their previous values. 

3. Select the Start and Stop tab. 
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4. Select the Start Schedule on check box and enter a start date in dd/mm/yy format. 

5. Select the Stop Schedule on check box and enter a stop date in dd/mm/yy format. 

6. Click Save to save your changes or Reset to reset the fields to their previous values. 

Related Topics 

• How to run or schedule a report 
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Configuration Reports 

Board Inventory Report 

The Configuration Board Inventory Report shows a count of boards (circuit packs) by type, code, 
suffix, and vintage. The inventory may include all boards or only selected systems or locations. 

Fields 

Column  Contains 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Type Board type 

Code Board code and suffix 

Vintage Board vintage code 

Count Board count 

Tabs 

• Systems tab 

• Location tab 

• Fields tab 

• Sort tab 

• Destination tab 

Related Topics 

• Board Inventory Report (Online) 



Using Avaya FPM 

185 

Board Report 

The Configuration Board Report shows a list of installed boards (circuit packs). The report may 
include all boards, or it may be filtered by system, type, code, or location. 

Fields 

Column Contains 

Severity Alert severity Icon 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Location The cabinet, carrier, and slot for the specified board. 

Type Board Type 

Code Board code and suffix 

Vintage Board manufacture date 

AssignPorts Count of assigned ports 

UnassignPorts Count of unassigned ports 

TTIPorts Count of TTI ports 

PSAPorts Count of PSA ports 

TotPorts Total number of ports 

PN/SN Port network or Switch node number 

SigType Signaling type 

Name Board name 

CSU ID CSU module ID 

Tabs 

• Systems tab 

• Location tab 

• Board Type tab 

• Fields tab 

• Sort tab 

• Destination tab 

Related Topics 

• Board Report (Online) 
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Capacity Report 

The Capacity Report provides used and available capacity information for a switch. The report 
displays information for the selected switches. 

Fields 

Column Contains 

Name A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Switch Type Voice System type 

Building Location Voice System Location 

# if Cabinets Number of cabinets 

# of Carriers (in use) Number of carriers in use 

# of Unused Carriers Number of spare carriers 

Total Slot Total slots available 

Used Slot Number of slots used 

Spare Slot Number of slots available 

Total Digital Ports Total digital ports 

Used Digital Ports Number of digital ports used 

Spare Digital Ports Number of digital ports available 

Total Analog Ports Total analog ports 

Used Analog Ports Number of analog ports used 

Spare Analog Ports Number of analog ports available 

Total License Ports Total licensed ports 

Used Licensed Ports Number of licensed ports used 

Spare Licensed Ports Number of licensed ports available 

Total X Mobility  

Used X Mobility  
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Column Contains 

Spare X Mobility  

Total IP Stations Total IP stations 

Used IP Stations Number of IP stations used 

Spare IP Stations Number of IP stations available 

Total DS1s Total DS1 trunks 

Total Trunk Ports Total trunk ports 

Total Station Total stations 

ACD License ACD license included 

Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Destination tab 

Related Topics 

• Capacity  Report (Online) 



Avaya Fault & Performance Manager User Guide 

188 

Exception Reports 

Table of Exception Types and Reports 

Exception Type Exception Report Location or Component Selection 

Data collection failures 

Scheduled report failures 

Network Manager 
Exceptions 

None 

Alarms 

Errors 

Voice System 
Exceptions 

Voice System plus one of the following: 

-Hardware location (cabinet, carrier, slot, 
port) 

-Port network number 

-Switch node number 

-Trunk group or group and member 

-One or both of the following: 
--Equipment type, usually a voice system 
Maintenance Name 
--Equipment identifier, usually a voice 
system Alt Name, for example an extension. 
May also be trunk group number or trunk 
group and member. 

Board conflicts 

Restarts 

Voice System 
Exceptions 

Voice System 

Processor occupancy 
exceptions 

Voice System 
Exceptions 

Voice System 

TG GOS violations Voice System 
Exceptions 

Voice System plus trunk group 

Trunk outages 

Trunks - Lightly-used 

Trunk holding times 

Voice System 
Exceptions 

Voice System plus trunk group or trunk 
group and member 

N/A Transaction Logs 
Exceptions 

Voice System 
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Exceptions: Adjunct Systems 

The Adjunct Systems Exceptions Report shows adjunct-related exceptions, for example, alarms 
or traps. Exceptions may be filtered by system or by time. 

Fields 

• CMS Exceptions 

Column Contains 

Severity Alert Severity (key) 

Type Type (key) 

ADJUNCT ADJUNCT 

Product ID Product ID 

Alarm No. Alarm No. 

Name Name 

Product Type Product Type 

Version Version 

ID Value ID Value 

Alarms No. Alarms No. 

ADJUNCT Start ADJUNCT Start Date and Time (key) 

ADJUNCT End ADJUNCT End Date and Time (key) 

Alert Alert 

Exc DB ID Exception Database Identifier. 

• Messaging Adjunct Exceptions 

Column Contains 

Severity Alert Severity (key) 

Type Type (key) 

ADJUNCT ADJUNCT 

Product ID Product ID 
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Column Contains 

Alarm No. Alarm No. 

Location Location 

Resource Resource 

Fault Code Fault Code 

Module ID Module ID 

Event No. Event No. 

Count No. Count No. 

ADJUNCT Start ADJUNCT Start Date and Time (key) 

ADJUNCT End ADJUNCT End Date and Time (key) 

Alert Alert 

Exc DB ID Exception Database Identifier. 

• VMM Exceptions 

Column Contains 

Severity Alert Severity (key) 

Type Type (key) 

ADJUNCT ADJUNCT name 

Product ID Product ID 

Alarm No. Alarm No. 

Participant Address Participant IP address 

Participant Phone Participant phone number 

Participant 
GateKeeper 

Participant Gate Keeper name 

Participant Peer 
Address 

Participant Peer Address 

QoS RTT Packet delay 
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Column Contains 

QoS Jitter Average jitter 

QoS Packets Packets Sent 

QoS Lost Packets Lost Packets 

System Alarm Count System Alarm Count 

System Alarm 
Threshold 

System Alarm Threshold value 

Trap Location Trap Location 

RTPCInactivityTimeout RTPC Inactivity Timeout value 

Alert Alert 

Exc DB ID Exception Database Identifier. 

Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Time tab 

• Destination tab 
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Exceptions: Fault/Performance Manager 

Network Manager exceptions shows exceptions related to this application, for example, failure to 
collect data or run a scheduled report. Exceptions may be filtered by type or time. 

Fields 

Column Contains 

Severity Alert Severity (key) 

Type Exception Type (key) 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

NMS Start Most recent date and time when the Network Management System 
(NMS) software started. 

NMS End Most recent date and time when the Network Management System 
(NMS) software ended. 

Alert Alert identifier. 

Description Alert description. 

Exc DB ID Exception Database Identifier. 

Tabs 

• Fields tab 

• Sort tab 

• Time tab 

• Destination tab 
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Exceptions: Voice Systems 

The Voice Systems Exception Report shows current or historical exceptions for the selected 
systems. Exceptions may be filtered by type or time. 

Types 

Type of Exceptions 

Alarms 

Server Alarm 

Errors 

Board Conflicts 

Restarts 

Processor Occupancy Exceptions 

TG Grade of Service Violations 

Trunk Outages 

Trunks Lightly Used 

Trunk Long Holding Time 

Trunk Short Holding Time 

Management Security Service Traps 

Performance Alarm 

Fields 

Column Contains 

Severity Alert Severity (key) 

Type Type of exception (key). See table above for values. 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Location The cabinet, carrier, and slot for the specified board. 

Equip Type Equipment Type 

Equip ID Equipment ID 
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Column Contains 

Voice System Start Most recent date and time when the voice system software 
started (key). 

Voice system End Most recent date and time when the voice system software 
ended. 

Description The Description field may contain trap data fields as well as a 
brief description of the problem. 

AlmNum Alarm number 

Alert  

Exc DB ID Exception Database Identifier. 

Tabs 

• Systems tab 

• Types tab 

• Location tab 

• Fields tab 

• Sort tab 

• Time tab 

• Destination tab 
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Exceptions: Transaction Logs 

The Transaction Logs Exception Report shows current or historical transactions for the selected 
systems. Transactions may be filtered by time. 

Fields 

Column Contains 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

NMS Start Most recent date and time when the voice system software 
started (key). 

NMS End Most recent date and time when the Network Management 
System (NMS) software ended. 

Description The Description field contains details of each transaction including 
the userid, system, transaction type and results as applicable. 

Tabs 

• Systems tab 

• Time tab 

• Fields tab 

• Sort tab 

• Destination tab 
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Performance Reports 

Performance: Announcements 

The Announcements Performance Report shows maximum in-region and out-region play 
requests queued, requested, and dropped. Records may be filtered by system and time. 

Fields 

Column Contains 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

Board Location The cabinet, carrier, and slot for the specified board. 

Calls Queued Calls Queued. The number of announcements that were held in 
queue while waiting for a port during the period. 

Extension Assigned extension. 

Max Calls Maximum Calls. The peak number callers simultaneously connected 
to a port by announcement during the period. 

Max Callers on Board 
/ Period 

The peak number callers simultaneously connected to a circuit pack 
(sum of the ports) at the same time. 

Max Ports Maximum Ports. The peak number of ports used simultaneously for 
playing the same announcement during the period (1-16 for TN750; 
1-31 for TN2501AP). 

MPort Plays Multi-port Plays. A count of how many times the announcement 
played through more than one port simultaneously during the period. 

Name (First 24 
Chars) 

The first 24 characters of the 27-character announcement name as 
administered on the announcement form. 

PSP Peak speed-to-play from the time the request to play the 
announcement went into the queue until the time it starts playing. 
Abandoned calls that are waiting for announcement port are not 
included in the calculation. 

Announcement 
Number 

The system assigned number of the announcement. 

Play Ports The number of ports available on the circuit pack. 
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Column Contains 

Play Requests The number of requests to play this announcement. 

• If there is a queue, equals the number of times played plus 
abandons 

• If there is no queue, equals the number of times played plus 
“busys” (no ports are available) 

All Ports Busy / 
Period 

A count of how many times the all-ports-busy condition occurred 
within the reporting period.  

Queue Drops Calls that dropped while in queue. A count of the individual calls that 
had to queue but dropped while waiting during the period - this 
includes calls abandoned by the caller and VOA aborts but excludes 
calls that were waiting but answered by an agent. 

Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Time tab 

• Destination tab 
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Performance: Attendant Groups report 

The Attendant Groups Performance Report shows call counts and usage for the group and for 
individual attendants. Records may be filtered by system and time. 

Fields 

• Primary level data: 

Column Contains 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management 
System (NMS) software started. 

AvgHold  Average Hold Time 

CallsHeld  The number of calls answered by the attendant group and 
subsequently placed on hold by the attendant group. 

TalkTime The total time, during the measurement interval, attendant(s) are 
active or talking on a loop (measured in CCS). Talk time is not 
started until the call is answered by the attendant. The duration of 
time between the call terminating at the attendant console and 
when the call is answered is not accumulated as either Avail Time 
or Talk Time.  

Calls split by the attendant do not accumulate talk time from the 
point when the attendant presses the start button until the call is 
placed. 

Calls routed to an attendant via a hunt group are treated as calls 
to the attendant extension and therefore do not accumulate talk 
time. 

NOTE: 

An attendant can have up to six calls on hold at any one time. 
However, each attendant can only be active on one loop at a time. 

Suggested action: If talk time is acceptable, but one or more of 
the other measurements are unacceptable, then all parameters 
should be studied in order to identify what should be changed (the 
number of consoles, number of attendant  positions staffed, 
attendants schedule, faulty trunks, and so on). 
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Column Contains 

TimeAvail Time Available. The time during which the “pos avail” lamp is lit on 
all attendant consoles, and the attendants are not talking on calls 
but are available to handle new calls. Measured in Centum 
(hundred) Call Seconds (CCS). 

NOTE: 

An attendant can have calls on hold and still be available. For 
example, if two attendants are available for 15 minutes each 
during the measurement hour, the total available time would be 30 
minutes or 18 CCS (0.5 hour X 36 CCS per hour). 

Consoles may be administered either with their own unique 
extension number or without any extension number. For the “with 
extension number” case, traffic measurements for outgoing calls 
and incoming calls to the extension are allotted to the console’s 
extension number and not to the attendant group. For the “without” 
case, all traffic measurements are allotted to the attendant group. 
The time the console is on outgoing calls is not included in the 
attendant group’s Time Avail measurement. 

Attendants are not available and do not accumulate time available 
when: 

• The position is in Night Service 

• The position was busied-out 

• The headset is unplugged 

• The attendant is servicing a call 

Suggested actions: 

• If the Time Avail plus Time Talk fields total to a number 
less than 36 CCS X the number of attendants, then some 
of the attendant positions are not staffed for the 
measurement hour. If this is a problem, then it is 
appropriate to staff additional positions during the busy 
hour(s). 

• If the Time Avail plus Time Talk fields equal 36 CCS X the 
number of attendants, then any time available is idle time 
or time not spent on calls. A large number for the Time 
Avail field indicates a low occupancy. If this is a problem, 
then it is appropriate to reduce the number of attendant 
positions that are staffed. Staffed time is usually very 
close to the sum of the Time Avail and Time Talk fields. 

CallsAns The number of calls answered by all active attendants during the 
measurement hour. With Total Usage and Calls Answered, you 
can determine the Average Work Time (AWT), which is the time it 
takes an attendant to handle a call. 

Calls placed to individual attendant extensions or that route to an 
attendant via a hunt group do not increment the CallsAns counter. 



Avaya Fault & Performance Manager User Guide 

200 

Column Contains 

HeldTime The total amount of time (measured in seconds) the attendants 
have calls on hold. 

CallsQue The total number of calls placed in the attendant queue (delayed) 
because no attendants are available. Calls remain in the queue 
until one of the following occurs: 

• An attendant becomes available and the call is connected. 

• The caller, while waiting in the queue, abandons the call 
hangs up) before an attendant is available. 

• The call covers to another point in a coverage path. 

CallsHeldAban Calls Held-Abandoned. The number of calls that abandon while 
the caller is in hold mode. Held calls which time out and re-alert 
are included in the held-abandoned call count. 

Suggested action: If this number is determined to be excessive, 
you should investigate and attempt to identify the reasons. 

CallsAban The number of calls that ring an attendant group and drop (the 
caller hangs up) before an attendant answers. Where applicable, 
this total includes calls abandoned from the attendant queue 
before answered. A call abandoned after placed on hold is not 
included in this measurement, because it is already added to the 
calls answered measurement. 

Suggested action: Observe times during which the calls 
abandoned number may be higher than desirable, and then 
schedule additional attendants in the group as needed during the 
indicated times.  
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Column Contains 

TimeAban Also referred to as time to abandoned. The average amount of 
time calls spend in queue and/or ringing at the console before the 
callers hang up (measured in seconds). 

NOTE: 

Time to abandoned does not include calls that overflow the 
attendant group queue. 

Time To Abandoned = Total Number of Calls Abandoned / 
Total Delay For All Abandoned Calls (in seconds)  

Suggested action: If the TimeAban value is smaller than the 
SpeedAns (sec) value, you need more agents. As a contrast, if the 
TimeAban value is larger than the SpeedAns (sec) value, the 
attendant group should process the calls faster. The attendant 
group should be engineered so TimeAban approximately equals 
the calculated average delay. 

 

Total Delay = (Time To Abandoned) × (# of Abandoned 
Calls) + (Speed of Answer) × (# of Calls Answered) 

Avg Delay = Calls Answered + (CallsAban / Total Delay) 

NOTE: 

If the average time to abandon is equal to or exceeds 9999 
seconds, the value 9999 displays in the field. 

SpeedOfAns The average elapsed time from when a call terminates at the 
attendant group to when the call is answered by an attendant 
(measured in seconds). 

The average time calls wait to ring an attendant (Queue Usage / 
Calls Answered). The Queue Usage is the total time calls spend in 
the attendant queue. 

NOTE: 

Calls terminate either directly to an attendant console and 
subsequently begin ringing or in the attendant queue when there 
are no attendant positions available.  

Speed of Answer = Total Number of Calls Answered / 
Total Delay For All Answered Calls (in seconds)  

If the average time to abandon is equal to or exceeds 9999 
seconds, the value 9999 displays in the field. 

Suggested action: If this number appears to be too high and all 
attendants are working at acceptable efficiency levels, consider 
additional training that may help the attendants complete calls 
more quickly. Alternatively, observe the hours during which speed 
of service becomes unacceptable and consider adding consoles 
and staffing additional attendants during those hours. 
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Column Contains 

Size The number of attendant positions (consoles) administered for the 
groups. 

• Secondary level data: 

Column Contains 

AttID Attendant ID. A number between 1 and the maximum number of 
attendants to identify which attendant’s data is being displayed. 
This number is chosen by the user upon administering this 
attendant. 

AvgHold Average Hold Time 

TalkTime The time the attendant is active on calls (in CCS), measured from 
the time the attendant activates an attendant loop until the loop is 
released. If more than one loop is active on an attendant console 
at one time, the usage is counted only once (for example, one 
attendant is not counted as being busy more than once at a 
single time). 

TimeAvail Time Available. The total time the subject attendant is available to 
receive calls during the polling interval (measured in CCS). 

CallsAns Calls Answered. The total number of calls answered by this 
attendant (measured in CCS). Calls placed to an individual 
attendant extension or that route to an attendant via a hunt group 
do not increment the Calls Ans field. 

HeldTime The time the attendant had calls on hold (measured in seconds). 

Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Time tab 

• Destination tab 
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Performance: Call Admission Control/Bandwidth Limitation report 

The Call Admission Control/Bandwidth Limitation Performance Report shows source and 
destination region, connection type and status, bandwidth limit value and units, transmission and 
reception bandwidth and number of connections, and number of denials. 

Fields 

• Destination Region 

Column Contains 

Source Region Source Region number (1-250) (key) 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

Destination Region Destination Region number (1-250) (key) 

Connection Type Connection Type (Direct | Indirect) 

Connection Status Connection Status (Pass | fail) 

BW Limit Value Bandwidth Limit Value (count of bandwidth limit units). The number 
of calls, Kbits, or Mbits to establish the limit. 

For Dynamic CAC Gateway, this number is assigned by 
Communication Manager. 

BW Limit Units Bandwidth Limit Units. Since the bandwidth limit is by direct 
connection, the single bandwidth limitation applies to the combined 
audio and video traffic. 

• Calls, Kbits, Mbits 

Limit Value indicates maximum bandwidth in the specified 
units. 

• Dynamic 

The maximum bandwidth will be determined dynamically 
based on network load algorithms in media gateways that 
have this capability.  

• No Limit 

BW Used 
Transmission 

transmission. 

BW Used Reception Bandwidth used for Reception 
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Column Contains 

Transmission 
Connect Count 

Transmission Connect Count 

Reception Connect 
Count 

Reception Connect Count 

Denial Count Denial Count 

• Primary Data 

Column Contains 

Source Region Source Region (key) 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

 

Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Call Rate report 

The Call Rate Performance Report shows busiest hour and interval. May be filtered by system 
and time. 

Fields 

Column Contains 

Voice System A 20-character string administered by the customer that 
uniquely identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software 
started (key). 

NMS Time Most recent date and time when the Network Management 
System (NMS) software started. 

Type Type 

Busiest Hour 
Compl 

The number of calls completed, or answered (including 
incoming, outgoing, and intercom) during the busiest hour. 

Busiest Hour 
(Hour) 

Identifies the busiest (peak) hour. This is the hour with the 
largest number of completed calls. 

Busiest Hour Int 
(Min) 

Busiest Hour Int (Min) 

Busiest Hour Int 
(Sec) 

Busiest Hour Int (Sec) 

Busiest Hour Int 
Calls Compl 

Busiest Hour Int Calls Compl 

Busiest Interval 
(Hour) Calls Comp 

Busiest Interval (Hour) Calls Compl  

Busiest Interval 
(Hour) 

Busiest Interval (Hour) 

Busiest Interval 
(Min) 

Busiest Interval (Min) 

Busiest Interval 
(Sec) 

Busiest Interval (Sec) 

Busiest Interval 
(Int) Compl 

Busiest Interval (Int) Compl 
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Tabs 

• Systems tab 

• Call Rate Types tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: CLAN PPP report 

The CLAN PPP Performance Report shows CLAN PPP crc counts and delta by board. May be 
filtered by system and time. 

Fields 

Column Contains 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

 Board 

CHAP Failures 
Delta 

The difference between the current and the previous sample for the 
number of failed attempts for ppp authentication. 

CHAP Failures Total The total value of the counter on the board 

NOTE: 

The counter value can be up to 11 digits long because of the 32-bit 
counter on the board. After the occurrence of an “N/A,” the delta 
equals the total. Busy-out or release of a board or a port, the reset 
board command, and reseating the board all clear the firmware 
counters. 

CRC Check Delta  The difference between the current and the previous sample for 
Cyclic Redundancy Check errors. 

CRC Check Total The total value of the counter on the board 

NOTE: 

The counter value can be up to 11 digits long because of the 32-bit 
counter on the board. After the occurrence of an “N/A,” the delta 
equals the total. Busy-out or release of a board or a port, the reset 
board command, and reseating the board all clear the firmware 
counters. 

Date The date that the data was collected. 

Invalid Frame Delta The difference between the current and the previous sample for 
invalid frames. Invalid frames are frames that are misaligned. 
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Column Contains 

Invalid Frame Total The total value of the counter on the board 

NOTE: 

The counter value can be up to 11 digits long because of the 32-bit 
counter on the board. After the occurrence of an “N/A,” the delta 
equals the total. Busy-out or release of a board or a port, the reset 
board command, and reseating the board all clear the firmware 
counters. 

Hour The hour that the data was collected. 

Time The current 15-minute interval in which the action was performed. 

Tabs 

• Systems tab 

• Board Type tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: CLAN Sockets report 

The CLAN Sockets Performance Report shows CLAN socket usage, and denial counts and 
percentages by boards and regions. May be filtered by system and time.  

Fields 

Column Contains 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

Board The cabinet, carrier, and slot for the specified board. 

Denial Count Total number of times a C-LAN socket on the board was needed 
for a call or link, but was not available. 

Hour The hour the measurement was taken. Switches in multiple time 
zones are treated as in the current MMI reports. We do not assume 
that the customer has made any correlation between LAN regions 
and time zones. 

Denial % (Denial Count)/(Denial Count + Count) 

Time ASB % The percentage of time during the measured interval that all C-LAN 
sockets on the board were unavailable for use. 

Count Total number of times a C-LAN socket on the board was needed 
for a call or link, and was available. 

Region The network region that the C-LAN for this measurement is in. 

Usage (ERL) The total time, in Erlangs, that is available from sockets on this C-
LAN board. Calculated by: (Total Socket Seconds of usage)/3600 

Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: CLAN Ethernet report 

The CLAN Ethernet Performance Report shows CLAN ethernet crc counts, and delta by board. 
May be filtered by system and time. 

Fields 

Column Contains 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

Board The cabinet, carrier, and slot for the specified board. 

Collision Count 
Delta 

The difference between the current and the previous sample 

Collision Count 
Total 

The error count for collisions on the Ethernet. 

CRC Check Delta The difference between the current and the previous sample 

CRC Check Total The error count for CRC errors. 

Date The date that the data was collected. 

Hour The hour that the data was collected. 

Time The current 15-minute interval in which the action was performed. 

Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Coverage Paths 

The Coverage Paths Performance Report shows configuration, usage, and call counts. Records 
may be filtered by system, coverage path, and time. 

Fields 

Column Contains 

CpId# Coverage Path ID (key) 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

CallsOffrd The total number of calls offered to the path. 

CallsActive The number of calls offered to this path due to the principal being 
active. 

Suggested action: If this number is large compared to the CallsOffrd 
field, you should investigate. A possible reason is the path is 
administered for “active” only. 

CallsBusy The number of calls offered to this path due to the principal being 
busy. 

CallsDA The number of calls offered to this path because the principal did not 
answer the call after the administered number of rings. 

CallsAll The number of calls offered to this path due to the use of Cover All. 

CallsSendAll The number of calls offered to this path due to the principal’s use of 
Send-All-Calls, or the calling party using Go To Coverage. 

Suggested action: If this number, or the CallsAll field, are unusually 
large, you should investigate why calls are still offered to this 
principal. 

CallBack The number of calls offered to this path where the calling party used 
LWC or ACB before a coverage point answered the call. These 
cases are separated out because they are usually considered 
abandons but counting them as such would be misleading. 

Suggested action: If this number appears high, verify why calls are 
not being answered. 

Ans1 The total number of calls answered by the specified point. 
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Column Contains 

Abd1 The total number of calls abandoned by the caller while ringing at the 
specified point. 

Suggested action: If this number is high, you may want to re-
engineer the coverage paths so less traffic is offered to this point. 

Ans2 The total number of calls answered by the specified point. 

Abd2 The total number of calls abandoned by the caller while ringing at the 
specified point. 

Suggested action: If this number is high, you may want to re-
engineer the coverage paths so less traffic is offered to this point. 

Ans3 The total number of calls answered by the specified point. 

Abd3 The total number of calls abandoned by the caller while ringing at the 
specified point. 

Suggested action: If this number is high, you may want to re-
engineer the coverage paths so less traffic is offered to this point. 

Tabs 

• Systems tab 

• Coverage Paths tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Denial Events 

The Denial Events Performance Report shows event type, description, event data, first 
occurrence, last occurrence, and event count. May be filtered by system and time. 

Fields 

• Primary Data 

Column Contains 

Type Type of event (key) 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software 
started (key). 

NMS Time Most recent date and time when the Network Management 
System (NMS) software started. 

• Event Index 

Column Contains 

Type Type of event (key) 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

Event Index A system assigned number that uniquely identifies the event (key). 

Description A brief description of the cause of the event. 

Event Data 1 

Event Data 2 

Hexadecimal data captured by the event handler to help identify the 
exact cause of the event. 

First Month 

First Day 

First Hour 

First Minute 

The date and time of the first occurrence included in this event 
record. 



Avaya Fault & Performance Manager User Guide 

214 

Column Contains 

Last Month 

Last Day 

Last Hour 

Last Minute 

The date and time of the last occurrence included in this event 
record. 

Event Count The number of times this same event occurred over the period 
indicated in the first and last date and time fields. 

Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Expansion Services Module report 

The Expansion Service Module Performance Report shows available ports/usage, total 
usage/allocation, denials, out of service, and blockage. May be filtered by system and time. 

Fields 

Column Contains 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software 
started (key). 

NMS Time Most recent date and time when the Network Management 
System (NMS) software started. 

Available Ports Available Ports. Total network ESM-MMIs in the system. 

Available Usage Available Usage. Total time, in CCS units, that is available in the 
system for ESM-MMI ports. 

Denials Total number of times an MMI port was needed but could not be 
allocated because all ports were busy. Ideally, this number should 
be zero. If you see denials on a regular basis, you should 
consider adding MMIs to your system. 

Hour Measurement Hour. The hour for which these measurements 
apply, on the 24-hour clock. 

Out of Service Out of Service in CCS Units. The total time, in CCS units, that 
any ESM-MMI ports were out of service during any part of the 
measured interval. 

APB % The percentage of time during the measured interval that all 
ESM-MMI ports are unavailable to carry a new call. 

Block % The percentage of attempted allocations of ESM-MMI ports that 
are not successful. This value is calculated as % blockage = 
(Denials / Total Allocation + Denials) * 100 

Total Allocation Total Allocated. The total number of times that an MMI port was 
allocated to a call. Keep in mind that a 2-channel call occupies 2 
ports, so this number does not necessarily reflect the number of 
calls that took place. Also, point-to-point calls do not use MMI 
resources, so these allocations are for conversion calls of 
multimedia conferences. 

Total Usage The total time, in CCS units, that ESM-MMI ports are in use on a 
call. Includes the time that the ports are out of service or 
maintenance busy. Usage is measured from the time the port is 
allocated until it is released. 
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Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Hunt Groups report 

The Hunt Group Performance Report shows configuration, usage, and call counts. May be filtered 
by system, hunt group, and time. 

Fields 

Column Contains 

Grp# Hunt group number 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

Name Shows the name administered for the hunt group. 

Size Shows the actual number of hunt group members. 

Type Group Type. Identifies the type of hunt group, which may be one of 
the following: 

• ddc - direct department calling 

• ucd - uniform call distribution 

• ead - expert agent distribution 

AvgHold Average hold time calculated from TotUsage and CallsAns. 

CallsAban The total number of calls which attempt to reach the hunt group but 
abandon the attempt before being answered. Calls may abandon 
either while in the hunt group queue or while ringing a hunt group 
extension. This total does not include calls answered by Call Pick 
Up, other hunt groups, or calls abandoned while listening to a forced 
first announcement. 

NOTE: 

ACD calls redirected to other splits within the system via the 
intraflow feature are not counted as abandoned calls. ACD calls 
redirected to another switch (interflow feature) are not counted as 
abandoned calls. 

Suggested actions: Observe times during which the Calls 
Abandoned number may be higher than desired. 

Subsequently, consider adding one or more agents to the hunt 
group and staffing these additional positions during the problem 
times. Also, see “Suggested action” in the ‘‘Total usage’’ description. 

CallsAns Calls Answered 
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Column Contains 

CallsQue Total number of calls that arrive to find all members of the hunt 
group busy and are placed in the hunt group queue. Calls Queued 
includes all calls that go to coverage. 

QueOvfl The number of calls that arrive when all slots in the hunt group 
queue are occupied. 

QueSize Shows the maximum number of calls that can be in queue for the 
hunt group. 

SpeedOfAns The average time interval (in seconds) from when the call first 
enters the hunt group or hunt group queue until the call is answered 
by a hunt group member. This does not include the time taken by a 
forced first announcement. 

TimeAvai The total time (in CCS) the hunt group extensions are not in use but 
are available to receive hunt group calls during the measurement 
hour. Time Available is calculated only when an agent (extension) is 
ready to receive calls from the specified hunt group. For example, if 
the hunt group had four extensions and each was available for 15 
minutes during the measurement hour, the total time available 
would be 60 minutes or 36 CCS. 

NOTE: 

ACD hunt groups administered to support Multiple Call Handing 
displays a series of 5 asterisks (*****) in the total usage field. This 
measurement is not collected for ACD hunt groups that support 
Multiple Call Handling. 

TotUsage The sum of all times (in CCS) that the members of a hunt group are 
busy on hunt group calls. Total Usage is the most important 
parameter for this report. The maximum possible usage = 36 CCS × 
Total # of Members 

Suggested action: If the Total Usage number approaches the total 
CCS, you may consider adding another extension to the hunt group 
but only staffing it during the peak hours. If the hunt group has 
several extensions and the Total Usage is low, this may be 
acceptable if the personnel perform other duties. 

NOTE: 

ACD hunt groups administered to support Multiple Call Handing 
displays a series of 5 asterisks (*****) in the Total Usage field. This 
measurement is not collected for ACD hunt groups that support 
Multiple Call Handling. 

Tabs 

• Systems tab 

• Hunt Groups tab 

• Fields tab 
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• Sort tab 

• Format tab 

• Time tab 

• Destination tab 

 



Avaya Fault & Performance Manager User Guide 

220 

Performance: IP Codecs Report 

The IP Codecs Performance Report shows G.711/G.732/G.729 codec usage, in CCS or Erlangs 
for IP codecs. Records may be filtered by system, IP codec type, and time. 

Fields 

Column Contains 

IP Codec Type IP Codec Type (G.711/G.732/G.729) (key) 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

DSP Resources Total number of IP codec resources, or voice channels, in the 
region. 

In Region The total number of times an IP media processor port in the region 
was allocated to a selected codecs call. 

Out of Region The total number of times an IP media processor port was needed 
in the region for a selected codec call, but was successfully 
allocated to a resource in another region. 

If the “Region” fields on the Inter Network Region Connection 
Management screen are blank, then this measurement will always 
be 0. 

Region The network region of the IP media processors being measured. 
The region number is assigned on the Ip-interfaces screen during 
switch administration. 

Usage Amount of time (in erlangs) that the selected codecs were in use 
during the measurement period. The time is measured from the time 
the voice channel is allocated until it is released, including the time 
that the voice channel is on a call.  

This measurement is calculated by adding the total time (in 
seconds) that the selected codecs resources on all IP media 
processors are in use, divided by 3600. 
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Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: IP DSP Resources Report 

The IP DSP Resources Performance Report shows configuration, usage, and peg counts for IP 
DSP resources. Records may be filtered by system and time. 

Fields 

Column Contains 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

DSP Resources Total number of IP codec resources, or voice channels, in the 
region. 

In Region The total number of times an IP media processor port in the region 
was allocated to a call 

Out of Region The total number of times an IP media processor port was needed 
in the region for a call, but was successfully allocated to a resource 
in another region. 

If the “Region” fields on the Inter Network Region Connection 
Management screen are blank, then this measurement will always 
be 0. 

Percent Blocked The percent of attempted use of IP media processor ports in the 
region that were not successful  
(blocked). This percent includes calls that were denied after they 
were successfully allocated out of the region. 

Percent Out of Service The percent of CCS time that any IP media processor ports were 
out of service during the measurement period. This percent 
includes ports that were manually busied out or maintenance busy 
during the measured interval. 

This measurement is calculated by multiplying by 100 the following: 

Total time (in CCS) that any port was out of service divided by the 
number of available resources times 36 

Region The network region of the IP media processors being measured. 
The region number is assigned on the Ip-interfaces screen during 
switch administration. 

Resources Denied The total number of times an IP media processor port was needed 
in the region for a call, but all media ports in all regions were busy 
and the call did not go through. 
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Column Contains 

Usage Digital Signaling Processor Usage in Erlangs. Amount of time (in 
erlangs) that all codecs were in use during the measurement 
period. The time is measured from the time the voice channel is 
allocated until it is released, including the time that the voice 
channel is on a call.  

This measurement is calculated by adding the total time (in 
seconds) that G.711 resources on all IP media processors are in 
use plus twice the total time (in seconds) that G.723 and G.729 
resources are in use plus twice the time (in seconds) that fax relay 
resources are in use, divided by 3600. 

Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: IP Signalling Report 

The IP Signaling Groups Performance Report shows packet latencies, and packets sent and lost 
for IP Signaling Groups. Records may be filtered by system and time. 

Fields 

Column Contains 

Voice System A 20-character string administered by the customer that 
uniquely identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software 
started (key). 

NMS Time Most recent date and time when the Network Management 
System (NMS) software started. 

Region The network region of the group. 

Average Latency / Hour The average latency (ms) for the whole hour. 

Packets Sent / Hour The number of packets sent during the whole hour. 

Percent Packets Lost / Hour The percent of lost packets for the whole hour (if100% the 
corresponding latency is shown as ****) 

Average Latency / Interval The average latency (ms) for the interval 

Packets Sent / Interval The number of packets sent during the interval. 

Percent Packets Lost / 
Interval 

The percent of lost packets for the interval 

Signalling Group Number The group number in rank order. 

Worst Interval / Hour The hour with the worst 3 minute interval within the hour. 

Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Inter-Port Network Latency report 

The Inter-Port Network Latency Performance Report shows PN connection requests and ATM 
setup requests with average delay in milliseconds. Records may be filtered by system, PN pairs, 
and time. 

Fields 

Column Contains 

Dest PN Destination Port Network (key) 

Orig PN Originating PN (key) 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

PNC PN Connectivity (A or B) 

ATMReq ATM Network Setup Requests 

ATMSetup Average ATM Setup Time 

PNSetup Average PN Setup Time 

PNReq PN Connection Requests 

Tabs 

• Systems tab 

• PN Connections tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Multimedia Interface report 

The Multimedia Interface Performance Report shows available ports/usage, total 
usage/allocation, denials, out of service, and blockage. May be filtered by system and time. 

Fields 

Column Contains 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software 
started (key). 

NMS Time Most recent date and time when the Network Management 
System (NMS) software started. 

Available Ports Available Ports 

Available Usage Available Usage 

Denials Denials 

Hour Hour 

Out of Service Out of Service 

APB % APB % 

Block % Block % 

Total Allocation Total Allocation 

Total Usage Total Usage 

Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Port Networks Report 

The Port Networks Performance Report shows usage and peg counts. Records may be filtered 
by system, PN pair, and time. 

Fields 

Column Contains 

PN# Identifies the port network being measured (key). 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

IncTrkIncPeg The count of TDM time-slot seizures caused by calls to a station on 
the port network from an incoming trunk on another port network. 

IncTrkIncUsage The TDM time-slot usage caused by calls to a station on the port 
network from an incoming trunk on another port network. Usage is 
displayed in CCS. 

IncTrkIntraPeg The count of TDM time-slot seizures caused by incoming trunk calls 
to a station on the same port network. 

IncTrkIntraUsage The TDM time-slot usage caused by incoming trunk calls to a station 
on the same port network. Usage is displayed in CCS. 

IncTrkOutPeg The count of TDM time-slot seizures caused by calls to a station on 
another port network from an incoming trunk on the measured port 
network. 

IncTrkOutUsage The TDM time-slot usage caused by calls to a station on another 
port network from an incoming trunk on the measured port network. 
Usage is displayed in CCS. 

IntInterPeg Intercom Inter-PN Peg 

IntInterUsage Intercom Inter-PN Usage 

IntIntraPeg Intercom Intra-PN Peg 

IntIntraUsage Intercom Intra-PN Usage 

OutTrkIncPeg The count of TDM time-slot seizures resulting from outgoing calls 
originated at stations on another port network but serviced by trunks 
on the port network measured. 
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Column Contains 

OutTrkIncUsage The TDM time-slot usage resulting from outgoing calls originated at 
stations on another port network but serviced by trunks on the port 
network measured. Usage is displayed in CCS. 

OutTrkIntraPeg The count of TDM time-slot seizures caused by outgoing calls made 
by stations on the measured port network and serviced by outgoing 
trunks on the same port network. 

OutTrkIntraUsage The TDM time-slot usage caused by outgoing calls made by stations 
on the measured port network and serviced by outgoing trunks on 
the same port network. Usage is displayed in CCS. 

OutTrkOutPeg The count of TDM time-slot seizures resulting from outgoing calls 
originated at stations on the port network measured but serviced by 
trunks on another port network. 

OutTrkOutUsage The TDM time-slot usage resulting from outgoing calls originated at 
stations on the port network measured but serviced by trunks on 
another port network. Usage is displayed in CCS. 

PNLBlock The total count of circuit switched PN link blockages, that is, the total 
number of times a PN link time-slot is denied, during the 
measurement hour. This count includes calls originating or 
terminating on this PN. This field should be zero for all 
configurations that do not use T1 remoting and are smaller than 16 
PNs since the center stage is non-blocking in these configurations. 

Suggested action: If blockages occur in the switching fabric, 
consider shifting resources. Use the Intercom, Outgoing, Incoming 
and Tandem reports to determine which resources to switch. 

PNLOcc The percent Port Network Link Occupancy is computed as follows: 

(PNL Usage/PNL Total Potential Usage) x 100 

PNLPeak The maximum number of PNL time slots allocated at any one time 
during the measurement. 

PNLPeg The total number of circuit switched time slot seizure attempts for 
the PN during the measurement hour. 

PNLUsage The total circuit switch usage (Measured in CCS) of the PN Link(s). 

PN Link Usage = Sum of the allocated PN link time-slots at the end 
of each 100 second interval in a measurement hour. 

PNL Total Potential Usage = 766 x 36 CCS = 27,576 CCS 

PNOcc Port Network Occupancy 
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Column Contains 

CtlUtil The fraction of the total capacity of the processor on the measured 
EI board. This value is expressed in percent, where 0% is the 
processor occupancy corresponding to no control measure traffic, 
and 100% is the processor occupancy corresponding to the 
maximum message traffic that can be handled and meet delay 
criteria. The data used to calculate this field is obtained as a traffic 
counter from the EI board. When the processor is idle, it usually 
reads about 14%. 

TanTrkIncPeg The count of TDM time-slot seizures resulting from tandem trunk 
calls originating on another port network but terminating on the port 
network measured. 

TanTrkIncUsage The TDM usage resulting from tandem trunk calls originating on 
another port network but terminating on the port network measured. 
The usage is represented in CCS. 

TanTrkIntraPeg The count of TDM time-slot seizures caused by tandem trunk calls 
originating and terminating on the port network being measured. 

TanTrkIntraUsage The TDM usage caused by tandem trunk calls originating and 
terminating on the port network being measured. The usage is 
represented in CCS. 

TanTrkOutPeg The count of TDM time-slot seizures resulting from tandem trunk 
calls originating on the port network measured but terminating on 
another port network. 

TanTrkOutUsage The TDM usage resulting from tandem trunk calls originating on the 
port network measured but terminating on another port network. The 
usage is represented in CCS. 

TDMBlock The total count of TDM blockages, that is, the total number of times 
a TDM time-slot request is denied for the PN being measured, 
during the measurement hour. 

TDMOcc The percent TDM Occupancy is computed as follows: 

(TDM Usage/TDM Total Potential Usage) x 100 

Suggested action: Generally, the load should be distributed evenly 
across port networks. If the percent occupancy is out of line with the 
occupancy on other port networks, consideration should be given to 
shifting resources. Use the Intercom, Outgoing, Incoming, and 
Tandem reports to help determine which resources to shift. 

TDMPeak The maximum number of TDM time-slots allocated at any one time 
during the measurement hour. 
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Column Contains 

TDMPeg The total count of circuit switch TDM time-slot seizure attempts for 
the PN during the measurement hour (requests for maintenance 
processes are not included). 

TDMUsage The total TDM time-slot usage, in CCS, for the PN being measured: 

TDM Usage = Sum of the allocated TDM Time Slots at the end of 
each 100 second interval in a measurement hour. TDM Total 
Potential Usage = 483 x 36 CCS = 17,388 CSS 

Tabs 

• Systems tab 

• Port Networks tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Principal Data 

The Principal Data Performance Report shows configuration, usage, and call counts. Records 
may be filtered by system, principal data, and time. 

Fields 

Column Contains 

PdId# Principal Data ID (key). The principal extension or PCOL 
group/TAC being reported. 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

CallsOffrd Calls Offered. The total number of calls offered to the principal. 

CallsActive The number of calls sent to coverage by this principal due to the 
principal being active. 

CallsBusy The number of calls sent to coverage by this principal due to the 
principal being busy. 

CallsDA The number of calls sent to coverage by this principal because the 
principal didn’t answer the call after the administered number of 
rings. 

CallsAll The number of calls sent to coverage by this principal due to the 
principal’s use of Cover All. 

CallsSendAll The number of calls sent to coverage by this principal due to the 
principal’s use of Send All Calls, or because the calling party used 
the Go To Cover feature. 

CallBack The number of calls offered to this principal where the calling party 
used LWC or ACB before the principal answered the call and 
before it went to coverage. These cases are separated out because 
they look like abandons and counting them as such would be 
misleading. 
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Column Contains 

Aband The total number of abandoned calls, where the calling party hung 
up before the call was answered or sent to 

coverage. 

Suggested Action: If this number is high at the principal, you may 
need to redirect traffic. 

The number of calls answered by principal = Calls Offered − Calls 
Abandoned − Calls Redirected 

Redir The total number of calls not answered by the principal and 
subsequently sent to coverage. 

Suggested action: If this number is large compared to CallsOffrd, 
investigate the reasons. 

CoveragePath The coverage paths used by this principal. 

Tabs 

• Systems tab 

• Principal Data tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Processor Occupancy Report 

The Processor Occupancy Performance Report shows occupancy and call counts. May be 
filtered by system and time. 

Fields 

Column Contains 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

%CP_Occ Call Processing Occupancy. The percentage of occupancy used by 
call processing-level processes. The processing of CDR, DCS, 
ISDN, and other adjunct interfaces is also included in this level. 
Note that some occupancy due to BX.25 and ISDN-PRI call traffic is 
counted as static occupancy instead of CP Occ. 

Note: It is not desirable for any system to function at 100 percent 
processor occupancy. Rather, the CP Occ and Stat Occ fields 
should total no more than a maximum of 75 percent. By maintaining 
this 75 percent maximum limit, other system functions can be 
performed and bursts of caller activity can also be accommodated. 

Suggested actions: If the 75 percent maximum limit is exceeded, 
take one or more of the following steps to lower call processing 
occupancy: 

• If the users do not get a dial tone immediately, they should 
be encouraged to wait 10 to 15 seconds before going on-
hook and off-hook again. 

• If the system is part of a private network and is receiving a 
large amount of traffic from another system in the private 
network, investigate the possibility of reconfiguring the 
network. 

• Check the administration translation and verify all digital 
sets, administered with display modules, actually have 
display modules. For those sets without display modules, 
change the administration translations to indicate the digital 
sets do not have a display module. 

• Check the hardware error log for high levels of maintenance 
activity. 
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Column Contains 

%IdleOcc Idle Occupancy. The amount of time the processor is unused. There 
are several factors that drive down this number, including the 
following: 

• A large offered load increases CP occupancy 

• A switch with many stations and trunks requires a high level 
of background maintenance, increases SM occupancy 

• Frequent demand testing or administration increases SM 
occupancy 

These factors may reduce the idle occupancy to almost 0 percent 
during several 3-minute intervals. On a heavily-loaded configuration 
with frequent demand testing, the idle occupancy may drop to low 
levels for longer periods (perhaps 1–2 hours). These situations are 
normal and do not indicate a problem with the configuration.  

However, a lightly-loaded configuration with few stations translated 
and little demand maintenance or administration should not 
experience long periods of low idle occupancy (less than 15 
percent). If this is the case, a problem is likely. 

IncAtts Incoming Attempts. The number of incoming trunk seizures from 
public network facilities. 

IntAtts Intercom Attempts. This field includes the sum of two types of calls. 
The first type is extension-to-extension calls on the same 
configuration. The second type is partially completed calls where a 
local extension goes off-hook and then hangs up before the call is 
answered. This includes both busy and no-answer calls. 

OutAtts Outgoing Attempts. The number of outgoing trunk seizures made 
over public network facilities. 

%Aban Percent Abandoned (percent) 

PNetAtts Private Network Attempts. The number of incoming and outgoing 
seizures made over private network facilities. Note that a tandem 
call is counted as two private network attempts, since it includes 
both incoming and outgoing trunk seizures. 

NOTE: 

The determination of whether a call is over public network or over 
private network facilities depends on the trunk type (for ISDN-PRI 
facilities it is also dependent on 

the service type). 
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Column Contains 

%StaticOcc Static Occupancy. The percentage of occupancy used by high 
priority background processes in support of call processing, 
maintenance, and administration functions. Examples of this activity 
are high level sanity checks, system timing, polling of adjuncts, and 
operating system support. This also includes some call processing 
occupancy for BX.25 and ISDN-PRI traffic. 

Note: Static occupancy remains fairly consistent in an idle 
configuration. However, it increases as traffic is introduced into the 
system. 

%SM_Occ System Management Occupancy. The percentage of processor 
occupancy due to system management processes. This 
measurement is time coincident with the peak value of the 
combined call processing and static processor occupancy. 

TanCalls Tandem Calls. The number of trunk-to-trunk calls connected during 
the last hour. 

TotAtts Total Attempts. The number of call attempts made during the 
measurement interval. The following occurrences count as an 
attempt: 

• A user lifts the station handset and hangs up before dialing 
any digits (off-hooks) 

• A user lifts the station handset, dials the destination 
number, the far end rings but does not answer, and the user 
hangs up (no answer) 

• A user lifts the station handset, dials the destination 
number, the far end is busy 

• A user places a call answered by the dialed number 

• A user conferences a second party onto the call 

• An incoming trunk seizure 

• Maintenance requests an outgoing trunk be seized 

• Tandem calls (either pnet or public network) result in 2 
attempts, but only one total call 

• AUDIX audits of message waiting lamps 

• AUDIX Leave Word Calling activations 

NOTE: 

Mathematically, the Total Atmpts field is the total of the Intcom, Inc, 
Out, and Pnet Atmpts fields. 

TotCalls Total Calls. The total number of calls connected during the listed 
hour. Calls are counted in the time interval they are answered and 
not in the time interval they are dropped. Therefore, a call that starts 
in one time interval and ends in another is counted only in the time 
interval where it originates. 
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Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Routing Patterns Report 

The Routing Patterns Performance Report shows call counts for routing patterns and trunk 
groups within routing patterns. Records may be filtered by system, routing pattern, and time. 

Fields 

• Primary level data: 

Column Contains 

Pat# The identification (number) of the route pattern measured. 

Voice System A 20-character string administered by the customer that 
uniquely identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software 
started (key). 

NMS Time Most recent date and time when the Network Management 
System (NMS) software started. 

CallsCarried The total number of seizures (for all trunk groups) in the routing 
pattern. 

CallsQue The number of offered calls that found all trunk groups in the 
pattern busy and were placed in queue for the first trunk group 
(first-choice trunk group) in the pattern. These calls also 
increment the blocked calls counter. 

QueOvfl The number of calls that find the queue on the first trunk group 
full. Calls attempted while the queue is in overflow receive a 
reorder signal. These calls also increment the blocked calls 
counter. 

QueSize The size (length) of the queue for the first trunk group in the 
route pattern. This is commonly referred to as the route pattern 
queue size. A queue is an ordered sequence of calls waiting to 
be processed. 

CallsBlock The number of offered outgoing calls that found all trunk groups 
in the pattern busy. If the queue overflows, then the call is still 
blocked. Specifically, a blocked call is a call that: 

• Arrives when there are no available resources 

• Arrives and gets queued 

• Arrives when the queue is full 

• Arrives and cannot queue because the queue length is 
set to zero 

• Cannot queue because the Automatic Callback (ACB) 
button is busy 

• Cannot queue because there is no ACB button 
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Column Contains 

CallsOffer The total number of calls offered to the route pattern. 

• Calls Offered (With Queue) = # of Calls Carried + # of 
QueueOverflowCalls + # of QueueAbandonCalls 

• Calls Offered (Without Queue) = # of Calls Carried + # 
of CallsBlocked 

%Block The percentage of offered calls not carried on the route pattern. 
It does not include unauthorized calls denied service on the 
route pattern (due to restrictions) or calls carried on the route 
pattern but do not successfully complete at the far end (that is, 
where there is no answer).  

• Trunk Group Measurements: 

Column Contains 

Pat# The identification (number) of the route pattern measured. 

Voice System A 20-character string administered by the customer that 
uniquely identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software 
started (key). 

NMS Time Most recent date and time when the Network Management 
System (NMS) software started. 

TG# Trunk Group Number. The number, assigned via the Trunk 
Group screen, that identifies each trunk group associated 
with the displayed data (key).  

Trunk groups are listed in the same order as they are 
assigned on the Route Pattern screen. The first trunk group 
listed is the first selected (preference 1); the second listed is 
the second selected (preference 2), and so on. (key) 

Dir Identifies whether the assigned trunk groups are outgoing 
(out) or 2-way (two). Incoming trunks are not included in route 
patterns. 

Name The trunk group identification administered on the Trunk 
Group screen. 

Size The number of trunks in the group. 
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Column Contains 

Type The type of trunk in the group. The following types of trunk 
groups can be accessed through the route pattern: 

• Access (access) 

• Advanced Private Line Termination (aplt) 

• Local Central Office (co) 

• Direct Inward/Outward Dialing (diod) 

• Foreign Exchange (fx) 

• Integrated Services Digital Network-Primary Rate 
Interface (isdn-pri) 

• Tandem (tandem) 

• Tie Trunk (tie) 

• Wide Area Telecommunications Service (wats) 

Service ISDN PRI service 

TAC Trunk Access Code administered for the trunk group. 

WB If a trunk group is administered to support wideband 
switching, a “W” appears. 

TotCalls The total number of calls carried by the route pattern by the 
trunk group.  

%Carried The percentage of the total calls carried over the route 
pattern by the trunk group. 

Suggested action: The first trunk group listed in the report is 
the first choice trunk group. This trunk group should always 
carry a significantly larger percentage of the calls than any of 
the other trunk groups. If not, you should add more members 
so the first choice trunk group has significantly more 
members than any other group in the pattern. 

Tabs 

• Systems tab 

• Routing Patterns tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Security Violations Report 

The Security Violations Performance Report includes valid and invalid attempts by port type and 
by system. Records may be filtered by system and time. 

Fields 

• Primary Data 

Column Contains 

Voice System A 20-character string administered by the customer that 
uniquely identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software 
started (key). 

NMS Time Most recent date and time when the Network Management 
System (NMS) software started. 

BCViol The total number of times a user entered a valid or invalid 
remote access barrier code, and the number of resulting 
security violations. Barrier codes are used with remote 
access trunks. 

An inexplicable, significant increase in valid barrier code use 
could indicate the barrier code has been compromised. 

A marked increase in this number of invalid codes may 
indicate someone is attempting to break into your system. If 
you have just administered a new barrier code, or a barrier 
code expired recently, it may indicate people are making 
honest mistakes.  

Suggested action: Delete or change the barrier code if you 
suspect it has been compromised. 

InvAttAC Invalid Attendant AC 

InvRemAC Invalid Remote AC 

InvStnAC Invalid Station AC 

TotInvAC Total Invalid AC 

InvTrkAC Invalid Trunk AC 

InvBC Invalid Barrier Codes 

InvStnSSC Invalid Station SSC 

TotInvSSC Total Invalid SSC 

InvTrkSSC Iinvalid Trunk SSC 
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Column Contains 

Since The time at which the counts were last cleared and started 
accumulating again, or when the system is initialized. 

AttACViol Attendant AC Security Violations 

RemACViol Remote AC Security Violations 

StnACViol Station AC Security Violations 

TotACViol Total AC Security Violations 

TrkACViol Trunk AC Security Violations 

TotSSCViol Total SSC Security Violations 

ValAttAC Valid Attendant AC 

ValRemAC Valid Remote AC 

ValStnAC Valid Station AC 

TotValAC Total Valid AC 

ValTrkAC Valid Trunk AC 

ValBC Valid Barrier Codes 

ValStnSSC Valid Station SSC 

TotValSSC Total Valid SSC 

ValTrkSSC Valid Trunk SSC 

Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Switch Node Links Report 

Switch Node Link performance shows usage and peg counts. Records may be filtered by system, 
SN link, and time. 

Fields 

Column Contains 

Link Switch Node Pair. Identifiers for the two SNs connected by the 
SNL being measured (key). 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

SNL Block The total count of circuit switched SNL blockages, that is, the total 
number of times a call is blocked because no time-slots are 
available either in the most direct route or through any alternate 
route, during the measurement hour. 

SNL Ovfl The total number of times a call is routed over an alternate route. 
This counter is incremented when a call was not successfully 
routed over the most direct route and is routed over an alternate 
route. This allows you to distinguish true blockage of a call from 
the direct route blockage. 

Suggested action: Generally, the usage between switch nodes 
should be equally distributed. If the usage between switch nodes is 
high, you may want to move resources to another switch node or 
add a new switch node. 

SNL Peg The total count of circuit switched SNL time-slot seizure attempts 
during the measurement hour between the two measured SNs. 
This is the total peg count on all interconnecting fibers. 

SNL Usage The total circuit switch usage of the SNL connecting the two SNs. 
This is the total usage on interconnecting fibers. At the end of each 
100-second interval, a snapshot is taken of the number of SNL 
time-slots used on each port network. 

Max SNL usage = 766 x 36 CCS = 27,576. 

Slots The number of switch node link time-slots available between 
switch nodes. At any given time interval, this translation value is 
fixed. The SNL time slot maximum is 766; for T1 remoting it is 94. 
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Tabs 

• Systems tab 

• Switch Node Links tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Tone Receivers Report 

The Tone receiver Performance Report shows peg counts for each tone receiver type and port 
network. Records may be filtered by system, tone receiver type, and time. 

Fields 

• Measurements by Port Network 

Column Header Contains 

Type The type of tone receiver measured. 

NOTE: 

Each TN748 and TN420 circuit pack provides four DTMF ports 
(for touch-tone reception) and two GPTD ports (for call progress 
tone reception). The TN744 Call Classifier Circuit Pack provides 
eight ports for call progress tone reception (CC-CPTR), touch-
tone reception (CC-TTR), or MFC (CC-MFCR) reception. 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software 
started (key). 

NMS Time Most recent date and time when the Network Management 
System (NMS) software started. 

PN# The port network in which the circuit pack containing the type of 
tone receiver listed is physically located. 

PeakAlloc The peak number of DTMF, GPTD, CC-TTR, CC-CPTR, or 
MFCR receivers located in the listed port network in use 
simultaneously during the listed hour. 

PeakOffPN Peak Off-Port Network. For the identified hour and port network, 
this is the peak number of DTMF, GPTD, CC-TTR, CC-CPTR, or 
MFCR receivers simultaneously allocated on a different port 
network for requests originated on this port network. 

NOTE: 

A desirable goal is to minimize (within reason) the number 
displayed with this field. 

Suggested actions: Locate communities of interest within the 
same port network. Provide sufficient tone receivers for each port 
network. Perhaps you should move one TN748 and TN420 circuit 
pack (or, if you are working with a CC-TTR, CC-CPTR, and 
MFCR, move a TN744 circuit pack) to the PN with the Off-PN 
counts to minimize Off-PN allocations. 

Requests The number of requests for DTMF, GPTD, CC-TTR, CC-CPTR, 
or MFCR receivers within the port network during the listed hour. 
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Column Header Contains 

TotAlloc The total number of DTMF, GPTD, CC-TTR, CC-CPTR, or MFCR 
receivers located in the listed port network allocated for use 
during the listed hour. 

TotOffPN For the identified hour and port network, this is the total number of 
DTMF, GPTD, CC-TTR, CC-CPTR, or MFCR receivers allocated 
on a different port network for requests originated on this port 
network. 

NOTE: 

With ideal conditions, this field displays the number 0. However, 
with more practical conditions, the field displays a larger number. 

Suggested actions: Locate communities of interest within the 
same port network. Provide sufficient tone receivers for each port 
network. 

• Primary Data 

Column Contains 

Type The tone receiver circuit packs physically connected at the time 
of the hour measurement. 

Voice System A 20-character string administered by the customer that 
uniquely identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software 
started (key). 

NMS Time Most recent date and time when the Network Management 
System (NMS) software started. 

PeakDenied The system-wide peak number of requests denied because no 
receivers were available during the listed hour.  

Suggested action: At a minimum you should increase the 
number of tone receivers by the number displayed in the Peak 
Denied field. Furthermore, you may want to consider 
engineering the switch as “non-blocking” for tone receivers. 
This involves increasing the number of tone receivers (the Avail 
field) so all requests receive service immediately and no 
requests are queued. For example, keep the value displayed in 
the Avail field greater than that displayed in the PeakReq field. 

PeakQue The system-wide maximum number of call requests queued at 
any one time during the listed hour. 

NOTE: 

The system has a maximum queue size of 4 for DTMF requests 
and 80 for CC-TTR call vectoring requests. 
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Column Contains 

PeakReq The system-wide peak number of simultaneous requests for 
DTMF, GPTD, CC-TTR, CC-CPTR, or MFCR receivers that 
occurred at any one time for the listed hour. The peak (or 
maximum) number is calculated by incrementing a counter for 
each request and decreasing the counter when the request fails 
or a tone receiver is released. 

NOTE: 

If the Peak Req field indicates a number higher than listed in 
the Avail field, then certain requests were either queued or 
denied during the peak time interval. Denied requests fail and 
are given the reorder tone. 

Ports The number of the ports available for the type of tone receiver 
listed. 

TotDenied The system-wide total number of requests denied because no 
receivers were available during the listed hour. For DTMF-
receiver or CCTR requests, this happens only after the queue is 
full. Those requests denied are given reorder tone. 

TotQue The system-wide total number of requests queued during the 
listed hour. A request is queued when there are no receivers 
immediately available. Only DTMF and CC-TTR requests are 
queued. 

NOTE: 

If a request for a receiver is made in one port network, and no 
receivers are available, then the request is offered to the next 
port network. If no receivers are available on any port network, 
then the request is queued. Queued call requests do not 
receive dial tone until a tone receiver becomes available. 

TotReq The system-wide total number of requests, by call processing, 
for DTMF, GPTD, CC-TTR, CC-CPTR, or MFCR receivers 
during the listed hour. The total number of requests is 
calculated by incrementing a counter for each request. 

Tabs 

• Systems tab 

• Tone Receivers tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 

 



Using Avaya FPM 

247 

Performance: Trunk Groups Report 

The Trunk Group Performance Report shows usage, peg count, and grade-of-service.  

Fields 

• Average Data  

Column Contains 

TG# A number that identifies each trunk group associated with the 
displayed data. Group numbers are displayed in numerical 
order, beginning with the lowest administered number and 
continuing to the highest administered number (key). 

Voice System A 20-character string administered by the customer that 
uniquely identifies the voice system (key). 

Size The number of administered trunks in the trunk group. 

Type Group Type. The type of trunk in the trunk group. The system 
monitors/measures the following trunk types: 

• Access Tie Trunk (Access) 

• Advanced Private Line Termination (aplt) 

• Central Office (co) 

• Public Network Service Customer Provided Equipment 
(cpe) 

• Direct Inward Dialing (did) 

• Direct Inward/Outward Dialing (diod) 

• Digital Multiplexed Interface Bit Oriented Signaling 
(dmi-bos) 

• Foreign Exchange (fx) 

• Integrated Services Digital Network (isdn-pri) 

• Release Link Trunk (rlt) 

• Tandem (tan) 

• Tie Trunk (tie) 

• Wide Area Telecommunications Service (wats) 

Days Count of days 

Model Model 

GOS Grade of Service 

Needed Size Average of recommended trunks needed 

Recommended Size Average of recommended size 

Av. Pk. Usage Average peak usage 
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• Primary level data: 

Column  Contains 

TG# A number that identifies each trunk group associated with the 
displayed data. Group numbers are displayed in numerical order, 
beginning with the lowest administered number and continuing to 
the highest administered number (key). 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software 
started (key). 

NMS Time Most recent date and time when the Network Management 
System (NMS) software started. 

Size The number of administered trunks in the trunk group. 

Needed Size Needed Size 

Model Traffic Model 

AvgHold  Average Hold Time 

QueOvfl The total number of calls not queued because the queue is full. 
These calls receive a reorder signal.  

Suggested actions: Generally, this field indicates the number 0. 
If this field indicates a high number, then either the queue size 
may be too small, or add more trunks to reduce the number of 
calls queuing. 

QueSize A number (0 to 100) that identifies the number of slots assigned 
to the trunk group queue. This number represents how many 
calls may be held in queue by the trunk group. If 0 is displayed, 
then no queue is administered. Hence, the other queue 
measurements are also 0. Generally, the queue size should be 
larger than the trunk group size; however, not more than three 
times as large as the trunk group size. 

TotUsage Total usage (in CCS) for all trunks in the trunk group. Represents 
the total time the trunks are busy (with calls) during the one-hour 
measurement period. Total usage measures each time a trunk is 
seized for use by an incoming call (whether it is picked up or not) 
or an out going call (only after digits have been dialed). 

AvgUsage Average Trunk Usage 
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Column  Contains 

CallsQue The total number of calls that entered the trunk group queue 
after finding all trunks busy. 

OOS The number of trunks in the trunk group out of service (listed as 
maintenance busy) at the time data is collected. An individual 
trunk may be taken out of service by the switch whenever an 
excessive number of errors occur, or by maintenance personnel 
to run diagnostic tests. 

Suggested action: If the trunks are removed from service by the 
switch, then the appropriate maintenance personnel should be 
notified. The objective is to keep all members of a trunk group “in 
service.” Generally, you should not make adjustments to the 
trunk group because of “Out of Service” trunks, but should get 
those trunks returned to service. 

QueAban The number of calls removed from the queue in one of the 
following manners: 

• By the system because they have been in the queue for 
more than 30 minutes 

• By the user (for example, dialing the cancel code). 

Suggested action: Typically, this field indicates a small number. 
However, a large number generally indicates the queue size is 
too large and people are abandoning because they remained in 
queue for a long holding time and gave up. 

GroupOvfl The number of calls offered to a trunk group not carried or 
queued (if a queue is present). Calls rejected for authorization 
reasons are not included. 

IncSeize The number of incoming seizures carried on the trunk group. 
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Column  Contains 

%ATB The percentage of time all trunks in the trunk group were 
simultaneously in use during the measurement interval. 

NOTE: 

In use means the trunks are busy — either serving calls or 
because they are busied-out by maintenance. 

Suggested actions: 

1. If the group direction is outgoing or two-way, then a high 
number in the %ATB field and nothing in the GroupOvfl 
or QueOvfl indicates everything is functioning normally. 
However, a more typical scenario is a high number in 
this field and a high number in the GroupOvfl field. This 
indicates a possible problem that necessitates further 
analysis. Unless it is the last trunk group in the pattern, 
overflow is to the next choice trunk group, and the 
number in the GroupOvfl field is of no great significance. 
Otherwise, the obvious choice is to add more trunks to 
the trunk group. 

2. If the group direction is incoming, then a high number in 
this field is bad. It indicates some incoming calls are 
probably blocked. Generally, you want to add more 
trunks, thus lowering the %ATB and decreasing the 
number of calls blocked. 
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Column  Contains 

%Block The percentage of offered calls not carried on the trunk group. It 
does not include unauthorized calls denied service on the trunk 
group (due to restrictions) or calls carried on the trunk group but 
do not successfully complete at the far end (that is, where there 
is no answer). For trunk groups without a queue, the calls not 
carried are those calls that arrive when all trunks are busy. The 
number of Outgoing Seizures is calculated as follows: 

Outgoing Seizures = Total Seizures − Incoming Seizures 

Similarly, the equation for calculating Outgoing Calls Offered is 
as follows: 

Outgoing Calls Offered = Group Over flow + Outgoing 
Seizures 

%Block = GroupOvfl / Outgoing Calls Offered 

For trunk groups with a queue, the calls not carried are those 
calls that arrive when all trunks are busy and the queue is full 
(Queue Overflow) and calls removed from queue before being 
carried (Queue Abandoned). For this scenario, the Percentage 
Outgoing Blocking is calculated as follows: 

Outgoing Calls Offered = QueOvf + QueAbd + Outgoing 
Seizures 

% OutBlk = ((QueOvfl + QueAbd)/Outgoing Calls 
Offered) * 100 

Suggested actions: 

1. You can increase the length of the queue rather than 
adding more trunks. Subsequently, you should monitor 
the Que Abd field to insure it stays within reasonable 
limits. 

2. If conditions are such that Step 1 is not appropriate, then 
you may find it necessary to add more trunks. 

NOTE: 

If you are using ARS you may see a high number in this field. 
This only indicates calls are overflowing to the next choice. 

TotSeize The number of incoming and outgoing seizures carried on the 
trunk group. This includes the number of times a trunk in the 
group is seized, including false starts, don’t answer, and busy. 

AvgUsage Average Usage 

GOS Grade of Service 

Recommended Size Recommended Size 

Dir Identifies whether the trunk group is incoming (inc), outgoing 
(out), or two-way (two). 
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Column  Contains 

Name Administered trunk group name. 

Type Group Type. The type of trunk in the trunk group. The system 
monitors/measures the following trunk types: 

• Access Tie Trunk (Access) 

• Advanced Private Line Termination (aplt) 

• Central Office (co) 

• Public Network Service Customer Provided Equipment 
(cpe) 

• Direct Inward Dialing (did) 

• Direct Inward/Outward Dialing (diod) 

• Digital Multiplexed Interface Bit Oriented Signaling (dmi-
bos) 

• Foreign Exchange (fx) 

• Integrated Services Digital Network (isdn-pri) 

• Release Link Trunk (rlt) 

• Tandem (tan) 

• Tie Trunk (tie) 

• Wide Area Telecommunications Service (wats) 

Service  ISDN PRI Service 

TAC Trunk Access Code administered for the trunk group. 

WB WideBand flag. If any trunks in the trunk group are used in a 
wideband (n X DS0) connection, a “W” appears in this column. 

Tabs 

• Systems tab 

• Trunk Groups tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Trunk Groups- ISDN-PRI CBC Report 

The Trunk Groups ISDN-PRI Call-by-Call (CBC) Performance Report shows configuration, 
usage, and counts for ISDN Trunk Groups  

Fields 

• Service/Feature Measurements: 

Column Contains Field 

TG# A number that identifies each trunk group associated with the 
displayed data. Group numbers are displayed in numerical 
order, beginning with the lowest administered number and 
continuing to the highest administered number (key). 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software 
started (key). 

NMS Time Most recent date and time when the Network Management 
System (NMS) software started. 

Service Feature. The names of up to 10 services/features and the 
special identifier “other” for which the associated measurements 
are reported. 

TotUsage The sum of time, in hundred-call-seconds (CCS), for all 
channels used by the specified service/feature during the 
measurement interval. 

GroupOvfl Overflow Trunk Group. The number of outgoing calls that 
requested the specified service/feature, on the ISDN-PRI CBC 
trunk group, but are not carried because the calls arrived to find 
no idle trunk members available.  

NOTE: 

There are three overflow fields, each with a different priority. 
They are: overflow trunk group (GroupOvfl) (priority 1), overflow 
maximum (MaxChanOvfl) (priority 2), and overflow 
services/features (SvcOvf) (priority 3). If more than one of the 
overflow conditions is met, only the field that represents the 
condition with the highest priority is incremented. 

IncSieze The total number of incoming calls that requested the specified 
service/feature through the ISDN-PRI CBC trunk group. For two-
way and outgoing trunks, the number of Outgoing Seizures can 
be calculated as follows: 

Out Seize = Total Seize − In Seize 
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Column Contains Field 

MaxChanOvfl Overflow maximum. The number of calls not carried because the 
calls originated at a time when the service/feature already used-
up its allotted maximum number of channels. In this case, the 
trunk group may still have trunk members available for the other 
services/features. 

Suggested actions: 

1. Investigate the possibility of raising the number administered 
in the MaxChannels field. This is only possible provided the free 
pool is not exceeded. To determine whether or not you have 
more trunks available for a S/F calculate the following: 

Max − Min (for the identified S/F) ≤ Free Pool 

For example, use the above equations with the data in the 
formula as follows: 

• Free Pool = Total # of in−service trunks − Σ Min for each 
S/F 

• Free Pool = 18 − ( 5 + 4 ) 

• Free Pool = 9 

• 8 − 4 ( f or SDN) ≤ 9 

• 4 ≤ 9 Therefore, you can increase the Max 

2. Consider adding more trunks to the trunk group and increase 
the maximum for the identified service/feature. 

MaxChannels The maximum number of channels in the ISDN-PRI CBC trunk 
group allocated to the specified service or feature at the time the 
measurements are collected. 

MinChannels The minimum number of channels in the ISDN-PRI CBC trunk 
group allocated to the specified service/feature at the time the 
measurements are collected. 
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Column Contains Field 

%ATB Percentage All Trunks Busy. The percentage of time (0 to 100%) 
during the measurement interval that the specified 
service/feature could not get a channel because of at least one 
of the following reasons: 

• All trunks in the ISDN-PRI CBC trunk group are busy on 
a call or busied-out by maintenance. 

• This service/feature is above its minimum; and all 
available trunks are reserved for other features/services 
below their minimums. 

• The specified feature or service is at its maximum 
number of channels. 

Suggested actions: 

1. A number in the GroupOvfl field indicates the physical 
maximum number of trunks is exhausted. Unless the 
trunk group is the last preference in the routing pattern, 
overflow is to the next trunk group. Otherwise, the 
obvious choice is to add more trunks to the trunk group. 

2. If the SvcOvfl field indicates a problem (for example, a 
significant number), refer to Suggested actions in the 
SvcOvfl description.  

3. If the MaxChanOvfl field indicates a problem (for 
example, a significant number), refer to Suggested 
actions in the MaxChanOvf description. 

%TBM Percentage of Trunks Below Minimum. The percentage of time 
during the polling interval that the number of channels in use by 
the specified service/feature is below the specified minimum. 

Suggested action: Lower the “MinChannels” since this may be 
the cause for the “SvcOvfl”. 

NOTE: 

If the % TBM field is high, then you are reserving more trunk 
members than will be used. Determine if another service/feature 
needs more trunks and, if so, lower the “MinChannels” for this 
service/feature. 



Avaya Fault & Performance Manager User Guide 

256 

Column Contains Field 

%Block Percentage Outgoing Blocking. The ratio of outgoing calls not 
carried for a specified service/feature to the outgoing calls 
offered by the service/feature. For an ISDN-PRI CBC trunk 
group without a queue, the calls not carried are those calls that 
find all facilities busy for the specified service/feature. For an 
ISDN-PRI CBC trunk group with a queue, the calls not carried 
are queue abandons plus those calls that find all facilities for the 
specified service/feature busy and cannot be queued because 
the queue is full. 

Suggested actions: 

1. Look at the % ATB column and identify any service/feature 
with a high value. Follow the Suggested actions in the % ATB 
description. 

2. You can increase the length of the queue rather than adding 
more trunks. Subsequently, you should monitor the Queue 
Abandonments field to insure it stays within reasonable limits. 

3. If conditions are such that Item 1 above is not appropriate, 
you may find it necessary to add more trunks. 

SvcOvfl Overflow Services/Features. The number of calls that requested 
the specified service/feature but denied because the calls 
arrived under the following conditions: 

• The specified service/feature is at or above its minimum 
channel allocation and below its maximum allocation. 

• There are idle channels available in the trunk group, but 
they are reserved to meet the minimum channel 
allocation for other services/features. 

Suggested actions: 

1. Investigate the possibility of raising the “MinChannels” 
requirements for this service/feature. 

2. Investigate the possibility of increasing the number of 
members for the trunk group. 

3. Determine whether or not the “MinChannels” 
assignments for the other services/features are 
appropriate. For example, if the column “% TBM” 
displays a high number for one or more of the other 
service/features, then you can lower the minimums (for 
one or more of the other services/features). This makes 
more trunks available for this service/feature. 

TanSieze Tandem Seizures. The total number of trunk-to-trunk call 
seizures using this Service/Feature. 

TotSieze The total number of incoming and outgoing calls that requested 
the specified service/feature through the ISDN-PRI CBC trunk 
group. 
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• Usage Allocation Plans Used: 

Column Contains Field 

TG# A number that identifies each trunk group associated with the 
displayed data. Group numbers are displayed in numerical 
order, beginning with the lowest administered number and 
continuing to the highest administered number (key). 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software 
started (key). 

NMS Time Most recent date and time when the Network Management 
System (NMS) software started. 

Plan Allocation Plan Used. A list of the Usage Allocation Plan 
numbers followed by a list of the durations (in minutes) each 
plan was in effect during the measurement interval. The Number 
field can display up to a maximum of six plan numbers. A 
maximum of three different UAPs (identified by the numbers 1, 
2, and 3) may be defined for each trunk group. All three plans 
are defined on Page 3 of the trunk group screen. Page 4 of the 
corresponding trunk group screen is where you administer plan 
assignments. 

Each CBC trunk group is administered with either “fixed” 
allocation or “scheduled” allocation. If fixed, it remains in effect 
continuously. If scheduled, the designated plans are activated on 
a per-day and time-of-day basis determined by the schedule. 

Duration the durations (in minutes) each plan (above field) was in effect 
during the measurement interval. 

• Primary Data: 

Column Contains 

TG# A number that identifies each trunk group associated with the 
displayed data. Group numbers are displayed in numerical 
order, beginning with the lowest administered number and 
continuing to the highest administered number (key). 

Voice System A 20-character string administered by the customer that 
uniquely identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software 
started (key). 

NMS Time Most recent date and time when the Network Management 
System (NMS) software started. 
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Column Contains 

QueOvfl The total number of calls denied access to a trunk, found the 
queue full, and the caller received reorder tone. 

Suggested actions: Generally, this field displays the number 
0. If this field indicates a high number, then the queue size may 
be too small, more trunks may be needed so fewer calls will 
queue, or the UAP may be too restrictive (for example, some of 
the “MinChannels” values may be too high, or some of the 
“MaxChannels” values may be too low). Also, see Suggested 
actions in the % TBM description. 

QueSize Size of the queue for the ISDN-PRI CBC trunk group. If zero is 
displayed, then no queue is administered. Hence, the other 
queue measurements is also zero. If the queue is administered, 
then it serves all of the network services/features administered 
for the trunk group. However, its functional operation is 
somewhat different than the queue used with conventional 
trunk groups. When a particular service/feature uses its allotted 
maximum number of channels, then any additional call 
attempts are queued, even though not all of the trunks are 
currently in use. If the queue is already full, any additional call 
attempts simply overflow with the caller receiving reorder tone. 

Recommendations: Since one service/feature generally does 
not experience peak traffic the same time as another 
service/feature, there is an averaging effect. Furthermore, the 
queue size for a CBC trunk group need not be much larger than 
for a non-CBC trunk group. The Queue Size should be larger 
than the trunk group size; but, typically, not more than three 
times as large as the trunk group size. 

CallsQue The total number of calls entered the CBC trunk group queue 
during the hour. 

OOS The number of trunks in the trunk group out of service at the 
time the measurements are collected. An individual trunk may 
be taken out of service either automatically by the switch 
whenever an excessive number of errors occur, or by 
maintenance personnel in order to run diagnostic tests. 

Suggested action: If the trunks were removed from service by 
the switch, then the appropriate maintenance personnel should 
be notified. The objective is to keep all members of a trunk 
group in service. Generally, you should not make adjustments 
to the CBC trunk group because of Out of Service trunks, but 
should get those trunks returned to service. 
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Column Contains 

QueAban The number of calls removed from the queue by either the 
system or the user. The system automatically removes calls 
from the queue after 30 minutes. A user may abandon his/her 
call by canceling the Automatic Callback feature (set earlier to 
place their call in the queue). 

Suggested action: Recall that a trunk group and its associated 
queues are sized to accommodate peak-hour traffic loads. 
Typically, this field indicates a small number. However, a large 
number generally indicates the queue size is too large and 
people are abandoning because they remained in queue for a 
long time. Consider adding more trunks so fewer calls queue. 

Dir Group Direction. Identifies whether the trunk group is incoming 
(inc), outgoing (out), or two-way (two). 

Name Administered trunk group name. 

Size Group Size. The number of administered trunks in a specified 
trunk group. For additional details, refer to the Hardware Guide 
for Avaya™ Communication Manager. 

Type Group Type. The type of trunk associated with the accumulated 
data. The system monitors the following trunk types (see 
Administrator’s Guide for Avaya™ Communication Manager): 

• Access (access) 

• Advanced Private Line Termination (aplt) 

• Central Office (co) or Public Network Service 

• Customer Provided Equipment (cpe) 

• Digital Multiplexed Interface Bit Oriented Signaling 
(dmi-bos) 

• Direct Inward Dialing (did) 

• Direct Inward/Outward Dialing (diod) 

• Foreign Exchange (fx) 

• Integrated Services Digital Network (isdn-pri) 

• Release Link Trunk (rlt) 

• Tandem (tandem) 

• Tie Trunk (tie) 

• Wide Area Telecommunications Service (wats) 

Service Service (?) 

TAC Trunk Access Code administered for the trunk group. 

WB WideBand flag. If any trunks in the trunk group are used in a 
wideband (n X DS0) connection, a “W” appears in this column. 
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Tabs 

• Systems tab 

• Trunk Groups tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Performance: Trunk Groups- Wideband Report 

The Wideband Trunk Performance Report shows configuration, usage, and peg counts for 
wideband Trunk Groups. Records may be filtered by system, Trunk Group or Trunk Group list, 
and time. 

Fields 

Column Contains 

TG# A number that identifies each trunk group associated with the 
displayed data. Group numbers are displayed in numerical order, 
beginning with the lowest administered number and continuing to 
the highest administered number (key). 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

TotUsage Total usage (in CCS) for all trunks in the trunk group. Represents 
the total time the trunks are busy (with calls) during the one-hour 
measurement period. Total usage measures each time a trunk is 
seized for use by an incoming call (whether it is picked up or not) or 
an out going call (only after digits have been dialed). 

OOS The number of trunks in the trunk group out of service (listed as 
maintenance busy) at the time data is collected. An individual trunk 
may be taken out of service by the switch whenever an excessive 
number of errors occur, or by maintenance personnel to run 
diagnostic tests. 

Suggested action: If the trunks are removed from service by the 
switch, then the appropriate maintenance personnel should be 
notified. The objective is to keep all members of a trunk group “in 
service.” Generally, you should not make adjustments to the trunk 
group because of “Out of Service” trunks, but should get those 
trunks returned to service. 

GroupOvfl The number of calls offered to a trunk group not carried or queued 
(if a queue is present). Calls rejected for authorization reasons are 
not included. 

IncSeize The number of incoming seizures carried on the trunk group. 
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Column Contains 

%ATB The percentage of time all trunks in the trunk group were 
simultaneously in use during the measurement interval. 

NOTE: 

In use means the trunks are busy — either serving calls or because 
they are busied-out by maintenance. 

Suggested actions: 

1. If the group direction is outgoing or two-way, then a high 
number in the %ATB field and nothing in the GroupOvfl or 
QueOvfl indicates everything is functioning normally. 
However, a more typical scenario is a high number in this 
field and a high number in the GroupOvfl field. This 
indicates a possible problem that necessitates further 
analysis. Unless it is the last trunk group in the pattern, 
overflow is to the next choice trunk group, and the number 
in the GroupOvfl field is of no great significance. 
Otherwise, the obvious choice is to add more trunks to the 
trunk group. 

2. If the group direction is incoming, then a high number in 
this field is bad. It indicates some incoming calls are 
probably blocked. Generally, you want to add more trunks, 
thus lowering the %ATB and decreasing the number of 
calls blocked. 
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Column Contains 

%Block The percentage of offered calls not carried on the trunk group. It 
does not include unauthorized calls denied service on the trunk 
group (due to restrictions) or calls carried on the trunk group but do 
not successfully complete at the far end (that is, where there is no 
answer). For trunk groups without a queue, the calls not carried are 
those calls that arrive when all trunks are busy. The number of 
Outgoing Seizures is calculated as follows: 

Outgoing Seizures = Total Seizures − Incoming Seizures 

Similarly, the equation for calculating Outgoing Calls Offered is as 
follows: 

Outgoing Calls Offered = Group Over flow + Outgoing 
Seizures 

%Block = GroupOvfl / Outgoing Calls Offered 

For trunk groups with a queue, the calls not carried are those calls 
that arrive when all trunks are busy and the queue is full (Queue 
Overflow) and calls removed from queue before being carried 
(Queue Abandoned). For this scenario, the Percentage Outgoing 
Blocking is calculated as follows: 

Outgoing Calls Offered = QueOvf + QueAbd + Outgoing 
Seizures 

% OutBlk = ((QueOvfl + QueAbd)/Outgoing Calls Offered) * 
100 

Suggested actions: 

1. You can increase the length of the queue rather than 
adding more trunks. Subsequently, you should monitor the 
Que Abd field to insure it stays within reasonable limits. 

2. If conditions are such that Step 1 is not appropriate, then 
you may find it necessary to add more trunks. 

NOTE: 

If you are using ARS you may see a high number in this field. This 
only indicates calls are overflowing to the next choice. 

TotSeize The number of incoming and outgoing seizures carried on the trunk 
group. This includes the number of times a trunk in the group is 
seized, including false starts, don’t answer, and busy. 

Dir Identifies whether the trunk group is incoming (inc), outgoing (out), 
or two-way (two). 

Name Administered trunk group name. 

Size The number of administered trunks in the trunk group. 
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Column Contains 

Type Group Type. The type of trunk in the trunk group. The system 
monitors/measures the following trunk types: 

• Access Tie Trunk (Access) 

• Advanced Private Line Termination (aplt) 

• Central Office (co) 

• Public Network Service Customer Provided Equipment 
(cpe) 

• Direct Inward Dialing (did) 

• Direct Inward/Outward Dialing (diod) 

• Digital Multiplexed Interface Bit Oriented Signaling (dmi-
bos) 

• Foreign Exchange (fx) 

• Integrated Services Digital Network (isdn-pri) 

• Release Link Trunk (rlt) 

• Tandem (tan) 

• Tie Trunk (tie) 

• Wide Area Telecommunications Service (wats) 

Service Service Type. The administered Service Type for the trunk group. 
Valid entries are accunet, i800, inwats, lds, mega800, megacom, 
multiquest, operator, other, outwats-bnd, public-ntwrk, sdn, sub-
operator, and wats-max-bnd. 

TAC Trunk Access Code administered for the trunk group. 

WB WideBand flag. If any trunks in the trunk group are used in a 
wideband (n X DS0) connection, a “W” appears in this column. 

Tabs 

• Systems tab 

• Trunk Groups tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 

 



Using Avaya FPM 

265 

Performance: Voice Conditioner Report 

The Voice Conditioner Performance Report shows available counts/usage, H320/voice/total 
usage/allocation/denials, out-of-service, and blockage. May be filtered by system and time. 

Fields 

Column Contains 

Voice System A 20-character string administered by the customer that uniquely 
identifies the voice system (key). 

Voice System Time Most recent date and time when the voice system software started 
(key). 

NMS Time Most recent date and time when the Network Management System 
(NMS) software started. 

Available Ports Total number of VC ports in the system. 

Available Usage Total time, in CCS, that all VC ports are available in the system. 
Calculated as #MMI ports x 36. 

H320 Allocation Total time VC ports are allocated to H320 endpoints. 

H320 Denials Number of times a port was needed for an H320 call, but was not 
available. 

H320 Usage Total time that VC ports are allocated to H320 endpoints. 

Hour Measurement Hour. The hour for which these measurements 
apply, on the 24-hour clock. 

Out of Service The total time, in CCS units, that any MMI ports were out of service 
during any part of the measured interval. 

APB % The percentage of time during the measured interval that all MMI 
ports are unavailable to carry a new call. 

Block % The percentage of attempted allocations of MMI ports that are not 
successful. This value is calculated as % blockage = (Total Denials 
/ Total Alloc + Total Denials) * 100 

Total Allocation Total number of times a VC port was allocated to a call. Each B-
channel used on a multimedia call counts as one allocation. 

Total Denials Total number of times a VC port was needed for any call, but was 
not allocated because all VC ports were busy. 
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Column Contains 

Total Usage Total time, in CCS units, that VC ports are available to carry a new 
call. This includes time that the ports are busy on a call, out of 
service or maintenance busy. Measured from the time that the port 
is allocated until it is released. 

Voice Allocation Total time VC ports are allocated to voice endpoints. 

Voice Denials Number of times a port was needed for a voice call, but was not 
available. 

Voice Usage Total time VC ports are allocated to voice endpoints. 

Tabs 

• Systems tab 

• Fields tab 

• Sort tab 

• Format tab 

• Time tab 

• Destination tab 
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Screen Reference 
Main Window 

The main window offers three "views":  

• Configuration and Status (default) 

• FPM Administration 

• Report Manager 

Configuration and Status 
The Configuration and Status view is the default view when you open FPM. It provides a concise, 
graphical view of the configuration and health of your voice systems, using tabs and a Windows-
File-Explorer-like "tree" to represent your voice system network. The tabs provide alternate ways 
of organizing the information.  

• System Groups: Displays voice systems in user-defined groups 

• DCS Trunk Connectivity: Displays voice systems in groups based on DCS trunk 
connectivity. 

• IP Trunk Connectivity: Displays voice systems in groups based on IP trunk connectivity. 

• Clusters: Displays information about ESS and LSP clusters. 

For System Groups, DCS Trunk Connectivity, and IP Trunk Connectivity, the nodes in the tree 
represent objects in the network, and you can click objects at different levels of the tree to see 
different levels of detail about your network.  

• The first level of the tree shows the groups of voice systems that Fault and Performance 
Manager is monitoring,  

• The second level shows the individual voice systems in those groups, and  

• The third level shows the components of the voice systems: cabinets and stations, for 
example.  

For Clusters, the nodes in the tree are specifically related to ESS and LSP support.  

Cluster Groups 

ESS Clusters 

ESS Configuration 

LSP Clusters 

LSP Configuration 

You can open and close the branches of the tree by clicking the key icons. When the key points 
to the right, the subtree branches are closed. When the key points down, the subtree branches 
are displayed. 

Click a group, a system, or a component of a system to view information about it. 

Fault and Performance Manager places colored symbols by the nodes in the tree if there are 
exceptions in the branches beneath. By default, these symbols mean: 

Critical Alarm 

Major Alarm 
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Minor Alarm 

Warning 

The highest level of alarm that has occurred anywhere in a branch will be represented at the 
parent node so that you can see the alarm even if the branch is closed. 

FPM Administration 
The FPM Administration window lets you control which data Fault and Performance Manager 
collects from each voice system, whether it collects the data daily or hourly, and what time each 
day or hour it collects the data. View a list of the data that you can collect 

Report Manager 
The Report Manager lets you create customized performance, exception, and configuration 
reports for your voice system. After you create a report, the Report Manager lets you run the 
report immediately, save it to run later, or schedule it to run periodically. It lets you see the report 
output on the screen, send it to a printer, or write it to a file in HTML or character-delimited format. 
The Report Manager also lets you define reports containing data from multiple voice systems, 
giving you a comprehensive view of your voice system network. View a list of reports that Fault 
and Performance Manager can generate 

Menus 
The main window (the Network Monitor) contains the following menu options: 

• File 

 Administration: Opens the FPM Administration Window 

 Report Manager: Opens the Report Manager Window 

 Exit: Exits Fault and Performance Manager 

• View 

 Refresh: Refreshes the contents of the window if the displayed information has 
changed 

• Help 

 Help Topics: Displays the Table of Contents for the help system 

 Current Panel: Accesses help on the panel in the display pane 

 About: Displays information about Fault and Performance Manager. 

Status Bar 
The Status Bar at the bottom of the Main Window displays the status of user requests. 

Related Topics 
• How to view your network  
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Administration window 
FPM Administration Window 
Overview 

This window lets you specify what data to collect and when.  

 Note: 

You can complete administration functions such as setting data collection parameters 
only from the server application GUI. Administration functions are not available from the 
web client. 

The Navigation Pane displays the following tree structure. In the FPM Administration window, 
click the object in the Navigation pane that you want to administer. Below, you can click a link to 
learn more about that window. 

• Administration Root 

 Default Parameters 

• Configuration Collection 

 Trunk Exceptions 

 Alarms/Errors 

 Performance Collection 

 Processor Occupancy Exceptions 

 Trunk Group Exceptions 

 System Exceptions 

 System Groups 

 DEFINITY Parameters 

• Configuration Collection 

 Trunk Exceptions 

 Alarms/Errors 

 Performance Collection 

 Processor Occupancy Exceptions 

 Trunk Group Exceptions 

Menu Options 

• File 

 Close: Closes the FPM Administration window 

• View 

 Refresh: Refreshes the contents of the window if the displayed information has 
changed 

• Help 

 Help Topics: Displays the Table of Contents for the help system 
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 Current Panel: Accesses help on the panel in the display pane 

 About: Displays information about FPM. 

Related Topics 

• Understanding the Main Window  

• Understanding the Report Manager  
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Filtering Alarms (Alarm Filter Panel) 
The Alarm Filter Panel gives you detailed control of alarm collection and processing. You specify 
a set of parameters to filter out a selected set of alarms. Additional parameters define how often 
alarm collection occurs, and what actions to take when an alarm is received. 

Use this panel to View, Add, Modify, and Delete parameters for alarm filtering. 

• Default Alarm/Error Panel 

The default Alarm/Error panel appears under Administration Root > Default 
Parameters > Alarms/Errors.  

The default alarm filters apply to all systems except those where custom alarm filters have been 
defined. 

• Custom Alarm/Error Panel 

The custom Alarm/Error panel appears under Administration Root > Voice System 
Parameters > [system name] > Alarms/Errors.  

For each voice system, collection can be on or off. Each voice system can use either the 
default alarm filter parameter values, or custom alarm filter parameters.  

Viewing Alarm Filters 

Defined alarm filters are displayed as a scrolling list: 
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Selecting an alarm filter (or clicking Add) opens the selected filter (or a new filter) in the Alarm 
Filter Configurator.  

 

 

Filter Parameters: These parameters are shown in each row of the Alarm Filters panel, and in 
the upper section of the Alarm Filter Configurator used to define or edit alarm filters. 

• Filter Type: Select the type of alarm to be filtered: 

 Definity Alarms: Alarms collected from the Communication Managers and 
maintenance objects in the Communication Managers. 

 Note: 

Definity Alarms now includes the previous filter type: Traps. Selection 
of Definity Alarms now provides both filtering on FPM and setting filters 
on the platform. Traps is no longer available. 

 Restart Alarms: Restarts of the Communication Managers. 

 Note: 

Restart Alarms now includes the previous filter type: Restarts. 
Selection of Restart Alarms now provides both filtering on FPM and 
setting filters on the platform. Restarts is no longer available. 

 Server Alarms: Alarms collected from the Linux servers that hosts the 
Communication Managers. 

 Note: 

Server Alarms now includes the previous filter type: Platform. Selection 
of Server Alarms now provides both filtering on FPM and setting filters 
on the platform. Platform is no longer available. 
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 Errors: Errors collected from the Communication Managers. 

 Board Conflicts: Board conflicts detected in the Communication Managers 
(detected as conflicts between what is administered and what is actually plugged 
in). 

• Severity: Select the severity of alarm to be filtered: 

 Major 

 Minor 

 Warning (custom filters only) 

 Critical 

 Resolved (custom filters only) 

 All 

 None (this field does not apply to this filter) 

 Notes: 

 To receive traps for Warning and Resolved alarms, the Communication 
Manager must be release 3.0 or above, and Use Custom Values must 
be selected. 

 The filters for warning and resolved alarms are sent to the 
Communication Manager g3Agent using SNMP. The agent must be 
properly setup and the SNMP write community strings must be 
provided when requested. 

 There are a huge number of warning alarms. It is counterproductive to 
turn on all warning alarms on all maintenance objects. The intent of 
warning severity is to allow notification of events of particular interest on 
a limited number of crucial Maintenance Objects. 

• Collection Frequency: select the frequency of alarm filtering:  

 None (this field does not apply to this filter) 

 Daily 

 Hourly  

 Note: 

This field is only used for Filter Type values Definity Alarms, Server Alarms, 
and Errors — those types that are collected on a schedule from the 
Communication Manager. This field does not apply to Board Conflicts or 
Restart Alarms. 

• Category: Categories are groups of Maintenance Object types. (For example, when the 
Filter Type is Definity Alarms, the default Equipment-Type category expands to the MO 
group {MediaGateways, Cabinets, Boards, Ports, Extensions, and Trunks}. When a 
Category is chosen, the MO-Type contains the corresponding expanded list of 
Maintenance Objects. 

This field is only used for Filter Type values Definity Alarms, Server Alarms, Platform, 
Errors and Traps. This field does not apply to Board Conflicts, and Restarts. 
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• MO-Type: The Maintenance Object type can be selected from an appropriate list of 
Maintenance Objects within each Category. If a specific Maintenance Object is chosen, 
the filter applies only to Maintenance Objects of that type. If the value All is chosen, the 
filter applies to all Maintenance Objects in the Category. 

• MO-Location: The default All applies the filter to all locations for the chosen MO-Type. If 
a location is specified, the filter applies only to that location. 

 Note: 

When the MO-Type is specified as Error, the MO-Location field contains the 
Error Code. 

Action Parameters: These parameters are shown in each row of the Alarm Filters panel, and in 
the lower section of the Alarm Filter Configurator used to define or edit alarm filters. 

• Alert/Store as: Select the level of severity at which to alert and store. 

 Store only: The alarm/trap information is stored in the database, but not 
displayed. 

 Critical, Major, Minor, Warning: The alarm/trap information is stored in the 
database and displayed with the selected severity. 

 None: The alarm/trap information is neither stored nor displayed. 

• ARS Script: The fully qualified name of any applicable ARS Script. The default is None. 

• Send Mail To: The address to which to send email notification. The default is None. 

• Trap Level: select the level of severity at which to set an SNMP trap for another 
monitoring system. 

 None: Do not forward/generate a trap for this alarm/trap. 

 Critical, Major, Minor, Warning: Generate/forward a trap to the HP/OV NMS 
system. The default is Major. 

Specifying Default Filters 

The default Alarm/Error panel appears under Administration Root > Default Parameters > 
Alarms/Errors.  

The default alarm filters apply to all systems except those where custom alarm filters have been 
defined. 

Specifying Custom Filters 

The custom Alarm/Error panel appears under Administration Root > Voice System 
Parameters > [system name] > Alarms/Errors.  

For each voice system, collection can be on or off. Each voice system can use either the default 
alarm filter parameter values, or custom alarm filter parameters.  

Adding, Modifying, and Deleting Alarm Filters 

When the alarm filter panel is displayed, you can add, change, and delete filters using the buttons 
at the bottom of the panel: 

• Add: Click Add to open the Alarm Filter Configurator with a blank form for a new filter. 

• Modify: Select an existing filter by clicking on its row. Then click Modify to open the 
Alarm Filter Configurator with the selected filter parameters filled in for editing. 
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• Delete: Select one or more existing filters by clicking on their rows. Then click Delete to 
delete the selected filters. Multiple filters can be selected by clicking the first filter and 
then holding down the <shift> key and clicking the last filter. 

• Save: The Save button becomes active when any changes are mode to the panel. Click 
the Save button to save the changes to the database. Attempting to close the panel 
without saving requires a confirm dialog to save or discard the changes. 

• Reset: The Reset button becomes active when any changes are mode to the panel. 
Click the Reset button to discards any changes to the panel and reloads the panel from 
the database. 

Generating Test Traps 

The Test Trap button at the bottom of the Alarm Filter Panel generates a test trap. 

• At the default level the Test Trap button is always enabled. FPM determines which voice 
systems have CM4.0 (load 730.0 and above) and sets those systems to generate a trap. 

• At the voice system level clicking the Test Trap button generates a trap for that voice 
system. The Test Trap button is enabled only if the voice system has CM4.0 (load 730.0 
and above). 

If an appropriate alarm filter (Type = Trap, Severity = Warning or All) exists, the resulting traps 
display in the Voice System Exception Report. The Description indicates that this is a customer 
alarm test. 
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Filtering Alarms (Alarm Filter Panel) 
Use this panel to set parameters for adjunct alarms and errors. There are four tabs in this panel 
as follows: 

Default Parameters 

If you are viewing this panel under the Default Parameters tree node, the following fields are 
available: 

• Major Alarms: Allows you to set actions to be taken for major alarm exceptions 

 Store Exception: check to store major alarms exception data. 

 Alert: check to store the alert status. 

 Email/Notification: check to send an email. You must fill in the destination email 
address. 

 ARS Script: check to execute an associated ARS script. 

 Severity: select the level of severity: critical, major, minor, warning. The 
default is major. 

• Minor Alarms: Allows you to set actions to be taken for minor alarm exceptions 

 Store Exception: check to store minor alarms exception data. 

 Alert: check to store the alert status. 

 Severity: select the level of severity: critical, major, minor, warning. The default is 
minor. 

• Warning Alarms: Allows you to set actions to be taken for warning alarm exceptions 

 Store Exception: check to store warning alarms exception data. 

 Alert: check to store the alert status. 

 Severity: select the level of severity: critical, major, minor, warning. The default is 
warning. 

• Inads Exception: Allows you to set actions to be taken for Inads exceptions 

 Store Exception: check to store Inad exception data. 

Voice System Parameters 

If you are viewing this panel under the Voice System Parameters tree node, the following fields 
are also available: 

• Collection on: sets whether or not trunk exception collection is turned on. Check to turn 
on. Clear to turn off. 

 Use default values: sets whether or not default values are used. Check to use 
default values. 

 Use custom values: sets whether or not custom values are used. Check to use 
custom values. 

Related Topics 

• How to Set Data Collection Parameters  
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Configuration Collection panel 
The Configuration Collection panel is used to set parameters for collecting configuration data. 

Default Parameters 

If you are viewing this panel under the Default Parameters tree node, the following fields are 
available: 

• Frequency: Allows you to set configuration collection frequency parameters. 

• Times: Allows you to set a schedule for collection of configuration data. 

• Collection Start Minute: set the minute within the hour when configuration collection 
should start. Valid entries are 0-59. The default is 30. 

• Daily Collection Hour: set the hour in the day when the configuration collection should 
start. Valid entries are 0-23 (24 hr. format). The default is 1. 

• Weekly Collection Day: select the day during the week when the configuration collection 
should occur. Pay attention to the current time of day when you complete this field. If the 
hour (specified in the above field) has already passed, then the report will not run until the 
specified hour occurs during the following week. 

Voice System Parameters 

If you are viewing the Configuration Collection panel under the Voice System Parameters tree 
node, the following fields are also available: 

• Collection on: sets whether or not configuration data collection is turned on. Check to 
turn on. Clear to turn off. 

• Use default values: sets whether or not default values are used. Check to use default 
values. 

• Use custom values: sets whether or not custom values are used. Check to use custom 
values. 

Related Topics 

• How to set data collection parameters  
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Performance Collection panel 
Use this panel to set parameters for collecting performance data and alerting based on threshold 
values for any data field.  

Default Parameters 

If you are viewing this panel under the Default Parameters tree node, the following fields are 
available: 

• Thresholds: Allows you to set threshold alarms based on collected performance data. 

 Performance Type: Specifies the type of performance data to be used for 
setting thresholds.  

 Field: Specifies all available data fields for the Performance Type selected. 

 Collection Freq: Specifies if threshold testing is to be hourly, daily, or weekly (or 
not applicable). 

 Operation: Specifies how the data value is compared to the entered value (<, 
<=, =, >, >=). 

 Threshold: Specifies the value to be used for comparison. 

 Alert/Store as: Specifies the severity level associated with an alert. 

 ARS Script: Specifies any associated ARS script. 

 Send Mail To: Specifies recipients of email. 

 Trap Level: Specifies SNMP traps to be forwarded to other systems. 

 NMS: Select routing to any or all Network Management Systems in the drop-
down checkbox list revealed by clicking the NMS button. 

• Collection Hours: Allows you to set the schedule for collection of performance data. 

 Collection: Check On next to each day of the week that you want to schedule 
collection of performance data. 

 Start Time: Select the time (24 hr. format) to start collection of performance data. 

 Stop Time: Select the stop time (24 hr. time format) to stop collection of 
performance data. 

• Storage Limits: Allows you to set the storage limits for performance data that is 
collected. 

 Keep hourly data for: Enter the number of days less than or equal to 186 (6 
months) 

 Keep daily peaks for: Enter the number of days less than or equal to 730 (2 
years) 

 Keep weekly peaks for: Enter the number of weeks less than or equal to 260 (5 
years) 

• Times: Allows you to set when performance data is to be collected.  

 Hourly Data Collection Start Minute: Enter the start minute for performance 
data collected hourly. Valid values are 0-59. The default is 7. 

 Daily Collection Hour: Enter the start hour for performance data collected daily. 
Valid values are 0-23 (24 hr. format). The default is 1. 
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Voice System Parameters 

If you are viewing this panel under the Voice System Parameters tree node, the following fields 
are also available after you select a voice system: 

• Collection on: sets whether or not performance collection is turned on. Check to turn on. 
Clear to turn off. 

 Use default values: sets whether or not default values are used. Check to use 
default values. 

 Use custom values: sets whether or not custom values are used. Check to use 
custom values. 

Related Topics 

• How to set data collection parameters  
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Threshold Alarm Panel 
The Threshold Alarm Panel gives you detailed control of threshold alarm collection and 
processing. You specify a set of parameters to define threshold variables and values. Additional 
parameters define what actions to take when an alarm is received. 

Use this panel to View, Add, Modify, and Delete parameters for threshold alarms. 

• Default Threshold Panel 

The default Threshold panel appears under Administration Root > Default Parameters 
> Performance Collection.  

The default Threshold panel applies to all systems except those where custom thresholds 
have been defined. 

• Custom Threshold Panel 

The custom Threshold panel appears under Administration Root > Voice System 
Parameters > [system name] > Performance Collection.  

For each voice system, collection can be on or off. Each voice system can use either the 
default threshold parameter values, or custom threshold parameters.  

Viewing Threshold Settings 

Defined threshold settings are displayed as a scrolling list: 

     

 

Selecting a threshold setting and clicking Modify (or clicking Add) opens the selected threshold 
(or a new threshold) in the Performance Threshold Configurator.  
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Threshold Parameters: These parameters are shown in each row of the Thresholds panel, and 
in the upper section of the Performance Threshold Configurator used to define or edit threshold 
settings. 

• Performance Type: Select the type of threshold to be set: 

Attendant Groups 

Hunt Groups 

Coverage Paths 

Principal Data 

Inter-Port Network Latency 

Port Networks 

Processor Occupancy 

Routing Patterns 

Security Violations 

Switch Node Links 

Tone Receivers 

Trunk Groups 

Trunk Groups, ISDN-PRI 
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Attendant Groups 

Trunk Groups, Wideband 

IP Codecs 

IP DSP Resources 

IP Signalling Groups 

Announcements 

CLAN Sockets 

CLAN Ethernet 

CLAN PPP 

Call Rate 

Multimedia Interface 

Expansion Services Module 

Voice Conditioners 

Denial Events 

CAC/BL Status 

 

• Field: Select the data field to be tested for a threshold value: 

The fields available depend on the Performance Threshold selected. For each 
Performance Threshold type, all available data fields are listed. 

• Collection Frequency: Select the frequency of threshold testing:  

 None (this field does not apply) 

 Hourly 

 Daily 

 Weekly 

• Operation: Select the method of threshold testing: 

 None (this field does not apply) 

 > (data value is greater than threshold value) 

 >= (data value is greater than or equal to threshold value) 

 = (data value is equal to threshold value) 

 < (data value is less than threshold value) 
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 <= (data value is less than or equal to threshold value) 

• Threshold: Enter a numeric value to be used for comparison to the data value. 

Action Parameters: These parameters are shown in each row of the Thresholds panel, and in 
the lower section of the Performance Threshold Configurator used to define or edit threshold 
settings. NOTE: Routing to Network Management Systems outside of Fault and Performance 
Manager is on a concealed list of check boxes activated by the NMS button. 

• Alert/Store as: Select the level of severity at which to alert and store. 

 Store only: The threshold information is stored in the database, but not 
displayed. 

 Critical, Major, Minor, Warning: The threshold information is stored in the 
database and displayed with the selected severity. 

• ARS Script: The fully qualified name of any applicable ARS Script. The default is None. 

• Send Mail To: The address to which to send email notification. The default is None. 

• Trap Level: Select the level of severity at which to set an SNMP trap for another 
monitoring system. 

 None: Do not forward/generate a trap for this alarm/trap. 

 Critical, Major, Minor, Warning: Generate/forward a trap to the HP/OV NMS 
system. The default is Major. 

• NMS: Select routing to any or all Network Management Systems in the list of check 
boxes revealed by clicking the NMS button. 

Specifying Default Thresholds 

The default Thresholds panel appears under Administration Root > Default Parameters > 
Performance Collection.  

The default thresholds apply to all systems except those where custom thresholds have been 
defined. 

Specifying Custom Thresholds 

The custom Thresholds panel appears under Administration Root > Voice System Parameters 
> [system name] > Performance Collection.  

For each voice system, collection can be on or off. Each voice system can use either the default 
threshold parameter values, or custom threshold parameters.  

Adding, Modifying, and Deleting Thresholds 

When the Thresholds panel is displayed, you can add, change, and delete thresholds using the 
buttons at the bottom of the panel: 

• Add: Click Add to open the Performance Threshold Configurator with a blank form for a 
new threshold. 

• Modify: Select an existing threshold by clicking on its row. Then click Modify to open the 
Performance Threshold Configurator with the selected threshold parameters filled in for 
editing. 

• Delete: Select one or more existing thresholds by clicking on their rows. Then click 
Delete to delete the selected thresholds. Multiple thresholds can be selected by clicking 
the first threshold and then holding down the <shift> key and clicking the last threshold. 

• Save: The Save button becomes active when any changes are mode to the panel. Click 
the Save button to save the changes to the database. Attempting to close the panel 
without saving requires a confirm dialog to save or discard the changes. 
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• Reset: The Reset button becomes active when any changes are mode to the panel. 
Click the Reset button to discards any changes to the panel and reloads the panel from 
the database. 
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Processor Occupancy Exceptions Panel 
This panel is used to log processor occupancy data. There are two versions of this panel.  

Default Parameters 

If you are viewing this panel under the Default Parameters tree node, the following fields are 
available: 

• Exception: Allows you to set the processor occupancy exceptions. 

• Store Exception: check to store processor occupancy exception data. 

• Alert: check to store the alert status. 

• Email/Notification: check to send an email. You must fill in the destination email 
address. 

• ARS Script: check to execute an associated ARS script. 

• Select NMS to sent Traps: Click the Details button to reveal a list of checkboxes for 
defined Network Management Systems. 

• Severity: select the level of severity: critical, major, minor, warning. The default is 
major. 

Voice System Parameters 

If you are viewing this panel under the Voice System Parameters tree node, the following fields 
are also available: 

• Exception: Allows you to set how to administer processor occupancy exceptions for your 
voice system. 

• Use default values: sets whether or not default values are used. Check to use default 
values. 

• Use custom values: sets whether or not custom values are used. Check to use custom 
values. 

• Threshold: Allows you to set occupancy threshold parameters for voice systems. 

Related Topics 

• How to set data collection parameters  
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System Groups Administration Panel 
Use this panel to create new system groups and move systems into different system groups.  

You might want to create groups of systems for the following reasons: 

• If you are using DCS and not all of your systems belong to the same DCS configuration 

System groups need to be set up so that the Distributed Communications Service (DCS) 
Configuration windows (see DCS Connectivity Display and DCS Link Display) work 
properly when more than one DCS system is being managed. However, if all systems 
belong to the same DCS configuration, or if DCS is not in use, it is not necessary to 
create system groups. 

• If you want to group systems for convenience 

By default, all systems belong to the Systems group.  

What do you want to do? 

• Create a system group  

• Move a system to a new group  

• What I want to do isn't listed here  
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Trunk Exceptions Panel 
Use this panel to tell Fault and Performance Manager what to do when it encounters trunk 
exceptions.  

Default Parameters 

If you are viewing this panel under the Default Parameters tree node, the following fields are 
available: 

• Lightly Used Trunks: Allows you to set options for lightly used trunk exceptions 

 Store Exception: check to store exception data. 

 Alert: check to store the alert status. 

 Email/Notification: check to send an email. You must fill in the destination email 
address. 

 ARS Script: check to execute an associated ARS script. 

 Select NMS to sent Traps: Click the Details button to reveal a list of 
checkboxes for defined Network Management Systems. 

 Severity: select the level of severity: critical, major, minor, warning. 

• Trunk Outages: Allows you to set options for trunk outage exceptions 

 Store Exception: check to store exception data. 

 Alert: check to store the alert status. 

 Email/Notification: check to send an email. You must fill in the destination email 
address. 

 ARS Script: check to execute an associated ARS script. 

 Select NMS to sent Traps: Click the Details button to reveal a list of 
checkboxes for defined Network Management Systems. 

 Severity: select the level of severity: critical, major, minor, warning. 

• Holding Times: Allows you to set actions to be taken for ACA referrals for long and short 
holding times 

 Store Exception: check to store exception data. 

 Alert: check to store the alert status. 

 Email/Notification: check to send an email. You must fill in the destination email 
address. 

 ARS Script: check to execute an associated ARS script. 

 Select NMS to sent Traps: Click the Details button to reveal a list of 
checkboxes for defined Network Management Systems. 

 Severity: select the level of severity: critical, major, minor, warning. 

• Frequency: Allows you to set trunk collection frequency options 

 Daily 

 Hourly 

• Times: Allows you to set a schedule for collection of trunk exceptions 
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 Collection Start Minute: set the minute within the hour when trunk exception 
collection should start. Valid entries are 0-59. The default is 7. 

 Daily Collection Hour: set the hour in the day when the trunk exception 
collection should start. Valid entries are 0-23 (24 hr. format). The default is 1. 

Voice System Parameters 

If you are viewing this panel under the Voice System Parameters tree node, the following fields 
are also available: 

• Collection on: sets whether or not trunk exception collection is turned on. Check to turn 
on. Clear to turn off. 

• Use default values: sets whether or not default values are used. Check to use default 
values. 

• Use custom values: sets whether or not custom values are used. Check to use custom 
values. 

• ACA Status: an ACA status label indicates whether or not ACA is enabled on the 
selected system. 

Related Topics 

• How to set data collection parameters  
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Trunk Group Exceptions Panel 
Use this panel to tell Fault and Performance Manager what to do when it encounters trunk group 
exceptions. 

Default Parameters 

If you are viewing this panel under the Default Parameters tree node, the following fields are 
available: 

• Exception: Allows you to set the fields for administering trunk group exceptions 

 Store Exception: check to store trunk group exception data. 

 Alert: check to store the alert status. 

 Email/Notification: check to send an email. You must fill in the destination email 
address. 

 ARS Script: check to execute an associated ARS script. 

 Select NMS to send Traps: Click the Details button to reveal a list of 
checkboxes for defined Network Management Systems. 

 Severity: select the level of severity: critical, major, minor, warning. The default is 
warning. 

• Calculation: Allows you to set the fields for the traffic model and service objective to use. 

 Model: select the traffic model from the drop-down list. Valid values are ErlangB, 
ErlangC, and Retrial. The default value is ErlangB. 

 Service Objective P. : set the service objective. This is a numeric-only field. 
Valid values are 001-700. The default value is 010. 

Voice System Parameters 

If you are viewing this panel under the Voice System Parameters tree node, there is a table 
display. The table contains a row for each non-wideband trunk group in the voice system 
configuration. You can edit the rows in the table. 

Related Topics 

• How to set data collection parameters  
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System Exceptions Panel 
Use this panel to tell Fault and Performance Manager what to do when it encounters problems 
collecting data or generating reports.  

• Maximum days to store exception records:  

Enter the number of days that Fault and Performance Manager should store records 
about any problems it encounters collecting data or generating reports. Valid values are 
0-999. The default is 30 days. 

 Note: 

The longer the exception records are to be stored, the larger the database 
becomes. Use this to manage the size of the database and the lengths of time 
exception records are stored. 

• Collection Failure:  

Use this tab to tell Fault and Performance Manager what to do when there is a data 
collection failure. Data collection failures could occur if the network is "down" between 
your Fault and Performance Manager server and your voice systems, or if a given voice 
system is down. 

 Check the "Store Exception?" check box if you want Fault and Performance 
Manager to store a record of the failure. 

 Check the "Alert" check box and select an alarm level if you want Fault and 
Performance Manager to display an alarm if it encounters problems collecting 
data. 

 Check the "Email/Notification" check box to send an email. You must fill in the 
destination email address. 

 Check the "ARS Script" check box to execute an associated ARS script. 

 Check the "Select NMS to send Traps" check box and click the Details button 
to reveal a list of checkboxes for defined Network Management Systems. 

• Report Failure:  

Use this tab to tell Fault and Performance Manager what to do when there is a report 
failure. 

 Check the "Store Exception?" check box if you want Fault and Performance 
Manager to store a record of the failure. 

 Check the "Alert" check box and select an alarm level if you want Fault and 
Performance Manager to display an alarm if it encounters problems generating 
reports. 

 Check the "Email/Notification" check box to send an email. You must fill in the 
destination email address. 

 Check the "ARS Script" check box to execute an associated ARS script. 

 Check the "Select NMS to send Traps" check box and click the Details button 
to reveal a list of checkboxes for defined Network Management Systems. 

Related Topics 

• How to set data collection parameters  

• How to view or change report settings  
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Configuration & Status window 
Board Display 
This window provides the following information: 

• Board configuration information, including: 

 The system name 

 The cabinet/carrier/slot location 

 The board type 

 The board code and suffix 

 The board vintage 

 The total number of ports 

 The DS1 board name (DS1 boards only) 

 The signaling mode (DS1 boards only) 

 The CSU module (DS1 boards only) 

• An alert summary showing the alert counts for the selected board, and a sum of alert 
counts for all of the ports on the selected board 

• Port information (when appropriate for the board type), including: 

 An alert indicator showing the highest alert for this port 

 The port number 

 The status (assigned, unassigned, or TTI) 

• TCP/IP table (for CLAN boards only), including: 

 Connection state 

 Remote IP address 

 Remote Port 

• Command buttons 

 Busyout: Sends the busy out command to the system for the selected board  

 CAUTION!  

Busying out a trunk, trunk group, port, or boards can significantly 
interrupt the operation of your telecommunications system. Be 
certain that you understand the ramifications in the context of your 
own system before using this feature. For more information, refer to 
the documentation that came with your Communication Manager.   

 Note: 

Busyout/release must be enabled in Avaya Proxy Agent before it will 
work properly in Fault and Performance Manager. To enable this 
capability in Avaya Proxy Agent, consult Avaya Proxy Agent 
Configuration, which came on the Avaya Proxy Agent software CD-ROM. 
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 Camp-on Busyout: Sends the camp-on busyout command to the system for the 
selected board (TN2302AP, TN2302BP, or TN802B boards only). 

 Release: Sends the release command to the system for the selected board 

 Exceptions: Displays all exceptions for the selected board 

 Details: Displays the Port Display for the selected port (default)(when 
appropriate for the board type), or connection details for CLAN boards. 

 Close: Closes this window 

Related Topics 

 Board Display - ATM  

 Boards Display  
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Board Display - ATM 
This window provides the following information:  

• An alert summary showing the alert counts for the selected board, and a sum of alert 
counts for all of the circuits on the selected board 

• Board information, including: 

 The system name 

 The board's cabinet/carrier/slot location 

 The board name 

 The synchronization capable flag 

 The board type 

 The board code and suffix 

 The board vintage 

• Circuit information, including: 

 An alert indicator showing the highest alert for the selected circuit 

 The port number 

 The trunk group number 

 The signaling group number 

• Command buttons: 

 Busyout: Sends the busy out command to the system for the selected board  

 CAUTION 

Busying out a trunk, trunk group, port, or boards can significantly 
interrupt the operation of your telecommunications system. Be 
certain that you understand the ramifications in the context of your 
own system before using this feature. For more information, refer to 
the documentation that came with your Communication Manager.   

 Note: 

Busyout/release must be enabled in Avaya Proxy Agent before it will 
work properly in Fault and Performance Manager. To enable this 
capability in Avaya Proxy Agent, consult Avaya Proxy Agent 
Configuration, which came on the Avaya Proxy Agent software CD-ROM. 

 Release: Sends the release command to the system for the selected board 

 Exceptions: Displays all exceptions for the selected circuit 

 Details: Displays the Port Display for the selected circuit (default) 

 Close: Closes this window 

Related Topics 

• Board Display  

• Boards Display  
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Boards Display 
This display appears when, in the navigation tree in the left pane of the Fault and Performance 
Manager main window, you click a voice system, then the "Cabinets" node, then a carrier, then a 
board. This display provides the following information: 

• The System Name 

• The board type 

• The board code 

• An Alert summary showing the alert severity and the count for this board. 

• A Boards configuration table containing the following data about ports: 

 An icon representing the highest alert for the port 

 The port number 

 The port status 

• Command buttons 

 Exceptions: Displays all exceptions for this board 

 

Related Topics 

• Board Display - ATM  

• Board Display  
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Bulletin Board Display 
This window provides the following information: 

• System Name 

• System Type 

• A table containing message date and message text 
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Busy Out/Release Results Display 
This display summarizes the results of a busy out or release of a board or trunk group.  

 CAUTION! 

Busying out a trunk, trunk group, port, or boards can significantly interrupt the 
operation of your telecommunications system. Be certain that you understand the 
ramifications in the context of your own system before using this feature. For more 
information, refer to the documentation that came with your Communication 
Manager.   

 Note: 

Busyout/release must be enabled in Avaya Proxy Agent before it will work properly in 
Fault and Performance Manager. To enable this capability in Avaya Proxy Agent, consult 
Avaya Proxy Agent Configuration, which came on the Avaya Proxy Agent software CD-
ROM. 

Busyout/Release of Boards 

The Busyout/Release of Boards Results window provides the following information: 

• Configuration information, including: 

 The system name 

 The board location 

• Results configuration table, including: 

 The port number  

 The result of the busy out or release for the selected board 

• The voice system error code, in case of an error 

• The voice system error message if there was an error 

• Command buttons 

 Close: Closes this window 

Busyout/Release of Trunk Groups 

The Busyout/Release of Trunk Groups Results window provides the following information: 

• Configuration information, including: 

 The system name 

 The trunk group number 

• Results configuration table, including: 

 The trunk number  

 The result of the busy out or release for the selected trunk 

• The Communication Manager software error code, in case of an error 

• The Communication Manager software error message if there was an error 

• Command buttons 

 Close: Closes this window 
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Cabinet Display 
This display appears when you click "Cabinets" within a voice system node in the navigation tree 
in the left pane of the Fault and Performance Manager main window. This display provides the 
following information: 

• The System Name 

• The System Type and release 

• An Alert summary showing the alert severity, count for this voice system, and the sum of 
counts for all the cabinets for this voice system 

• A Cabinets configuration table containing the following data: 

 An icon representing the highest alert for the cabinet 

 Cab: the cabinet number 

 Layout: the cabinet layout 

 Type: the cabinet type 

 Building: the building location 

 Floor: the floor location 

 Room: the room number 

 Car A: the Port Network or Switch Node assigned to Carrier A 

 Car B: the Port Network or Switch Node assigned to Carrier B 

 Car C: the Port Network or Switch Node assigned to Carrier C 

 Car D: the Port Network or Switch Node assigned to Carrier D 

 Car E: the Port Network or Switch Node assigned to Carrier E 

 SRP: the name or product ID for the associated Survivable Remote Processor 

• Command buttons 

 Exceptions: Displays all exceptions for this voice system 

 Details: Displays the Detailed Cabinet Display for the selected cabinet (default) 

Related Topics 

• Detailed Cabinet Display  
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Detailed Cabinet Display 
This display includes either a cabinet graphic or a board table on the right side of the window. 
You can toggle between the graphic and table displays via the Table View and Graphic View. 
The graphic display shows the location and type of each board in the selected Cabinet, and each 
board is colored to indicate its alert level. You can double-click any board in the graphic display or 
in the board table to view a board display.  

The Detailed Cabinet display provides the following information: 

• Cabinet Configuration and Status, including: 

 System Name 

 Cabinet number 

 Layout 

 Type 

 Building location 

 Floor location 

 Room number 

• An Alert summary showing the alert severity, alert counts for the selected cabinet, and a 
sum of alert counts for all of the boards in the selected cabinet 

• Carrier information, including: 

 An alert indicator showing the highest alert for this carrier 

 Carrier ID number, type, and Port Network Number or Switch Node Number 

• Board information (table), including: 

 An alert indicator showing the highest alert for this carrier 

 The cabinet/carrier/slot location 

 The board type 

 The board code and suffix 

 The board vintage 

 The total number of ports 

 The number of ports in use 

 The number of TTI ports 

 The number of PSA ports 

 The number of unused ports 

• Command buttons 

 Inventory: Displays the inventory report for the selected cabinet 

 Graphic View/Table View: Toggles between the graphic and table data views 

 Exceptions: Displays all exceptions for the selected cabinet 

 Details: Displays the Board Display for the selected board (default) 

 Close: Closes this window 
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Related Topics 

• Cabinet Display  
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Carriers Display 
This display appears when you click a carrier within the "Cabinets" node, within a voice system 
node, in the navigation tree in the left pane of the Fault and Performance Manager main window. 
This display provides the following information: 

• Cabinet Configuration and Status, including: 

 System Name 

 Cabinet number 

 Layout 

 Type 

 Building location 

 Floor location 

 Room number 

 Rack 

• Carrier information, including: 

 A list of carriers within this cabinet 

 Alert indicators for carriers with exceptions 

 Carrier ID number, type, and Port Network Number or Switch Node Number 

• Command buttons 

 Exceptions: Displays all exceptions for the selected cabinet 

 Details: Displays details about the selected carrier 
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Data Modules Display 
This window provides the following information: 

• Data Modules information, including: 

 The system name 

 The system type and release 

• An alert indicator showing alert counts for all data modules. 

• Data Modules configuration information, including: 

 An alert indicator showing the highest alert for the selected data module 

 The data module extension 

 The data module location 

 The data module type 

 The data module name 

• Command buttons 

 Exceptions: Displays all exceptions all data modules 

 Details: Displays the Port Display for the selected data module (default) 
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DCS Connectivity Display 
This window provides the following information: 

• DCS Connectivity configuration information, including: 

 The system name 

 The system type and release 

 The PBX ID of the voice system 

• An alert indicator showing alert counts for all DCS components on the selected link. 

• DCS Links information, including: 

 The name of the voice system on the far end of the selected link 

 The PBX ID of the voice system on the far end of the selected link 

 The DCS signaling type 

 The number of trunk groups 

 The number of trunks 

• Command buttons 

 Exceptions: Displays all exceptions for the selected DCS link 

 Details: Displays the DCS Link Display for the selected DCS link (default) 

Related Topics 

• DCS Link Display  
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DCS Link Display 
This window provides the following information: 

• DCS link configuration information, including: 

 The system name of the voice system  

 The PBX ID of the voice system on the selected link 

 The name of the voice system on the far end of the selected link 

 The PBX ID of the voice system on the far end of the selected link 

• An alert indicator showing alert counts for all DCS components on the selected DCS link 

• Trunk Groups information, including: 

 An alert indicator showing the highest alert for the selected trunk group 

 The voice system endpoint name 

 The PBX ID of the endpoint voice system  

 The trunk group number 

 The trunk group name 

 The number of trunks 

 The trunk group type 

 The trunk signaling type 

• Command buttons 

 Exceptions: Displays all exceptions for the selected DCS link (both ends) 

 Details: Displays the Trunk Group Display for the selected trunk group (default) 

 Close: Closes this window 

Related Topics 

• DCS Connectivity Display  
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ESS/LSP Configuration Display 
This window provides the following information: 

• System Name 

• System Type 

For each ESS or LSP, the following information is provided: 

• name 

• IP address 

• The Service State (newer systems) or whether the ESS or LSP is available for translation 
update (older systems) 

• the date and time when the translations were last updated 
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LSP Server Configuration Display 
This window provides the following information: 

• System Name 

• System Type 

• IP address and type for each LSP server 
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Media Gateway Stacks Display 
This display appears when, in the navigation tree in the left pane of the Fault and Performance 
Manager main window, you click a system group node, then a system node, then the " 
MGStacks" node. This window provides the following information for the selected media gateway 
stacks: 

• Media Gateway Stacks configuration and status information, including: 

 The system name 

 The system type 

• An alert summary showing the alert counts for all the media gateway stacks 

• Media gateway stacks information, including: 

 An alert indicator showing the highest alert for this media gateway stack 

 The media gateway stack number 

 The IP address for the media gateway stack 

 The system name 

 The system description 

 The system location 

 The system contact 

• Command buttons 

 Busyout: Sends the busy out command to the system for this port 

 CAUTION! 

Busying out a trunk, trunk group, port, or boards can significantly 
interrupt the operation of your telecommunications system. Be 
certain that you understand the ramifications in the context of your 
own system before using this feature. For more information, refer to 
the documentation that came with your Communication Manager.   

 Note: 

Busyout/release must be enabled in Avaya Proxy Agent before it will 
work properly in Fault and Performance Manager. To enable this 
capability in Avaya Proxy Agent, consult Avaya Proxy Agent 
Configuration, which came on the Avaya Proxy Agent software CD-ROM. 

 Release: Sends the release command to the system for this port 

 Exceptions: Displays all exceptions for this port 

 Close: Closes this window 

Related Topics 

• Media Gateway Stack Display  

• Media Module Configuration and Status Display  

• Media Modules Display  
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Media Gateway Stack Display 
This display appears when, in the navigation tree in the left pane of the Fault and Performance 
Manager main window, you click a system node, then the "MGStacks" node, then a specific 
media gateway stack. This window provides the following information: 

• Media Gateway Stack configuration and status information, including: 

 The system name 

 The media gateway stack number 

 The hub address 

 The system name 

 The system description 

 The system location 

 The system contact 

• Media Gateway information, including: 

 An alert indicator showing the highest alert for this media gateway 

 The media gateway number 

 The media gateway name 

 The IP address for the media gateway 

 The serial number of the media gateway 

 The node number of the voice system 

 The IP address for the active controller  

 The hardware type 

 The media gateway vintage  

 The suffix (indicates the board version) 

 The media gateway recovery rule number 

 The media gateway recovery rule type 

 The stack position 

 The stack number 

 The controllers 

• Command buttons 

 Refresh Recovery Rule: Reads the recovery rule from the selected media 
gateway 

 Exceptions: Displays all exceptions for this media gateway 

 Details: Displays detailed information about the selected media gateway 

 View Recovery Rule: Displays the recovery rule from the selected media 
gateway 
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Related Topics 

• Media Gateway Stacks Display  

• Media Module Configuration and Status Display  

• Media Modules Display  
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Media Module Configuration and Status Display 
This display appears when, in the navigation tree in the left pane of the Fault and Performance 
Manager main window, you click a system node, then the "MGStacks" node, then a specific 
media gateway stack node, then a media gateway node, then a media module. This window 
provides the following information for the selected media module: 

• Board information, including: 

 The system name 

 The media module type 

 The media module code 

 The board vintage 

 The suffix (indicates the board version) 

• An alert summary showing the alert counts for the selected media module 

• Port information, including 

 An alert indicator showing the highest alert for this port 

 The port number 

 The port status (assigned or unassigned) 

• Command buttons 

 Exceptions: Displays all exceptions for this port 

Related Topics 

• Media Modules Display  

• Media Gateway Stacks Display  

• Media Gateway Stack Display  
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Media Modules Display 
This display appears when, in the navigation tree in the left pane of the Fault and Performance 
Manager main window, you click a system node, then the "MGStacks" node, then a specific 
media gateway stack node, then a media gateway. This window provides the following 
information for the selected media module: 

• Media gateway information, including: 

 The system name 

 The media gateway number 

 The media gateway name 

• An alert summary showing the alert counts for the selected media gateway 

• Media modules information, including 

 An alert indicator showing the highest alert for this media module 

 The media module type 

 The media module code 

 The media module vintage 

 The suffix (indicates board version) 

 The total number of ports 

 The number of ports being used 

 The TTI 

 The PSA 

 The number of unused ports 

• Command buttons 

 Exceptions: Displays all exceptions for this media module 

 Details: Displays detailed information for the selected media module 

Related Topics 

• Media Module Configuration and Status Display  

• Media Gateway Stacks Display  

• Media Gateway Stack Display  
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Port Display - External Device 
This window provides the following information for the selected external device: 

• Port information, including:  

 The system name 

 The cabinet/carrier/slot/port location 

 The board type 

 The alternate name 

 The device description 

 The product identifier 

 The building 

 The address 

 The alarm level 

• An alert summary showing the alert counts for the selected port  

• Command buttons  

 Busyout: Sends the busy out command to the system for this port  

 CAUTION! 

Busying out a trunk, trunk group, port, or boards can significantly 
interrupt the operation of your telecommunications system. Be 
certain that you understand the ramifications in the context of your 
own system before using this feature. For more information, refer to 
the documentation that came with your Communication Manager.   

 Note: 

Busyout/release must be enabled in Avaya Proxy Agent before it will 
work properly in Fault and Performance Manager. To enable this 
capability in Avaya Proxy Agent, consult Avaya Proxy Agent 
Configuration, which came on the Avaya Proxy Agent software CD-ROM. 

 Release: Sends the release command to the system for this port 

 Exceptions: Displays all exceptions for this port 

 Close: Closes this window 
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Port Display - General 
This display appears when, in the navigation tree in the left pane of the main window, you click a 
system node, then the "Cabinets" node, then a carrier, then a board, then a port. This window 
provides the following information:  

• Port information, including: 

 The system name 

 The cabinet/carrier/slot/port location 

 The board type 

 The code 

 The identifier for the station, trunk, etc. 

 A second equipment type for the BRI port 

 A second identifier for the station, trunk, etc. 

• An alert summary showing the alert counts for the selected port, and a sum of alert 
counts for all of the ports on the selected board 

• Command buttons 

 Busyout: Sends the busy out command to the system for this port  

 CAUTION! 

Busying out a trunk, trunk group, port, or boards can significantly 
interrupt the operation of your telecommunications system. Be 
certain that you understand the ramifications in the context of your 
own system before using this feature. For more information, refer to 
the documentation that came with your Communication Manager.   

 Note: 

Busyout/release must be enabled in Avaya Proxy Agent before it will 
work properly in Fault and Performance Manager. To enable this 
capability in Avaya Proxy Agent, consult Avaya Proxy Agent 
Configuration, which came on the Avaya Proxy Agent software CD-ROM. 

 Release: Sends the release command to the system for this port 

 Exceptions: Displays all exceptions for this port 

 Close: Closes this window 

Related Topics 

• Port Display - Data Module 

• Port Display - Trunk  
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Port Display - Data Module 
This display appears when, in the navigation tree in the left pane of the main window, you click a 
system node, then the "Cabinets" node, then a carrier, then a board, then a port. This window 
provides the following information for the selected data module:  

• An alert summary showing the alert counts for the selected port 

• Port information, including: 

 The system name 

 The cabinet/carrier/slot/port location 

 The board type 

 The data module extension 

 The data module type 

 The name assigned to the data module 

 The call forwarding extension 

 The service state 

 Maintenance Busy indicator (yes/no) 

 The connected ports 

• Command buttons 

 Busyout: Sends the busy out command to the system for this port  

 CAUTION! 

Busying out a trunk, trunk group, port, or boards can significantly 
interrupt the operation of your telecommunications system. Be 
certain that you understand the ramifications in the context of your 
own system before using this feature. For more information, refer to 
the documentation that came with your Communication Manager.   

 Note: 

Busyout/release must be enabled in Avaya Proxy Agent before it will 
work properly in Fault and Performance Manager. To enable this 
capability in Avaya Proxy Agent, consult Avaya Proxy Agent 
Configuration, which came on the Avaya Proxy Agent software CD-ROM. 

 Release: Sends the release command to the system for this port 

 Exceptions: Displays all exceptions for this port 

 Close: Closes this window 

Related Topics 

• Port Display - General  

• Port Display - Trunk  
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Port Display - Station 
This window provides the following information for the selected station: 

• An alert summary showing the alert counts for the selected port 

• Port information, including: 

 The system name 

 The cabinet/carrier/slot/port location 

 The board type 

 The board serial number 

 The port ID number 

 The station extension 

 The station type 

 The station name 

 The building location 

 The floor location 

 The room location 

 The cable 

 The jack 

 The current service state 

 A Maintenance Busy indicator (yes/no) 

 Send all calls (SAC) indicator (yes/no) 

 Call forwarding destination 

 Ring cutoff active indicator (yes/no) 

 The connected port locations 

• Command buttons 

 Busyout: Sends the busy out command to the system for this port  

 CAUTION! 

Busying out a trunk, trunk group, port, or boards can significantly 
interrupt the operation of your telecommunications system. Be 
certain that you understand the ramifications in the context of your 
own system before using this feature. For more information, refer to 
the documentation that came with your Communication Manager.   

 Note: 

Busyout/release must be enabled in Avaya Proxy Agent before it will 
work properly in Fault and Performance Manager. To enable this 
capability in Avaya Proxy Agent, consult Avaya Proxy Agent 
Configuration, which came on the Avaya Proxy Agent software CD-ROM. 

 Release: Sends the release command to the system for this port 
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 Exceptions: displays all exceptions for this port 

 Close: Closes this window 
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Port Display - Trunk 
This display appears when, in the navigation tree in the left pane of the main window, you click a 
system node, then the "Cabinets" node, then a carrier, then a board, then a port. This window 
provides the following information for the selected trunk group:  

• An alert summary showing the alert counts for the selected port 

• Port information, including: 

 The system name 

 The cabinet/carrier/slot/port location 

 The trunk group number 

 The trunk group member number 

 The trunk group name 

 The access code 

 The size 

 The type 

 The direction 

 The wideband indication (yes/no) 

 The service/feature 

 The ACA flag (yes/no) 

• Command buttons 

 Busyout: Sends the busy out command to the system for this port 

 CAUTION! 

Busying out a trunk, trunk group, port, or boards can significantly 
interrupt the operation of your telecommunications system. Be 
certain that you understand the ramifications in the context of your 
own system before using this feature. For more information, refer to 
the documentation that came with your Communication Manager.   

 Note: 

Busyout/release must be enabled in Avaya Proxy Agent before it will 
work properly in Fault and Performance Manager. To enable this 
capability in Avaya Proxy Agent, consult Avaya Proxy Agent 
Configuration, which came on the Avaya Proxy Agent software CD-ROM. 

 Release: Sends the release command to the system for this port 

 Exceptions: Displays all exceptions for this port 

 Close: Closes this window 

Related Topics 

• Port Display - Data Module  

• Port Display - General  
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Port Network ATM Link Display 
This window provides the following information:  

• Port network ATM link information, including: 

 The system name 

 The connection (A or B) 

 The port network connection number 

 The connection name 

 The port network number 

 The ATM board location 

 The ATM switch name 

 The authority and format identifier (AFI) 

 The ATM address 

 The high-order domain-specific part 

 The end system identifier 

 The selector 

• The alert counts for the selected port network link 

• Command buttons 

 Change ATM: Displays a dialog box to set the ATM switch name 

 Telnet ATM: Displays a login dialog box for the ATM switch  

 Exceptions: Displays all exceptions for the selected link 

 Details: Displays the Board Display for the board associated with the selected 
link (default) 

 Close: Closes this window 

Related Topics 

• Port Network Connectivity Graphical Display ATM  

• Port Network Connectivity Table Display ATM  
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Port Network Connectivity Graphical Display - ATM 
This window shows a graphical display of nodes for each port network and provides the following 
operational characteristics:  

• On a voice system PNC map, Fault and Performance Manager displays a node of each 
port network (PN), clearly distinguishing between processor port network (PPN) and 
expansion port network (EPN), and a port number label. 

• For each port network on a PNC map, each node is color-coded according to the most 
severe active exception on that node. 

• For a selected port network, the user can access the Port Network Display via a pop-up 
menu. 

• For ATM port network connectivity, Fault and Performance Manager displays a symbol 
representing the ATM network and the ATM link labeled with the link number and ATM 
switch name. 

• The user can access the ATM port network link display via a pop-up menu on an ATM 
link on the PNC map. 

• The user can Telnet to an ATM switch via a pop-up menu on an ATM switch icon. 

• Information such as ATM switch name and SRP, can be displayed via a tool tip when the 
cursor is placed on a port network icon or link. 

 Note: 

Double-clicking on an icon defaults to the first item in the pull-down menu for that icon. 
Double-clicking on a link defaults to the first item in the pop-up menu for that link. 

• Command buttons 

 Exceptions: Displays all exceptions for the selected PNC. 

 Table View: Toggles between the graphic and table views 

 Close: Closes this window 

Related Topics 

• Port Network Connectivity Table Display ATM  
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Port Network Connectivity Graphical Display - Center Stage 
This window shows a graphical display of nodes for each port network and provides the following 
operational characteristics:  

• On a voice system PNC map, Fault and Performance Manager displays a node of each 
port network (PN), clearly distinguishing between processor port network (PPN) and 
expansion port network (EPN), and a port number label. 

• For each port network on a PNC map, each node is color-coded according to the most 
severe active exception on that node. 

• For a selected port network, the user can access the Port Network Display via a pop-up 
menu. 

• For a center-stage switch PNC, port networks (PNs), switch nodes (SNs), SN-to-SN links, 
and PN-to-SN links are shown. The link is labeled with the fiber link number. 

• For a center-stage switch PNC, the link between the SN and PN shows when the port 
network number uses DS1 facilities via a tool tip. 

• The user can access the Switch Node Display via a pop-up menu on a switch node icon 
on the PNC map. 

• The user can access the Fiber Link Display via a pop-up menu on a link on the PNC 
map. 

• Information such as location, DS1, or SRP, can be displayed via a tool tip when the 
cursor is placed on a port network icon or link. 

 Note: 

Double-clicking on an icon defaults to the first item in the pull-down menu for that icon. 
Double-clicking on a link defaults to the first item in the pop-up menu for that link. 

• Command buttons 

 Graphic View/Table View: Toggles between the graphic and table data views 

 Close: Closes this window 

Related Topics 

• Port Network Connectivity Table Display - Center Stage  
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Port Network Connectivity Graphical Display - Direct Connect 
This window shows a graphical display of nodes for each port network. This window provides the 
following operational characteristics:  

• On a voice system PNC map, Fault and Performance Manager displays a node of each 
port network (PN), clearly distinguishing between processor port network (PPN) and 
expansion port network (EPN), and a port number label. 

• For each port network on a PNC map, each node is color-coded according to the most 
severe active exception on that node. 

• For a selected port network, the user can access the Port Network Display via a pop-up 
menu. 

• For a direct-connect port network, the links are labeled with the fiber link numbers. 

• The user can access the Fiber Link Display via a pop-up menu on a link on the PNC 
map. 

• Information such as location, DS1, or SRP, can be displayed via a tool tip when the 
cursor is placed on a port network icon or link. 

 Note: 

Double-clicking on an icon defaults to the first item in the pull-down menu for that icon. 
Double-clicking on a link defaults to the first item in the pop-up menu for that link. 

• Command buttons 

 Graphic View/Table View: Toggles between the graphic and table data views 

 Close: Closes this window 

Related Topics 

• Port Network Connectivity Table Display Direct Connect  
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Port Network Connectivity Status Display 
This window provides the following information:  

• PNC Status information, including:  

 The system name 

 The system type and release 

 A software locked indicator (yes/no) 

 A standby busy indicator (yes/no) 

 A standby refreshed indicator (yes/no) 

 An interchange disabled indicator (yes/no) 

 A last status update indicating the NMS time of the last update to this display 

• A-PNC/B-PNC Status information, including:  

 The mode (active/standby) 

 The state of health (functional, partially function, not functional) 

 InterPN index: 

 The Archangel Link Faults (number of PNs with EALs down) 

 The Neighbor Link Faults (number of PNs with LINK, RINL, or EI-SNIs 
neighbor link faults 

 The Hardware Faults (number of PNs affected by hardware faults in a 
link having an EI as an endpoint EXP-INTF) 

 The SNI Peer Link Faults (number of PNs affected by SNI peer link faults 
for SNIs connected to EIs) 

 The DS1C Facility Faults (number of PNs affected by DS1C facility 
faults) 

 InterSN index: 

 The SNL Link Faults (number of inter-switch node fibers affected by peer 
or neighbor link faults) 

 The SNI Hardware Faults (number of inter-switch node fibers affected by 
hardware faults) 

• Command buttons  

 Update: Provides a status update from voice system with an NMS time stamp 
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Port Network Connectivity Table Display - ATM 
This window provides the following information:  

• Port Network Connectivity information, including:  

 The system name 

 The system type and release 

 The PNC (A or B) 

• Alert counts for all ATM Port Network Connectivity (PNC) components  

• Port Network Connection information, including:  

 An alert indicator showing the highest alert for the selected port network 
connection 

 The port network connection number 

 The connection name 

 The port network number 

 The ATM board location 

 The ATM switch name 

 The authority and format identifier (AFI) 

 The address format 

 The ATM address 

 The high-order domain-specific part 

 The end system identifier 

 The selector 

• Command buttons  

 Exceptions: Displays all exceptions for the selected PNC. 

 Graphic View/Table View: Toggles between the graphic and table views 

 Details: Displays the Port Network Link Configuration and Status display for the 
selected link (default) 

Related Topics 

• Port Network Connectivity Graphical Display - ATM  
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Port Network Connectivity Table Display - Center Stage 
This window includes configuration tables for switch nodes, switch node links, and port network-
to-switch node links, and provides the following information:  

• Port Network Connectivity (PNC) information, including:  

 The system name 

 The system type and release 

 The PNC (A or B) 

• Alert counts for all PNC components  

• Switch node information, including:  

 An alert indicator showing the highest alert for the selected switch node 

 The switch node number 

 The carrier location 

 The building location 

 The floor location 

 The room location 

• Switch node links, including:  

 An alert indicator showing the highest alert for the selected switch node link 

 The fiber link number 

 The first switch node number (SN-1) 

 The first switch node interface board 

 The second switch node number (SN-2) 

 The second switch node interface board 

• Port Network links, including:  

 An alert indicator showing the highest alert for the selected port network link 

 The fiber link number 

 The switch node number 

 The switch node interface location 

 The DS1 converter location on the switch node number 

 The port network number 

 The expansion interface location 

 The DS1 converter location on the port network number 

 The converter type 

• Command buttons  

 Graphic View/Table View: Toggles between the graphic and table data views 

 Exceptions: Displays all exceptions for the selected PNC 
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 Details: Displays the Switch Node Display or Fiber Link Display for the selected 
switch node, switch number-to-switch number link, or port network number-to-
switch node number link (default) 

 Close: Closes this window 

Related Topics 

• Port Network Connectivity Graphical Display - Center Stage  
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Port Network Connectivity Table Display - Direct Connect 
This window provides the following information:  

• Port Network Connectivity information, including:  

 The system name 

 The system type and release 

 The PNC (A or B) 

• Alert counts for all Port Network Connectivity (PNC) components  

• Port Network link information, including:  

 An alert indicator showing the highest alert for the selected port network link 

 The fiber link number 

 The first port network number (PN-1) 

 The expansion interface (EI) location for the first port network 

 The DS1 converter location for the first port network 

 The second port network number (PN-2) 

 The expansion interface (EI) location for the second port network 

 The DS1 converter location for the second port network 

 The DS1 converter type 

• Command buttons  

 Graphic View/Table View: Toggles between the graphic and table data views 

 Exceptions: Displays all exceptions for the entire PNC 

 Details: Displays the Fiber Link Display for the selected link (default) 

Related Topics 

• Port Network Connectivity Graphical Display - Direct Connect  
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Port Network Display 
This window provides the following information: 

• Port Network information, including:  

 The system name 

 The port network number 

 The port network type 

 The cabinet that contains the selected port network 

 The carriers associated with the selected port network 

 The building location 

 The floor location 

 The room location 

 The name or product ID of the associated Survivable Remote Processor (SRP) 

• An alert summary showing:  

 The alert counts the selected port network 

 Alert counts summed up for all of the boards in the selected port network 

• Board information, including:  

 The cabinet/carrier/slot location 

 The board type 

 The board code and suffix 

 The board vintage 

 The total number of ports 

 The number of ports in use 

 The number of TTI ports 

 The number of unused ports 

• Command buttons  

 Exceptions: Displays all exceptions for the selected port network 

 Details: Displays the board display for the selected board (default) 

 Close: Closes this window 
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Fiber Link Display 
This window provides the following information:  

• Alert summary information, including:  

 The alert counts for the selected fiber link and associated boards 

 The alert counts for the selected fiber link 

• Fiber link configuration information, including:  

 The system name 

 The system type and release 

 The fiber link number 

 The PNC (A or B) 

 The first endpoint port network number or switch node number 

 The second endpoint port network number or switch node number 

 The control state 

 The service state 

• Board information, including:  

 An alert indicator showing the highest alert for this board 

 The board location 

 The port network or switch node number 

 The board type 

 The board code and suffix 

 The board vintage 

• Command buttons  

 Exceptions: Displays all exceptions for the selected fiber link 

 Details: Displays the Board Display for the selected board (default) 

 Close: Closes this window 
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Routing Patterns Display 
This window provides the following information: 

• Routing patterns information, including:  

 The system name 

 The system type and release 

• An alert summary showing alert counts for all routing patterns.  

• Routing Patterns configuration information, including:  

 An alert indicator showing the highest alert for the selected routing  

 The routing pattern number 

• Command buttons  

 Exceptions: Displays all exceptions all routing patterns 

 Details: Displays the Port Display for the selected routing pattern (default)  

Related Topics 

• Routing Pattern Display -Trunk Groups  
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Routing Pattern Display — Trunk Groups 
This window provides the following information: 

• Routing pattern information, including:  

 The system name 

 The system type and release 

 The routing pattern number 

 The routing pattern name 

• An alert indicator showing alert counts for the selected routing pattern  

• Trunk Groups configuration information, including:  

 An alert indicator showing the highest alert for the selected trunk group 

 The trunk group number 

 The trunk group name 

 The trunk access code 

 The number of trunks 

 The trunk group type 

 The direction (incoming, outgoing, or two-way) 

 The Wideband indication (yes/no) 

 The service/feature for ISDN-PRI CBC trunk groups 

• Command buttons  

 Exceptions: Displays all exceptions for the selected routing pattern 

 Details: Displays the Trunk Group Display for the selected trunk group (default) 

Related Topics 

• Routing Patterns Display  
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Server Display 
This display appears when you click "Server#" within a voice system node in the navigation tree 
in the left pane of the Fault and Performance Manager main window. This display provides the 
following information: 

• The Server Name 

• The Server IP address 

• The Server Status (active/standby) 

• An Alert summary showing the alert severity, count for this server 

• A Port Connections table containing the following data: 

 Service: Type of service the port is supporting on the connection 

 Destination: The IP address of the far end 

 Port: The IP Port used for the connection 

• Command buttons 

 Exceptions: Displays all exceptions for this voice system 

 Details: Displays the Detailed Cabinet Display for the selected cabinet (default) 
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Stations Display 
This window provides the following information:  

• Station information, including:  

 The system name 

 The system type and release 

• An alert indicator showing alert counts for all stations with exceptions  

• Stations with exceptions information, including:  

 An alert indicator showing the highest alert for the selected station 

 The station extension 

 The port location 

 The station type 

 The station name 

• Command buttons  

 Exceptions: Displays all exceptions for all stations 

 Details: Displays the Port Display for the selected station (default) 
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Switch Node Display 
This window provides the following switch node information:  

• Alert counts for the selected switch node  

• Switch node information, including:  

 The system name 

 The system type and release 

 The switch node number 

 The PNC (A or B) 

 The carrier location 

 The building location 

 The floor location 

 The room location 

• Board information, including:  

 The cabinet/carrier/slot location 

 The board type 

 The board code and suffix 

 The board vintage 

• Command buttons  

 Exceptions: Displays all exceptions for the selected switch node 

 Details: Displays the Board Display for the selected board (default) 

 Close: Closes this window 
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System Configuration Display 
This screen summarizes key configuration information about the node that you are looking at and 
serves as a "gateway" into a more extensive look at the selected node. You cannot make 
changes to this screen.  

This window provides the following information: 

• System configuration information, including:  

 The system name 

 The system type and release 

 The IP address 

 The connection status 

 The change status 

• An Alert summary showing the alert severity and count for the selected voice system's 
components  

• A listing of system components (such as Cabinets, Port Networks, Trunk Groups, and so 
on) and any corresponding alerts  

• Command buttons  

 Exceptions: Displays all exceptions for the selected voice system 

 Details: Displays the selected voice system component (default) 

 Update: Represents a status update from the voice system.  
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System Group & Adjuncts Group Graphic Display 
This graphic view contains the following operational characteristics: 

• For the group selected in the tree, Fault and Performance Manager displays a map with 
all voice systems or adjunct systems in that group. 

• For DCS and IP Trunk groups, FPM displays the DCS or IP Trunks connecting the 
systems. 

• Each icon is color-coded according to the most severe active exception on each system. 

• For the selected system icon on the map, the user can access the system component 
status display by a pop-up menu. The choices in the menu are the same as those 
available in the tree node. The pop-up menu also contains the following choices: 
System, which displays the System Display for the selected system, and Telnet to 
Proxy, which displays a login window for the Proxy Agent. 

• The user can access the system configuration display by double-clicking on the desired 
system icon. 

• A DCS link between any two voice systems indicates the signaling type (ISDN, X.25) and 
is color-coded for the most severe active exception on the link. The signaling type is 
indicated via a tool tip. 

• The user can access the DCS link display or IP trunk display through a pop-up menu on 
a selected link between two connected voice systems. 

 Note: 

Double-clicking on an icon defaults to the first item in the pull-down menu for that icon. 
Double-clicking on a link defaults to the first item in the pop-up menu for that link. 

Related Topics 

• System Group Table Display  
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System Group Table Display 
This window provides the following information for the selected system group: 

• An alert summary showing alert counts summed up for all of the systems in the selected 
group 

• A configuration table including:  

 An alert indicator showing the highest alert for the selected system 

 The system name 

 The system type  

 The system release 

 The PBX ID 

 The software version 

 An update ID 

 An update state 

• Command buttons  

 Exceptions: Displays all exceptions for all systems 

 Graphic View/Table View: Toggles between the graphic and table data views 

 Details: Displays the System Display for the selected system (default) 

Related Topics 

• System Group Graphic Display  
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System Status Display 
This window provides the following information: 

• System name  

• System type and release  

• Active SPE (A or B)  

• Static Occupancy: static CPU occupancy  

• Call Processing Occupancy: call processing CPU occupancy  

• System Management Occupancy: system management CPU occupancy  

• Idle Occupancy: idle CPU occupancy  

• Trunks Busied: number of trunks that have been busied out  

• Stations Busied: number of stations that have been busied out  

• Other Busied: number of other objects busied out  

• Logins: number of user logins  

• Last Alarms/Errors Refresh: NMS time of last alarms/errors collection  

• Last Configurations Refresh: NMS time of last configuration collection  

• Last status Update: NMS time of last status data refresh  

• Current Item: Current item in the queue  

• Queued Items: Items in the queue  

• Command buttons  

 Update Queue: Requests a queue update from the voice system 

 Update Status: Requests a status update from the voice system 

 Refresh Alarms/Errors: Requests a refresh of alarm and error data 

 Refresh Configuration: Requests a refresh of the configuration data 
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Trunk Group Display 
This window provides the following information: 

• Trunk Group configuration information, including:  

 The system name 

 The system type and release 

 The trunk group number 

 The trunk group name 

 The trunk access code 

 The number of trunks 

 The trunk group type 

 The direction (incoming, outgoing, or two-way) 

 The Wideband indication (yes/no) 

 The service/feature for ISDN-PRI trunk groups 

• An alert summary showing alert counts for all the trunks in the system   

 Alert counts for the selected trunk group 

 Alert counts for the trunks in the selected trunk group 

• Trunks with exceptions information, including:  

 An alert indicator showing the highest alert for the selected trunk 

 The trunk group member number 

 The trunk group member port 

• Command buttons  

 Busyout: Sends the busy out command to the system for the selected trunk 
group  

 CAUTION! 

Busying out a trunk, trunk group, port, or boards can significantly 
interrupt the operation of your telecommunications system. Be 
certain that you understand the ramifications in the context of your 
own system before using this feature. For more information, refer to 
the documentation that came with your Communication Manager.   

 Note: 

Busyout/release must be enabled in Avaya Proxy Agent before it will 
work properly in Fault and Performance Manager. To enable this 
capability in Avaya Proxy Agent, consult Avaya Proxy Agent 
Configuration, which came on the Avaya Proxy Agent software CD-ROM. 

 Release: Sends the release command to the system for the selected trunk group 

 Exceptions: Displays all exceptions for the selected trunk group 

 Details: Displays the Port Display for the selected trunk group (default) 

 Close: Closes this window 
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Related Topics 

• Trunk Groups Display  
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Trunk Groups Display 
This window provides the following information: 

• Trunk Groups information, including:  

 The system name 

 The system type and release 

• An alert summary showing alert counts for all trunk groups in the system  

• Trunk Group configuration information, including:  

 An alert indicator showing the highest alert for the selected trunk group 

 The trunk group number 

 The trunk group name 

 The trunk access code 

 The number of trunks 

 The trunk group type 

 The direction (incoming, outgoing, or two-way) 

 The Wideband indication (yes/no) 

 The service/feature for ISDN-PRI CBC trunk groups 

• Command buttons 

 Exceptions: Displays all exceptions for all trunk groups 

 Details: Displays the Trunk Group Display for the selected trunk group (default) 

Related Topics 

• Trunk Group display  
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Report Manager window 
Report Manager Screen 
From the File menu of the Configuration and Status screen you can select File > Report 
Manager... to open the FPM Report Manager screen. 

 

 

The FPM Report Manager screen provides: 
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• Report Definitions 

The Report Definitions panel lists all currently defined reports. 

For new reports, you can select report type, systems, and other parameters. You can 
schedule when reports are run on a regular basis. You can create ad-hoc reports and run 
them immediately when investigating a problem. 

For the types of reports you can define, see Report Types in the following topic. 

• Scheduled Reports 

You can select any  regularly scheduled report that has been saved to a file and display it 
or print it. 

• Trunk Group Lists 

You can define trunk group lists for reports that are based on network performance rather 
than system performance. 

Related Topics 

• New Report Dialog Box 

• Report Types 

• Defined Reports 

• Scheduled Reports 

• Trunk Group Lists 
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Reports Types 

 Note: 

Selection of a report type does not determine whether or not you have collected and 
saved the necessary information for the report. See Filtering Alarms, Default and Custom 
System Parameters, and Performance Data for data collection information. 

FPM produces many types of reports. The report types are listed below: 

 Notes: 

 If the value in the Time Scale column is "N/A", the report is not tied to 
any time scale. There are two different types of Time tabs, one for the 
exception reports and one for performance reports. On some of the 
performance reports, there are limited options on the Time tab. 

 The available tabs are listed under Component Selection. 

 If the value in the Secondary Data column is anything other than "N/A", 
the Report Output dialog box has a drop-down list where you can choose 
to display primary data, or one or more types of secondary data. 

• Configuration Reports 

Configuration reports can be run from the View menu (online) on the main Configuration 
and Status screen or System Detail screen as well as from the Report Manager screen. 
While the online and Report Manager reports are similar, they are not identical. 

 

Report Type 

 

Description 

Time  
Scales 

Component 
selection 

Secondary data 

Board Inventory 
(table format 
only) 

Board Inventory shows a 
count of boards (circuit 
packs) by type, code, suffix, 
and vintage. The inventory 
may include all boards or 
only selected systems or 
locations. 

N/A Systems tab 

Location tab 

 

N/A 

Board Report 
(table format 
only) 

Board Report shows a list 
of installed boards (circuit 
packs). The report may 
include all boards, or it may 
be filtered by system, type, 
code, or location. 

N/A Location tab 

Board Type tab 

 

N/A 

Capacity Report 
(table format 
only) 

Capacity Report provides 
used and available capacity 
information for a switch. 
The report displays 
information for the selected 
switches. 

N/A Systems tab N/A 
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Report Type 

 

Description 

Time  
Scales 

Component 
selection 

Secondary data 

Board Inventory 
(online) 

Board Inventory shows a 
count of boards (circuit 
packs) by type, code, suffix, 
and vintage. The inventory 
is filtered automatically 
based on the current 
position in the 
Configuration and Status or 
System Detail screen. 

N/A Automatic N/A 

Board Report 
(online) 

Board Report shows a list 
of installed boards (circuit 
packs). The inventory is 
filtered automatically based 
on the current position in 
the Configuration and 
Status or System Detail 
screen. 

N/A Automatic N/A 

Capacity Report 
(online) 

Capacity Report provides 
used and available capacity 
information for a switch. 
The inventory is filtered 
automatically based on the 
current position in the 
Configuration and Status or 
System Detail screen. 

N/A Automatic N/A 

• Exception Reports 

Some exception reports can be run from the View menu (online) on the main 
Configuration and Status screen or System Detail screen as well as from the Report 
Manager screen. While the online and Report Manager reports are similar, they are not 
identical. 

Report Type Description Time  
Scales 

Component 
selection 

Secondary 
data 

Exceptions: 
Adjunct Systems  
(table format only) 

Adjunct Exceptions shows 
adjunct-related exceptions, 
for example, alarms or 
traps. Exceptions may be 
filtered by system or by 
time. 

Time tab 
(Excptns) 

Systems tab 

 

N/A 
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Report Type Description Time  
Scales 

Component 
selection 

Secondary 
data 

Exceptions: 
Fault/Performance 
Manager 
(table format only) 

Network Manager 
exceptions shows 
exceptions related to this 
application, for example, 
failure to collect data or run 
a scheduled report. 
Exceptions may be filtered 
by type or time. 

Time tab 
(Excptns) 

N/A N/A 

Exceptions: Voice 
System 
(table format only) 

Voice System Exceptions 
shows voice system-related 
exceptions, for example, 
alarms or TG GOS 
violations. Exceptions may 
be filtered by system, type, 
location, or time. 

Time tab 
(Excptns) 

Systems tab 

Types tab 

Location tab 

N/A 

Exceptions: Voice 
System 
(online) 

Voice System Exceptions 
shows voice system-related 
exceptions. The exceptions 
are filtered automatically 
based on the current 
position in the Configuration 
and Status or System Detail 
screen. 

N/A Automatic N/A 

Exceptions: 
Transaction Logs 

Transaction Logs shows all 
transactions in FPM such as 
logins and busyouts and 
releases on media modules 
and ports.  

Time tab 
(Excptns) 

Systems tab N/A 

• Performance Reports 

Performance reports run only from the Report Manager. However, you can go directly to 
the New Report dialog box from View > Performance Data on the main Configuration 
and Status screen. 

Report Type Description Time  
Scales 

Component 
selection 

Secondary data 

Performance: 
Announcements 

Announcements 
performance shows 
maximum in-region and out-
region play requests queued, 
requested, and dropped. 
Records may be filtered by 
system time. 

Time tab Systems tab 

 

 

N/A 
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Report Type Description Time  
Scales 

Component 
selection 

Secondary data 

Performance: 
Attendant 
Groups 

Attendant Group 
performance shows call 
counts and usage for the 
group and for individual 
attendants. Records may be 
filtered by system and time. 

Time tab Systems tab 

 

Attendants 

Performance:  
CAC/BL Status 

Call Admission Control / 
Bandwidth Limitation 
performance shows source 
and destination region, 
connection type and status, 
bandwidth limit value and 
units, transmission and 
reception bandwidth and 
number of connections, and 
number of denials. 

Time tab Systems tab N/A 

Performance: 
Call Rate 

Call Rate performance 
shows busiest hour and 
interval. May be filtered by 
system and time.  

Time tab Systems tab 

Call Rate 
Types tab 

 

N/A 

Performance:  
CLAN Ethernet 

CLAN Ethernet performance 
shows CLAN ethernet crc 
counts, and delta by board. 
May be filtered by system 
and time. 

Time tab Systems tab N/A 

Performance: 
CLAN PPP 

CLAN PPP performance 
shows CLAN PPP crc counts 
and delta by board. May be 
filtered by system and time. 

Time tab Systems tab 

Board Type tab 

 

N/A 

Performance: 
CLAN Sockets 

CLAN Sockets performance 
shows CLAN socket usage, 
and denial counts and 
percentages by boards and 
regions. May be filtered by 
system and time.  

Time tab Systems tab N/A 

Performance: 
Coverage Paths 

Coverage Paths 
performance shows 
configuration, usage, and 
call counts. Records may be 
filtered by system, coverage 
path, and time. 

Time tab Systems tab 

Coverage 
Paths tab 

 

N/A 
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Report Type Description Time  
Scales 

Component 
selection 

Secondary data 

Performance: 
Denial Events 

Denial Events performance 
shows event type, 
description, event data, first 
occurrence, last occurrence, 
and event count. May be 
filtered by system and time. 

Time tab Systems tab N/A 

Performance: 
Expansion 
Services Module 

Expansion Service Module 
performance shows available 
ports/usage, total 
usage/allocation, denials, out 
of service, and blockage. 
May be filtered by system 
and time. 

Time tab Systems tab N/A 

Performance:  
Hunt Groups 

Hunt Group performance 
shows configuration, usage, 
and call counts. May be 
filtered by system, hunt 
group, and time. 

Time tab Systems tab 

Hunt Groups 
tab 

 

N/A 

Performance:  
Inter-Port  
Network 
Latency 

Inter-Port Network Latency 
shows PN connection 
requests and ATM setup 
requests with average delay 
in milliseconds. Records may 
be filtered by system, PN 
pairs, and time. 

Time tab Systems tab 

PN 
Connections 
tab 

 

N/A 

Performance: 
IP Codecs 

IP Codecs performance 
shows G.711/G.732/G.729 
codec usage, in CCS or 
Erlangs for IP codecs. 
Records may be filtered by 
system, IP codec type, and 
time. 

Time tab Systems tab N/A 

Performance: 
IP DSP 
Resources 

IP DSP Resources 
performance shows 
configuration, usage, and 
peg counts for IP DSP 
resources. Records may be 
filtered by system and time. 

Time tab Systems tab N/A 

Performance: 
IP Signaling 
Groups 

IP Signaling Groups 
performance shows packet 
latencies, and packets sent 
and lost for IP Signaling 
Groups. Records may be 
filtered by system and time. 

Time tab Systems tab N/A 
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Report Type Description Time  
Scales 

Component 
selection 

Secondary data 

Performance: 
Multimedia 
Interface 

Multimedia Interface 
performance shows available 
ports/usage, total 
usage/allocation, denials, out 
of service, and blockage. 
May be filtered by system 
and time. 

Time tab Systems tab N/A 

Performance:  
Port Networks 

Port Networks performance 
shows usage and peg 
counts. Records may be 
filtered by system, PN pair, 
and time. 

Time tab Systems tab 

Port Networks 
tab 

N/A 

Performance: 
Principal Data 

Principal Data performance 
shows configuration, usage, 
and call counts. Records 
may be filtered by system, 
principal data, and time. 

Time tab Systems tab 

Principal Data 
tab 

 

N/A 

Performance:  
Processor 
Occupancy 

Processor Occupancy shows 
occupancy and call counts. 
May be filtered by system 
and time. 

Time tab Systems tab N/A 

Performance:  
Routing 
Patterns 

Routing Patterns 
performance shows call 
counts for routing patterns 
and trunk groups within 
routing patterns. Records 
may be filtered by system, 
routing pattern, and time. 

Time tab Systems tab 

Routing 
Patterns tab 

 

Trunk groups 

Performance:  
Security 
Violations 

Security Violations includes 
valid and invalid attempts by 
port type and by system. 
Records may be filtered by 
system and time. 

Time tab Systems tab Port types 

Performance:  
Switch Node 
Links 

Switch Node Link 
performance shows usage 
and peg counts. Records 
may be filtered by system, 
SN link, and time. 

Time tab Systems tab 

Switch Node 
Links tab 

 

N/A 
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Report Type Description Time  
Scales 

Component 
selection 

Secondary data 

Performance:  
Tone Receivers 

Tone receiver performance 
shows peg counts for each 
tone receiver type and port 
network. Records may be 
filtered by system, tone 
receiver type, and time. 

Time tab Systems tab 

Tone 
Receivers tab 

 

Port networks 

Performance:  
Trunk Groups 

Trunk Group performance 
shows usage, peg count, 
and grade-of-service.  

Time tab Systems tab 

Trunk Groups 
tab 

 

Primary Data or 
Average Data 

Performance:  
Trunk Groups  
ISDN-PRI CBC 

ISDN-PRI performance 
shows configuration, usage, 
and counts for ISDN TG  

Time tab Systems tab 

Trunk Groups 
tab 

ISDN services 
or features, and 
usage 
allocation plans 

Performance:  
Trunk Groups, 
Wideband 

Wideband Trunk 
performance shows 
configuration, usage, and 
peg counts for wideband 
TGs. Records may be filtered 
by system, TG or TG list, and 
time. 

Time tab Systems tab 

Trunk Groups 
tab 

N/A 

Performance: 
Voice 
Conditioner 

Voice Conditioner 
performance shows available 
counts/usage, 
H320/voice/total 
usage/allocation/denials, out-
of-service, and blockage. 
May be filtered by system 
and time. 

Time tab Systems tab N/A 
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Chart Properties Dialog Box 
This dialog box allows you to set charting options for your report. It is accessed by clicking Chart 
on the Format tab of the Report Definition dialog box. 

 

note: 
Scheduling takes place on the Linux server. To create graphics, the X-windowing system MUST 
be started, and must be running when the report runs. 

 

To set chart options, complete the following steps: 

1. Set the chart format by filling in the following fields: 

Field Description 

Chart Type Select the type of chart: Bar, Stacked Bar, Line, or Pie 



Avaya Fault & Performance Manager User Guide 

350 

Field Description 

3D Settings Set the appearance of the chart in three dimensions:  

Elevation - sets the position of the observer above the horizontal 
axis from -45? to +45?. A negative elevation positions the observer 
below the horizontal axis. (Default is 0 for a two-dimensional graph 
only.) 
Depth - sets the depth of the graph as a percent of the width from 
0 - 500%. (Default is 0 for a two-dimensional graph only. In this 
case, both Elevation and Rotation are ignored.) 
Rotation - sets the position of the observer to the right or left of the 
vertical axis from -45? to +45?. (Positive rotation positions the 
observer to the right of the vertical axis; negative rotation positions 
the observer to the left of the vertical axis.) 

Notes: If both Elevation and Rotation are zero (0), the graph is 
two-dimensional and the Depth is ignored. If the Depth is a non-
zero value, and either Elevation or Rotation is a non-zero value, 
then the graph is three-dimensional, but the effect is somewhat flat. 

Tip: To achieve the best 3D effect, each of the above settings 
should be a non-zero value. 

 

X Axis Set the X-axis to one of the Key fields previously defined for the 
report. The default is the voice system date and time. 

Hide Collection Gaps Check to delete gaps in the data. For example, if data collection is 
scheduled only during business hours (9:00 a.m. to 5:00 p.m.), 
setting this option ensures that gaps during off-hours and 
weekends are deleted. 

Create Grouping 

 

Check to group measurements according to the values of one 
grouping field. 

Group By If Create Grouping is checked, select one field from the key fields 
selected on the Fields tab. The default is the voice system name. 

 

Y Axis If Create Grouping is checked, select one Y-axis measurement 
from the non-key numeric fields selected on the Fields tab. The 
default is the first non-key numeric field. 
If Create Grouping is not checked, select up to 10 Y-axis 
measurements from the non-key numeric fields selected on the 
Fields tab. 

Tip: The fields available on the X- and Y-axes are the fields 
selected on the Fields tab. If you set chart properties here and 
then go back and change the selections on the Fields tab, this may 
change the chart in unpredictable ways. 

2. Click Close to close the Chart Properties dialog box. 
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Related Topics 

• How to print a report  
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Report Definitions Display 
This window includes the following information: 

• Alert indicator showing the alert level (if there is a report run failure)  

• The Report Name  

• The Report Type  

• The Time Scale  

• Command buttons 

 New: Displays the New Report dialog box 

 Open: Displays the Report Definitions dialog box for the selected report. This 
button is only active when a report is selected. 

 Exceptions: Displays an Output window showing active report failure exceptions 
for the selected report 

 Delete: Displays a confirmation dialog box to confirm deletion of a report. After 
the deletion is confirmed, the report and schedules are deleted, and the 
corresponding report row in the Report List display is deleted. 

 Help: Displays the online help for the Report Definitions display. 

Related Topics 

• Create a new report  

• View or change report settings  

• Run or schedule a report  

• View a report  

• Print a report  
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Report Output Window 
This window provides the following information: 

• Report name 

• Run date and time 

• Time interval covered by the report (Start date and time and End date and time) 

• Primary data/Secondary data combo selection box (if the report type contains secondary 
data types) 

Menu Options 

The Report Output Window includes the following menu options: 

• File: 

 Open>Chart: Shows the selected report output in chart format (if supported by 
the report type). 

 Open>Table: Shows the selected report output in table format. 

 Save As: Opens a dialog box that lets you save the report as an HTML file. 

 View as HTML: Opens the report output in Internet Explorer. 

 Close: Closes the Report Output window. 

• Tools: 

 Sort: Opens a dialog box that lets you choose sorting options. 

 Acknowledge: Enabled only for an exception report. Acknowledges all 
exceptions on the list. (The exceptions are removed from the list as they have 
presumably been processed.) 

 Configuration: Opens a configuration screen for the hardware highlighted in the 
Report Output Window. (Typical shown below.) 
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 Error Description: Provides an error description for the highlighted error on the 
Error Report. See Associated Errors (next).  

This window provides the following information about selected voice system 
errors: 

 The Maintenance Name. 

 The Error Code. 

 The Alt Name/Aux Data. 

 The Error Description corresponding to the maintenance name/error 
code/Alt Name if supplied by the voice system. If there is no supplied 
description, then "Not Available" appears in the Error Description box.) 

 A Notes text box in which any previous notes are displayed with the date 
and time of the last update, and in which you can enter notes pertaining 
to the error in question. 
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 Command buttons: 

o Save: Saves any modifications. 

o Close: Closes the window. 

o Help: Displays a help window. 

 Associated Errors: Enabled only for an exception report. Opens the Error 
Report for the highlighted alarm. This shows all errors associated with the 
highlighted alarm. 

 

 TroubleShoot > Helper: Enabled only for an exception report. Opens the 
Communication Manager manual page describing the selected exception. The 
manual page may suggest additional tests or corrective actions that can be 
accomplished using the SAT. 

 TroubleShoot > SAT Connection: Enabled only for an exception report. Opens 
the Login dialog box for the selected system. You must have a user account and 
password on the selected system to use the SAT connection. 

• Help 

 Help Topics: Displays the Help Table of Contents 

 Current Pane: Accesses help on the panel in the display pane 

 About: Displays information about Fault and Performance Manager 
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Schedule Report Dialog Box 

 Note: 

You can complete administration functions such as scheduling a report only from the 
server application GUI. Administration functions are not available from the Web client. 

 Note: 

Scheduling takes place on the Linux server. To create graphics, the X-windowing system 
MUST be started, and must be running when the report runs. 

 

This dialog lets you specify when you want a report to run. 

 

1. Select an option button and complete the corresponding fields to define the schedule: 

 Run once at: Enter the date in dd/mm/yy format, and enter the time start time in 
military format (24 hr.) 

 Run daily: Enter the start time in military format (24 hr.) 

 Run weekly: Select a day of the week, and enter the start time in military format 
(24 hr.) 

 Run monthly: Select a day of the month, or select the last day of the month. 

2. Click Save to save your changes or Reset to reset the fields to their previous values. 

3. Select the Start and Stop tab. 
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4. Select the Start Schedule on check box and enter a start date in dd/mm/yy format. 

5. Select the Stop Schedule on check box and enter a stop date in dd/mm/yy format. 

6. Click Save to save your changes or Reset to reset the fields to their previous values. 

Related Topics 

• How to run or schedule a report 
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Trunk Group Lists display 
This display includes the following information: 

• Name of the voice system  

• Name of the Trunk Group List  

• Command buttons  

 New: Displays the New List dialog box 

 Open: Displays the List dialog box for the selected trunk group list. This button is 
only active when a trunk group list is selected. 

 Delete: Displays a confirmation dialog box to confirm deletion of a trunk group 
list. After the deletion is confirmed, the trunk group list is deleted. 

Related Topics 

• How to create a new trunk group list  

• How to add trunk groups to the trunk group list  
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New Trunk Group List Dialog Box 
Clicking New on the Trunk Group Lists display of the Report Manager screen opens the New 
Trunk Group List dialog box. 

 

A trunk group list applies to one system. 

1. Select the system. 

2. Enter a name for the list. 

3. Click OK. 

The Trunk Group List Definition dialog box opens. 

Related Topics 

• Trunk Group List Definition dialog box 

• Trunk Group Lists 
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Trunk Group List Definition dialog box 
The Trunk Group List Definition dialog box displays when you click Open on the Trunk Group List 
display, or when you click OK on the New Trunk Group List dialog box. 

 

All trunk groups on the system associated with this trunk group list are displayed. 

1. Check any or all of the trunk groups. 

2. Click Save. 

Related Topics 

• New Trunk Group Lists dialog box 

• Trunk Group Lists 
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New Report Dialog Box 
Selecting View > Performance Data... from the Configuration and Status screen or the System 
Detail screen opens the New Report Dialog Box. You may also open the New Report Dialog Box 
by clicking New on the Report Definition screen. The New Report Dialog Box is used to select a 
report type and assign a report name. 

 

To define a new report, follow these steps: 

1. Select the report type from the available list.  

FPM displays a description of the selected report type in the information box below the 
report type list box. 

2. Enter a unique name for the new report in the Enter Report Name text box. 

3. Click OK to create the new report. 
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FPM displays the Report Definition Dialog Box. This dialog box contains different tabs 
depending on the type of report you are creating. 

Related Topics 

• Report Definition Dialog Box 

• Report Definition screen 

• How To Create a New Report  

• How To Run or Schedule a Report  

• How To View a Report  

• How To Print a Report  
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Report Definition tabs 
Board Type Tab 
This tab allows you to specify the boards to include in your report. 

 

To make board selections, follow these steps: 

1. On the Select Board Types box, complete the following fields: 

 Include only boards with unassigned ports: Check or clear as desired. 

 All boards: Select to include all boards in your report. 

 Note: 

If you want a more selective report, select either Types including 
or Codes including below.  

If you do not select All boards, then you must enter up to six 
sub-strings to match against board types or board codes plus 
suffixes. The report includes boards that match any one of the 
sub-strings you enter.  
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 Types including: Enter up to six sub-strings of board types to include in your 
report. 

For example if you enter type "line", the report includes boards of types ANALOG 
LINE, BRI LINE, DATA LINE, DIGITAL LINE, and PDATA LINE.  

 Note: 

Types are always uppercase, but the matching ignores case. 

 Codes including: Enter up to six sub-strings of board codes to include in your 
report.  

For example, if you enter code "TN76", the report includes TN760, TN765, and 
TN765C. 

 Note: 

Codes are always uppercase, but the matching ignores case. 

2. After selecting the board types, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Components Tabs 
You can restrict the performance report to one or more components.  

If you selected all voice systems on the Systems tab, then all systems and all components are 
included in the report. In this case, there is no component tab selection.  

If you select specific voice systems in the Systems tab, then you can use the corresponding 
Components tabs to limit report data to specific components. Refer to the following table. 

 

Performance Report Type Tab Title 

Hunt Groups Hunt Groups  

Inter-Port Network Latency PN Connections  

Port Networks Port Networks  

Routing Patterns Routing Patterns  

Switch Node Links Switch Node Links  

Tone Receivers Tone Receivers  

Trunk Groups 
Trunk Groups, ISDN PRI CBC 
Trunk Groups, Wideband 

Trunk Groups  
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Destination Tab 
This tab allows you to select the report output destination and print the reports. 

 

To set the report output destination, follow these steps: 

1. Select one or more of the following report destinations:  

 Screen to send the report to the screen display. 

 Print to send the report to the specified print destination.  

Click the Setup button to specify a print command or a printer for the report or to 
specify height and width of the text on the page.  

 File to send the report to the specified file destination.  

Click the Save As button to specify the directory, file name, and file format 
(ASCII or HTML (default)). 
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 Note: 

The ASCII file format is intended primarily as input to other applications; 
for example, expert systems or spreadsheet programs.  

Select one of the following options: 

 Replace to overwrite the file with the latest data, or  

 Automatically append time stamp to file to create a new report each 
time the report is run  

 E-Mail to send the report to a specified email address. Enter one or more email 
addresses. 

 Note: 

Spaces are invalid in the email address field. If you use internal type 
addresses (such as first initial and last name), specify the first initial, a 
dot, and the last name rather than using spaces. Separate multiple 
entries with commas but no spaces. 

 Note: 

Even when only email output is desired, File must be checked and a 
valid directory on the Linux server is required in the associated text box. 
Click Save As to save the report under a specific name. If you do not 
check File and supply a valid Linux server directory, the resulting file will 
have an incorrect extension. 

If you select E-Mail, you can also select Attachment Type in the Attachment Type 
dialog box: 

 

Selecting HTML (default) generates the report as a web browser readable table. 
Selecting any of the ASCII formats gives delimited fields suitable for importing 
into a spread sheet. For reports that are formatted as charts, an additional choice 
(GIF) is available to present the chart as a picture. 

2. After selecting the output destinations, click another tab to continue defining the report, or 
click one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Note: 

File must be checked and a local PC directory is required in the 
associated text box. Click Save As to save the report under a specific 
name. 

 Schedule 

Opens the Schedule Report dialog box. 

 Note: 

File must be checked and a valid directory on the Linux server is 
required in the associated text box. Click Save As to save the report 
under a specific name. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Fields Tab 
This tab allows you to select the data fields to include in your report. 

 

The list of fields depends on the report type. All fields available in the data records used for the 
report are listed. 

To select the data fields, follow these steps: 

1. Select the data fields to include in the report (by default all data fields are selected.)  

The order of the fields in the report is the same as the order the fields in this list. The 
fields selected here determine the fields that are available for sorting and charting on the 
Sort tab and Format tab respectively. The word "key" in parentheses identifies Key fields. 
These are the fields that uniquely identify a record, for example, date and time, system 
name, and sometimes component identifier (trunk group number). Each report should 
include at least one key field. Some report types have "secondary" data fields. For 
example, a Routing Pattern report has an hourly record for each routing pattern, which is 
called the "primary" record. The data fields in this record are the primary data fields. In 
addition, each primary record has a number of "secondary" records, one for each trunk 
group in the routing pattern. The "secondary" data fields appear in the selection list after 
the primary data fields, and are indicated by a different background color. If you include 
both primary and secondary data fields in a report, the report output shows several tables 
and charts. 
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 Use the Select All button to select all fields.  

 Use the Clear All button to clear any selections. 

2. To select the units in which traffic usage measurements are presented, select one of the 
following options: 

 Note: 

These buttons are only available for Performance reports. 

 Show traffic in CCS 

 Show traffic in Erlangs 

3. After selecting the fields, click another tab to continue defining the report, or click one of 
the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Format Tab 
This tab allows you to select the output format for your report. 

 

 Note: 

Scheduling takes place on the Linux server. To create graphics, the X-windowing system 
MUST be started, and must be running when the report runs. 

 

To set output format options, follow these steps: 

1. Choose the output format for the report by selecting either the Table option button 
(default) or the Chart option button. 

2. If you select the Chart option button, click the Chart options button to specify the Chart 
Properties and click Close when you are done. 

For help completing the fields, click Help on that screen. 

3. After selecting the report format, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 
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 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 

Related Topics 

• Chart Properties Dialog Box 
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Hunt Groups Tab 
This tab allows you to select the hunt groups to include in your report. 

 

To select hunt groups, follow these steps: 

1. Select the Hunt Groups to include in the report.  

Fault and Performance Manager displays a list of hunt groups for the systems selected 
on the Systems tab. The list includes the system name, the hunt group number, and the 
hunt group name, if known. Note that it is possible that Fault and Performance Manager 
may receive performance data for a new hunt group before Fault and Performance 
Manager receives configuration data. In this case, the hunt group name is not shown until 
configuration data is collected. (See Configuration Collection for more information.) 

 Use the Select All button to select all hunt groups.  

 Use the Clear All button to clear any selections. 

2. After selecting the hunt groups, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 
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 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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IP Codecs tab 
This tab allows you to specify which IP codec types to include in your report.  

 

If you select all systems on the Systems tab, then the IP Codecs tab does not allow you to make 
selections. 

To select IP Codecs, follow these steps: 

1. Select the IP Codecs to include in the report.  

Fault and Performance Manager displays a list of IP codecs for the systems selected on 
the Systems tab. The list includes the system name and the codec name. 

 Use the Select All button to select all hunt groups.  

 Use the Clear All button to clear any selections. 

2. After selecting the IP Codecs, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Location Tab for Board Report 
This tab allows you to specify the board information at all or one location to be included in your 
report. 

 

To select exception locations, follow these steps: 

1. In the Select Location box, specify either all boards or specific hardware, port networks, 
or switch nodes at one location. 

 All boards, regardless of location: Select to include all boards. 

 Hardware location: Enter a valid hardware location. (The system does not 
validate this entry. Make sure the spelling is correct.) The report includes all 
exceptions for hardware locations beginning with the specified location string. For 
example, if you enter a carrier location such as 02B, the report includes 
exceptions for that carrier location and exceptions at all boards and ports 
contained in that carrier. 

 Port network number: Enter a valid port network number. (The system does not 
validate this entry. Make sure the number is correct.) 

 Switch node number: Enter a valid switch node number. (The system does not 
validate this entry. Make sure the number is correct.) 
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2. After selecting the location, click another tab to continue defining the report, or click one 
of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Location Tab for Voice System Exceptions Report 
This tab allows you to specify the exceptions at all or one location to be included in your report. 

 

To select exception locations, follow these steps: 

1. In the Select Location box, specify either all exceptions or exceptions at one location. 

 All exceptions, regardless of location: Select to include all exceptions. 

 Hardware location:  

Enter a valid hardware location. (The system does not validate this entry. Make 
sure the spelling is correct.) The report includes all exceptions for hardware 
locations beginning with the specified location string. For example, if you enter a 
carrier location such as 02B, the report includes exceptions for that carrier 
location and exceptions at all boards and ports contained in that carrier. 

 Port network number:  

Enter a valid port network number. (The system does not validate this entry. 
Make sure the number is correct.) 
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 Switch node number:  

Enter a valid switch node number. (The system does not validate this entry. 
Make sure the number is correct.) 

 Trunk or Trunk Group:  

Enter a valid trunk group number or a trunk group and member in the format 
nnnn/mmmm. The report will include alarms, errors, trunk group GOS violations, 
restarts, board conflicts, processor occupancy exceptions, and the four trunk 
exception types, or a subset of these types as specified on the Types tab. (The 
system does not validate this entry. Make sure the entry is correct.) The report 
includes all exceptions that could cause an alert on the specified trunk or trunk 
group. 

 Object type and ID:  

For object type, enter a voice system maintenance name and for object ID, enter 
a voice system ALT name. Up to 12 characters can be entered, including 
alphanumeric, a dash (-), and forward slash (/). Lower case characters are 
converted to upper case. (The system does not validate this entry. Make sure the 
entry is correct.) The report includes all exceptions whose object type and ID 
exactly match the entry in this field. 

 Tips 

 To find all exceptions on a trunk group when you know the trunk group number: 

Select the Trunk or trunk group option button and enter the trunk group 
number, for example "1009". In this case, trunk group GOS violations on the 
specified trunk group, as well as alarms, errors, outages, light usage, and holding 
time exceptions for members of the trunk group, are included in your report. 

 To find all exceptions on a single trunk when you know the trunk group and 
member 

Select the Trunk or trunk group option button and enter the trunk group and 
member, for example "1009/235". In this case, alarms, errors, outages, light 
usage, and holding time exceptions for the specified trunk are included in your 
report. Trunk group GOS violations are not included, since they are trunk group 
alerts rather than trunk alerts. 

or 

If you know the trunk type and the corresponding maintenance name, for 
example "CO-TRK" or "AUX-TRK", select the Object type and ID option button, 
and enter the maintenance name for the object type and the trunk ID for the 
object ID. In this case, only alarms and errors are included in your report, since 
the other exceptions are detected by the application, which assigns an object 
type of "TRUNK". 

 To find exceptions on all trunks of a specific type when you know the 
maintenance name corresponding to the specified type: 

Select the Object type and ID option button and enter the maintenance name for 
the object type. Leave the object ID blank. In this case, all alarms and errors on 
trunks of the specified type are included in your report. Application-detected 
exceptions like trunk outages are not included in your report, since they have 
object type "TRUNK". 

 To find exceptions on a single extension when you know the line type and its 
corresponding maintenance name: 
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Select the Object type and ID option button and enter the maintenance name for 
the object type, for example"ANL-16-L" or "DIG-LINE", and the digits of the 
extension for the object ID. In this case, alarms and errors on the port serving 
that extension are included in your report. 

2. After selecting the location, click another tab to continue defining the report, or click one 
of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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PN Connections Tab 
This tab allows you to select the port network connections to include in your report. 

 

To select the port network connections, follow these steps: 

1. Select the port network connections to include in the report. 

The list shows only connections for which Fault and Performance Manager has collected 
performance data. This will not be all connections, since the voice system limits 
performance data collection to at most 20 connections at a time. 

 Use the Select All button to select all systems.  

 Use the Clear All button to clear any selections. 

2. After selecting the connections, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Port Networks Tab 
This tab allows you to select the port networks to include in your report. 

 

To select the port networks, follow these steps: 

1. Select the port networks to include in the report. 

 Use the Select All button to select all systems.  

 Use the Clear All button to clear any selections. 

2. After selecting the port networks, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Routing Patterns Tab 
This tab allows you to select the routing patterns to include in your report. 

 

To select routing patterns, follow these steps: 

1. Select the routing patterns to include in the report.  

 Use the Select All button to select all systems.  

 Use the Clear All button to clear any selections. 

2. After selecting the routing patterns, click another tab to continue defining the report, or 
click one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Sort Tab 
This tab allows you to select the sort options in your report. 

 

To set sorting options, follow these steps: 

1. From the Sort tab, select how to sort the data rows in the report: 

 Sort first by: select the first sort option from the drop-down list box, and then 
select the Ascending or Descending option button 

 Then by: select the second sort option from the drop-down list box, and then 
select the Ascending or Descending option button 

 Then by: select the third sort option from the drop-down list box, and then select 
the Ascending or Descending option button 

 Note: 

The fields you can sort on are the fields selected on the Fields tab. If you set sort 
fields here and then go back and change the selections on the Fields tab, this 
may change the sort in unpredictable ways. 
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 Tips 

 Sort dates in descending order to get the most recent first. 

 Sort severity in descending order to get the most critical first. 

 Most other fields are usually sorted in ascending order. 

 You can also sort rows after you run the report. 

2. Enter the maximum number of records to be included in the report in the Specify 
maximum records in a report field.  

The default is 1000. 

3. After selecting the sort options, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Switch Node Links Tab 
This tab allows you to select the switch node links to include in your report. 

 

To select switch node links, follow these steps: 

1. Select the switch node links to include in the report.  

 Use the Select All button to select all switch node links.  

 Use the Clear All button to clear any selections. 

2. After selecting the switch node links, click another tab to continue defining the report, or 
click one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Systems Tab 
This tab allows you to select the systems to include in your report. 

 Note: 

You can only select systems for which you have administrative privileges. 

 

 

To select systems, follow these steps: 

1. From the Systems tab, select one or more systems to include in the report.  

 Use the Select All button to select all systems.  

 Use the Clear All button to clear any selections. 

2. After selecting the systems, click another tab to continue defining the report, or click one 
of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Time Tab 
This tab allows you to set time options for your report. 

 

To set time options, follow these steps: 

1. Select the time scale from the drop-down list box: Hourly counts, Daily peaks (default), 
or Weekly peaks. 

 Tips 

 If you select Daily or Weekly peaks, all time windows start and end at 
midnight and the hour field is inactive.  

 If you select Weekly peaks, all time windows start and end at a week 
boundary, Monday 00:00. You can specify a different day; in this case 
when the report is run, the time window expands to the week boundary 
before and after the time window defined. 

1. Choose the time period by selecting one of the following options:  
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 Show data for the previous 

Enter the duration in the corresponding text box. The duration unit is hours, days, 
or weeks depending on the time scale selected. The default is 7 days. 

 Show data for the fixed interval 

Enter the start and end times and days. The end time must be later than the start 
time. The time is in 24-hr. format. Select the time zone: DEFINITY time zone or 
Use Network Manager time zone. DEFINITY time zone refers to the time at 
each monitored voice system. Use Network Manager time zone refers to the time 
on the network management station running the application.  

 Note: 

Reports defined with Daily or Weekly peaks and Show data for the fixed 
interval should also use the voice system time zone. This ensures that if 
a voice system is in a different time zone, all peaks are reported within 
the time window. 

3. After selecting the time information, click another tab to continue defining the report, or 
click one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Time Tab for Exception Report 
This tab allows you to select exception time options in your report. 

 

To set exception time options, follow these steps: 

1. In the Select current exceptions or exception history drop-down list box, select Show 
current exceptions or Show exception history. 

 Note: 

When Show current exceptions is selected, all the other controls in this tab are 
inactive. 

2. Choose the time period by selecting one of the following options:  

 Show data for the previous 

Enter the duration in the corresponding text box. The duration unit is days. The 
default is 7 days. 
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 Show data for the fixed interval 

Enter the start and end times and days. The end time must be later than the start 
time. The time is in 24-hr. format. 

 Select Time zone 

Only applies to a DEFINITY Exception Report. Does not apply to a 
Fault/Performance Manager Exception Report. If you select a fixed window for a 
DEFINITY Exception report, select the time zone. DEFINITY time zone refers to 
the time at each monitored voice system. Network Manager time zone refers to 
the time on the network management station running the application. 

3. After selecting the time information, click another tab to continue defining the report, or 
click one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 

 

 



Avaya Fault & Performance Manager User Guide 

398 

Tone Receivers Tab 
This tab allows you to select the type of tone receivers to include in your report. 

 

To select tone receiver types, follow these steps: 

1. Select the tone receiver types to include in the report. 

 Use the Select All button to select all systems.  

 Use the Clear All button to clear any selections. 

2. After selecting the tone receiver types, click another tab to continue defining the report, or 
click one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Trunk Groups Tab 
This tab allows you to select trunk groups in your report. 

 

To select trunk groups, follow these steps: 

1. Select one of the following options: 

 Trunk Groups to choose one or more trunk groups.  

The displayed list includes the trunk groups for systems selected on the Systems 
tab. The list includes the system name, the trunk group number, and the trunk 
group name, if known. It is possible that Fault and Performance Manager may 
receive performance data for a new trunk group before it receives configuration 
data. In this case, the trunk group name is not shown until configuration data is 
collected. (See Configuration Collection for more information.) 

 Trunk Group Lists to choose one or more trunk group lists.  

The displayed list includes the trunk group lists for systems selected on the 
Systems tab. The list includes the system name and the trunk group list name. 
(See Trunk Group Lists to view and edit the contents of a trunk group list.) 
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 Use the Select All button to select all trunk groups.  

 Use the Clear All button to clear any selections. 

 Note: 

If more trunk group lists are subsequently added, they will not be automatically 
included. You must edit the Report Definition to include the new lists.  

2. After selecting the trunk groups, click another tab to continue defining the report, or click 
one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 

 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Types Tab 
This tab allows you to select the types of exceptions to include in your report. 

 

To select the types of exceptions, follow these steps: 

1. Select the types of exceptions that you want to include in your report by selecting each 
one in the Select Exception Types list box. (At least one type must be selected.) 

 Use the Select All button to select all exception types.  

 Use the Clear All button to clear any selections. 

2. After selecting the exception types, click another tab to continue defining the report, or 
click one of the buttons at the bottom of the screen: 

 Save 

Saves the current report definition. This button is active for new reports that have 
not yet been saved, and for any report to which changes have been made. 
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 Run Now 

Runs the current report on demand. While the report is running, a progress 
dialog box displays information about percentage completion and provides a 
Cancel button to stop the report. A message box appears when the report has 
been run successfully. If the report run fails, a warning dialog box is displayed 
that describes the reason for the failure. 

 Schedule 

Opens the Schedule Report dialog box. 

 Reset 

Resets the report definition to the last saved version. If this is a new report that 
has not yet been saved, the report definition is reset to its initial default values. 

 Cancel 

Cancels the report definition and closes the dialog box without saving any 
changes. 

 Help 

Displays a help screen for the selected tab. 
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Miscellaneous 
Important New Features 

1. New Features in Release 5.0 
• CM-SES Co-residency. - The Avaya Communication Manager (CM) and SIP 

Enablement Server (SES) can be co-resident. This will be indicated in the Server Type 
field of the System Configuration screen. 

• Increased Attendant Consoles. - The Performance: Attendant Groups report can 
display up to 414 attendant consoles based on up to 100 attendant consoles for a 
complex switching system when represented as a "Mega Switch," and up to 314 
attendant consoles for a geographically dispersed network of cabinets/media-
gateways/remote offices. 

• G450 Media Gateway. - The G450 media gateway is supported similarly to other media 
gateways. 

• Transaction Log. - A Transaction Log report has been added to the Exception Report 
group. It logs transactions including the userID, transaction, and results of the 
transaction. 

• Malibu Media Gateways (J2320, J2350, J4350, and J6350). - The Malibu media 
gateways are supported similarly to other media gateways. 

• Filter Types - Filter typesin the Alarm Filter Panel have been simplified. 

• Platform Alarm Filtering. - Alarm filtering for a specific platform can specify a specific 
error code. Alarm filtering can also be specified for restart alarms by level. 

• Additional Maintenance Object (MO) types for Help Desk function: 

 VAL-BD (Voice Announcement over LAN Circuit Pack) 

 DID-TRK (DID Trunk) 

New Features in Release 4.0 
• AAA Server: CM Radius/LDAP Support. - FPM 4.0 uses Common Prompts for 

Automatic Login sequences so that customers will be able to use external authentication 
servers for authentication into CM. 

• Improvements to CM Logging. - CM 4.0 command history (in syslog) includes new 
fields that track variables changed together with original and new values.  A secondary 
user name indicates which FPM user made the changes. (FPM uses a common login to 
CM for all users.) 

Note: list and display type commands do not log the secondary user since they do not 
affect system configuration. 

• Dial Plan Expansion - Extensions may be up to thirteen characters including digits and 
(up to 3) punctuation characters. The use of periods or hyphens to break up long strings 
of digits improves readability and accuracy. 

• Up to 9000 announcements per CM. 

• Support for the S8300C processor board - Replaces earlier S8300x processor boards. 

• Additional Maintenance Object (MO) types for Help Desk function: 

 MG-VOIP (Media Gateway DSP Resources) 

 MG-DS1 (Media Gateway DS1 Trunk) 
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 IPSV-CTL (IP Server Interface Control 

 CLAN-BD (Control LAN Circuit Pack) 

 VAL-BD (Voice Announcement over LAN Circuit Pack) 

 DID-TRK (DID Trunk) 

 ETH-PT (Control LAN Ethernet Port) 

New Features in Release 3.2 
The ability to generate a capacity report that displays available and used capacity information for 
the selected voice systems.  

• Fault and Performance Manager displays only those elements that you have permission 
to administer. (The elements that you can administer are specified in Avaya Integrated 
Management Database.)  

• Distributed database and collection architecture enhancements that enable you to 
manage larger networks of voice systems and adjuncts with improved performance of the 
user interface.  

• Support of a Secure Services Gateway (SSG) as a managed element with Fault and 
Performance Manager and for “modem-free” alarm processing of adjunct/messaging 
alarms.  

New Features in Release 3.1: 
• Support for the following processors and boards: 

 S8720 Next Generation S87xx Server 

 S8400 Server TN Form Factor 

 Support G250-DCP Media Gateway 

 Support G250-T1/E1 Media Gateway 

 16X Analog MM 

 40 Port POE HDMM 

 Crossfire Duplication [TN2602AP]  

• Support for Processor Ethernet and Enhanced LSP 

• Support for Alarm Refinements 

• Managed Security Service 

• Selective Router – Provide audible indication 

• Helpdesk Assist Feature 

• Performance Data Alerting 

• Additional Element Support via SNMP 

Beginning with Release 3.0: 
• Support for the S8500B server 

• Support for the following media modules and boards: 

 G250 Media Gateway 

 Crossfire board - TN2602AP IP media processor 

 MM716 analog 16-port (12 line + 4 trunk) media module 

 MM720 trunk/line side BRI 8-port media module 
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• New user interface that provides a server view, a DCS view, and an IP trunk view of the 
network 

• Support for Enterprise Survivable Servers (ESS), which enables MCC1, SCC1, G600, 
and G650 media gateways to receive control from alternate sources when the primary 
S8500 server or S8700 server cannot communicate with these gateways. 

• Support for the Auto Fail Back Configuration feature, which enables you to configure a 
"recovery rule" for each G250, G350, and G700 media gateway. 

• The ability to receive traps from Avaya Converged Network Analyzer (CNA). 

• The Help Desk feature, which will help you troubleshoot alarms on Avaya Communication 
Manager. 

• Enhanced trunk reports. 

• Additional voice system reports: 

 Collect/Report List Measurement Coverage Path Data - Daily 

 Collect/Report List Measurement Coverage Path Data - Hourly 

 Collect/Report List Measurement Principal Data - Daily 

 Collect/Report List Measurement Principal Data - Hourly 

• Support for third-party voice system report 

• Enhanced trap forwarding and filtering 

• The ability to poll for clear alarms on Avaya Communication Manager  

Beginning with Release 2.1:  
• A user account and password are required to logon to Fault and Performance Manager 

(FPM). 

• Your account and password are assigned by a System Administrator using the Integrated 
Management Database (IMD). In addition to your account and password, you are 
assigned a privilege level. 

• The menus that appear when you use FPM are appropriate for your privilege level. If you 
can’t find a menu or you think a menu is missing, please contact your System 
Administrator and verify that you have the correct privilege level for your needs. 
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Legal Notices 
Copyright 2003-2007, Avaya Inc. 

All Rights Reserved 

Notice 
Every effort was made to ensure that the information in this document was complete and 
accurate at the time of printing. However, information is subject to change. 

Warranty 
Avaya Inc. provides a limited warranty on this product. Refer to your sales agreement to establish 
the terms of the limited warranty. In addition, Avaya’s standard warranty language as well as 
information regarding support for this product, while under warranty, is available through the 
following Web site: http://www.avaya.com/support. 

Preventing Toll Fraud 
“Toll fraud” is the unauthorized use of your telecommunications system by an unauthorized party 
(for example, a person who is not a corporate employee, agent, subcontractor, or is not working 
on your company's behalf). Be aware that there may be a risk of toll fraud associated with your 
system and that, if toll fraud occurs, it can result in substantial additional charges for your 
telecommunications services. 

Avaya Fraud Intervention 
If you suspect that you are being victimized by toll fraud and you need technical assistance or 
support, in the United States and Canada, call the Technical Service Center's Toll Fraud 
Intervention Hotline at 1-800-643-2353. 

How to Get Help 
For additional support telephone numbers, go to the Avaya support Web site: 
http://www.avaya.com/support. If you are: 

• Within the United States, click the Escalation Management link. Then click the 
appropriate link for the type of support you need. 

• Outside the United States, click the Escalation Management link. Then click the 
International Services link that includes telephone numbers for the international Centers 
of Excellence. 

Providing Telecommunications Security 
Telecommunications security (of voice, data, and/or video communications) is the prevention of 
any type of intrusion to (that is, either unauthorized or malicious access to or use of) your 
company's telecommunications equipment by some party. 

Your company's “telecommunications equipment” includes both this Avaya product and any other 
voice/data/video equipment that could be accessed via this Avaya product (that is, “networked 
equipment”). 

An “outside party” is anyone who is not a corporate employee, agent, subcontractor, or is not 
working on your company's behalf. Whereas, a “malicious party” is anyone (including someone 
who may be otherwise authorized) who accesses your telecommunications equipment with either 
malicious or mischievous intent. 

Such intrusions may be either to/through synchronous (time-multiplexed and/or circuit-based) or 
asynchronous (character-, message-, or packet-based) equipment or interfaces for reasons of: 
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• Utilization (of capabilities special to the accessed equipment) 

• Theft (such as, of intellectual property, financial assets, or toll facility access) 

• Eavesdropping (privacy invasions to humans) 

• Mischief (troubling, but apparently innocuous, tampering) 

• Harm (such as harmful tampering, data loss or alteration, regardless of motive or intent) 

Be aware that there may be a risk of unauthorized intrusions associated with your system and/or 
its networked equipment. Also realize that, if such an intrusion should occur, it could result in a 
variety of losses to your company (including but not limited to, human/data privacy, intellectual 
property, material assets, financial resources, labor costs, and/or legal costs). 

Responsibility for Your Company’s Telecommunications 
Security 
The final responsibility for securing both this system and its networked equipment rests with you - 
Avaya’s customer system administrator, your telecommunications peers, and your managers. 
Base the fulfillment of your responsibility on acquired knowledge and resources from a variety of 
sources including but not limited to: 

• Installation documents 

• System administration documents 

• Security documents 

• Hardware-/software-based security tools 

• Shared information between you and your peers 

• Telecommunications security experts 

To prevent intrusions to your telecommunications equipment, you and your peers should carefully 
program and configure: 

• Your Avaya-provided telecommunications systems and their interfaces 

• Your Avaya-provided software applications, as well as their underlying hardware/software 
platforms and interfaces 

• Any other equipment networked to your Avaya products 

TCP/IP Facilities 
Customers may experience differences in product performance, reliability and security depending 
upon network configurations/design and topologies, even when the product performs as 
warranted. 

Standards Compliance 
Avaya Inc. is not responsible for any radio or television interference caused by unauthorized 
modifications of this equipment or the substitution or attachment of connecting cables and 
equipment other than those specified by Avaya Inc. The correction of interference caused by 
such unauthorized modifications, substitution or attachment will be the responsibility of the user. 
Pursuant to Part 15 of the Federal Communications Commission (FCC) Rules, the user is 
cautioned that changes or modifications not expressly approved by Avaya Inc. could void the 
user’s authority to operate this equipment. 

Product Safety Standards 
This product complies with and conforms to the following international Product Safety standards 
as applicable: 
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• Safety of Information Technology Equipment, IEC 60950, 3rd Edition including all 
relevant national deviations as listed in Compliance with IEC for Electrical Equipment 
(IECEE) CB-96A. 

• Safety of Information Technology Equipment, CAN/CSA-C22.2 No. 60950-00 / UL 60950, 
3rd Edition 

• Safety Requirements for Customer Equipment, ACA Technical Standard (TS) 001 - 1997 

• One or more of the following Mexican national standards, as applicable: NOM 001 SCFI 
1993, NOM SCFI 016 1993, NOM 019 SCFI 1998 

The equipment described in this document may contain Class 1 LASER Device(s). These devices 
comply with the following standards: 

• EN 60825-1, Edition 1.1, 1998-01 

• 21 CFR 1040.10 and CFR 1040.11. 

The LASER devices operate within the following parameters: 

• Maximum power output: -5 dBm to -8 dBm  

• Center Wavelength: 1310 nm to 1360 nm 

Luokan 1 Laserlaite 

Klass 1 Laser Apparat 

Use of controls or adjustments or performance of procedures other than those specified herein 
may result in hazardous radiation exposures. Contact your Avaya representative for more laser 
product information. 

Electromagnetic Compatibility (EMC) Standards 
This product complies with and conforms to the following international EMC standards and all 
relevant national deviations: 

Limits and Methods of Measurement of Radio Interference of Information Technology Equipment, 
CISPR 22:1997 and EN55022:1998. 

Information Technology Equipment – Immunity Characteristics – Limits and Methods of 
Measurement, CISPR 24:1997 and EN55024:1998, including: 

• Electrostatic Discharge (ESD) IEC 61000-4-2 

• Radiated Immunity IEC 61000-4-3 

• Electrical Fast Transient IEC 61000-4-4 

• Lightning Effects IEC 61000-4-5 

• Conducted Immunity IEC 61000-4-6 

• Mains Frequency Magnetic Field IEC 61000-4-8 

• Voltage Dips and Variations IEC 61000-4-11 

• Powerline Harmonics IEC 61000-3-2 

• Voltage Fluctuations and Flicker IEC 61000-3-3 
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Federal Communications Commission Statement 
Part 15: 

Note: This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instruction manual, may cause harmful interference to 
radio communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own 
expense. 

Part 68: Answer-Supervision Signaling 

Allowing this equipment to be operated in a manner that does not provide proper answer-
supervision signaling is in violation of Part 68 rules. This equipment returns answer-supervision 
signals to the public switched network when: 

• answered by the called station, 

• answered by the attendant, or 

• routed to a recorded announcement that can be administered by the customer premises 
equipment (CPE) user. 

This equipment returns answer-supervision signals on all direct inward dialed (DID) calls 
forwarded back to the public switched telephone network. Permissible exceptions are: 

• A call is unanswered. 

• A busy tone is received. 

• A reorder tone is received. 

Avaya attests that this registered equipment is capable of providing users access to interstate 
providers of operator services through the use of access codes. Modification of this equipment by 
call aggregators to block access dialing codes is a violation of the Telephone Operator 
Consumers Act of 1990. 

REN Number 
For MCC1, SCC1, CMC1, G600, and G650 Media Gateways: 

This equipment complies with Part 68 of the FCC rules. On either the rear or inside the front 
cover of this equipment is a label that contains, among other information, the FCC registration 
number, and ringer equivalence number (REN) for this equipment. If requested, this information 
must be provided to the telephone company. 

For G350 and G700 Media Gateways: 

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the 
ACTA. On the rear of this equipment is a label that contains, among other information, a product 
identifier in the format US:AAAEQ##TXXXX. The digits represented by ## are the ringer 
equivalence number (REN) without a decimal point (for example, 03 is a REN of 0.3). If 
requested, this number must be provided to the telephone company. 
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For all media gateways: 

The REN is used to determine the quantity of devices that may be connected to the telephone 
line. Excessive RENs on the telephone line may result in devices not ringing in response to an 
incoming call. In most, but not all areas, the sum of RENs should not exceed 5.0. To be certain of 
the number of devices that may be connected to a line, as determined by the total RENs, contact 
the local telephone company. 

REN is not required for some types of analog or digital facilities. 

Means of Connection 
Connection of this equipment to the telephone network is shown in the following tables. 

 

For MCC1, SCC1, CMC1, G600, and G650 Media Gateways: 

Manufacturer’s Port Identifier FIC Code SOC/REN/ 
A.S. Code 

Network Jacks 

Off premises station OL13C 9.0F RJ2GX, RJ21X, RJ11C 

DID trunk 02RV2-T 0.0B RJ2GX, RJ21X 

02GS2 0.3A RJ21X CO trunk 

02LS2 0.3A RJ21X 

Tie trunk TL31M 9.0F RJ2GX 

Basic Rate Interface 02IS5 6.0F, 6.0Y RJ49C 

04DU9-BN 6.0F RJ48C, RJ48M 

04DU9-IKN 6.0F RJ48C, RJ48M 

1.544 digital interface 

04DU9-ISN 6.0F RJ48C, RJ48M 

120A4 channel service unit 04DU9-DN 6.0Y RJ48C 

  

For G350 and G700 Media Gateways: 

Manufacturer’s Port Identifier FIC Code SOC/REN/ 
A.S. Code 

Network Jacks 

Ground Start CO trunk 02GS2 1.0A RJ11C 

DID trunk 02RV2-T AS.0 RJ11C 
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Manufacturer’s Port Identifier FIC Code SOC/REN/ 
A.S. Code 

Network Jacks 

Loop Start CO trunk 02LS2 0.5A RJ11C 

04DU9-BN 6.0Y RJ48C 

04DU9-DN 6.0Y RJ48C 

04DU9-IKN 6.0Y RJ48C 

1.544 digital interface 

04DU9-ISN 6.0Y RJ48C 

Basic Rate Interface 02IS5 6.0F RJ49C 

 

For all media gateways: 

If the terminal equipment (for example, the media server or media gateway) causes harm to the 
telephone network, the telephone company will notify you in advance that temporary 
discontinuance of service may be required. But if advance notice is not practical, the telephone 
company will notify the customer as soon as possible. Also, you will be advised of your right to file 
a complaint with the FCC if you believe it is necessary. 

The telephone company may make changes in its facilities, equipment, operations or procedures 
that could affect the operation of the equipment. If this happens, the telephone company will 
provide advance notice in order for you to make necessary modifications to maintain 
uninterrupted service. 

If trouble is experienced with this equipment, for repair or warranty information, please contact the 
Technical Service Center at 1-800-242- 2121 or contact your local Avaya representative. If the 
equipment is causing harm to the telephone network, the telephone company may request that 
you disconnect the equipment until the problem is resolved. 

A plug and jack used to connect this equipment to the premises wiring and telephone network 
must comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A 
compliant telephone cord and modular plug is provided with this product. It is designed to be 
connected to a compatible modular jack that is also compliant. It is recommended that repairs be 
performed by Avaya certified technicians. 

The equipment cannot be used on public coin phone service provided by the telephone company. 
Connection to party line service is subject to state tariffs. Contact the state public utility 
commission, public service commission or corporation commission for information. 

This equipment, if it uses a telephone receiver, is hearing aid compatible. 

Canadian Department of Communications (DOC) Interference 
Information 
This Class A digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada. 
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This equipment meets the applicable Industry Canada Terminal Equipment Technical 
Specifications. This is confirmed by the registration number. The abbreviation, IC, before the 
registration number signifies that registration was performed based on a Declaration of 
Conformity indicating that Industry Canada technical specifications were met. It does not imply 
that Industry Canada approved the equipment. 

Declarations of Conformity 
United States FCC Part 68 Supplier’s Declaration of Conformity (SDoC) 

Avaya Inc. in the United States of America hereby certifies that the equipment described in this 
document and bearing a TIA TSB-168 label identification number complies with the FCC’s Rules 
and Regulations 47 CFR Part 68, and the Administrative Council on Terminal Attachments 
(ACTA) adopted technical criteria. 

Avaya further asserts that Avaya handset-equipped terminal equipment described in this 
document complies with Paragraph 68.316 of the FCC Rules and Regulations defining Hearing 
Aid Compatibility and is deemed compatible with hearing aids. 

Copies of SDoCs signed by the Responsible Party in the U. S. can be obtained by contacting 
your local sales representative and are available on the following Web site: 
ttp://www.avaya.com/support. 

All Avaya media servers and media gateways are compliant with FCC Part 68, but many have 
been registered with the FCC before the SDoC process was available. A list of all Avaya 
registered products may be found at: http://www.part68.org/ by conducting a search using 
“Avaya” as manufacturer. 

European Union Declarations of Conformity 

 

Avaya Inc. declares that the equipment specified in this document bearing the “CE” (Conformité 
Europeénne) mark conforms to the European Union Radio and Telecommunications Terminal 
Equipment Directive (1999/5/EC), including the Electromagnetic Compatibility Directive 
(89/336/EEC) and Low Voltage Directive (73/23/EEC). This equipment has been certified to meet 
CTR3 Basic Rate Interface (BRI) and CTR4 Primary Rate Interface (PRI) and subsets thereof in 
CTR12 and CTR13, as applicable. 

Copies of these Declarations of Conformity (DoCs) can be obtained by contacting your local sales 
representative and are available on the following Web site: http://www.avaya.com/support. 

Japan 
This is a Class A product based on the standard of the Voluntary Control Council for Interference 
by Information Technology Equipment (VCCI). If this equipment is used in a domestic 
environment, radio disturbance may occur, in which case, the user may be required to take 
corrective actions. 

 

Document Copies 
To order copies of this and other documents: 
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Call:   Avaya Publications Center 
   Voice 1.800.457.1235 or 1.207.866.6701 
   FAX 1.800.457.1764 or 1.207.626.7269 

Write:   Globalware Solutions 
   200 Ward Hill Avenue 
   Haverhill, MA 01835 USA 
   Attention: Avaya Account Management 

E-mail:   totalware@gwsmail.com 

For the most current versions of documentation, go to the Avaya support Web site: 
http://www.avaya.com/support. 
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Trademarks 
AUDIX, CONVERSANT, DEFINITY, and INTUITY, are trademarks or registered trademarks of 
Avaya, Inc. 

All other trademarks or registration marks mentioned in this help system are property of their 
respective owners. 
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Help System 
What Does This Help System Cover? 
Fault and Performance Manager's online help is designed to help you use Fault and Performance 
Manager day-to-day.  

The accompanying printed documentation provides two functions: 

• It is a self-paced training guide for persons interested in increasing their understanding of 
the system. 

• It contains a complete set of on-line help topics. 

For additional information about the following subjects, please see separate documentation: 

• Installing, upgrading, configuring, or removing Fault and Performance Manager 

Please refer to Fault and Performance Manager installation documentation. 

• Your Network Management System (NMS) 

Please refer to the documentation provided with the NMS. 

• Your operating system 

Please refer to the documentation provided with your operating system. 

• Data in the reports that Fault and Performance Manager generates 

Please refer to the documentation provided with your Communication Manager. 
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How To Use Online Help 
What Do You Want To Do? 

• View the table of contents  

• View the index 

• Search the help system  

• Change the font size  

• Print a help topic  

• Exit help  

• Functions not supported  

• What I want to do isn't listed here  

Common Help Problems 

• Hyperlink does not work: 

All hyperlinks should work. Please send us feedback about any broken links and we will 
fix them in the next release of the product. Include the name of the help topic! 

• No index entry for what I am looking for: 

Please send us feedback. 

• Search feature finds no entries for what I am looking for: 

Please send us feedback. 

View the online help Table of Contents (top) 

The Table of Contents provides topics organized for easy access. 

1. Click the Table of button. 

2. To open a book, click on it. 

3. To view a help topic, click on it. 

View the online help Index 

The Index provides topics organized alphabetically by keywords assigned by the author of the 
help system. 

1. Click the button. 

2. Either: 

 Type the word you are looking for and press Enter, or 

 Scroll down to the index entry you want. 

3. Click the help topic you want to view. 

Search the online help system (top) 

The Search feature provides a full text search. 

1. Click the button. 

2. Type the word you are looking for and press Enter. 

3. Click any of the topics that  appear in the list. 
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 Note: 

You can also use the general  box near the top right corner of 
the screen to search. The effect is to automatically click the Search button, copy the 
contents of the search box to the input field, and find a list of topics that contain it. 

Change the Help Font Size (top) 

Font size is the size of characters in the online help. The Fault and Performance Manager help 
system does not allow you to change the type size displayed. However, if you find the type size to 
be a problem, send us your feedback! We take your comments into account each time we update 
the help system. 

Print a Help Topic (top) 

• To print a help topic, display the help topic (as described above) and then click the 

browser  button.  

• To set up your printer, click the browser  button. 

Exit Help (top) 

• To exit the online help, click the "X" at the top right corner of the help window. 

Functions Not Supported (top) 

• Print all help topics (See Printed Documentation.) 

• Add my own notes to a help topic 

• Bookmark a topic 

• Make the help system stay on top of the application 

• Change the size of the typeface within help topics 

What I Want to do isn't Listed Here (top) 

As the authors of this online help system, we have made every effort to anticipate your questions 
and information needs. However, in this instance, we obviously missed!  

You can help us improve this online help system by telling us more about the situation you are in 
and the precise information you were looking for. Feel free to send us suggested text for a new 
link! Or a suggestion for a new topic! Or just tell us what you were looking for. 

We keep a record of all the customer comments that we receive. With each new release, we go 
through the list and implement fixes for as many of the comments as we can. 

You can put your suggestion on our list by contacting us at the email address listed in the topic, 
Giving Us Your Feedback. Thanks in advance for your comments and suggestions! 
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Contacting Us 
Before You Call 
Before you call, please have the following information available: 

• your name and number (in case we need to call you back) 

• your installation location (IL) number 

• your company’s main phone number 

• the type of voice system 

• the version of Fault and Performance Manager/Proxy Agent you are using 

• the name of a person at your location who can help execute troubleshooting activities 

• whether or not you have set up remote access on the Fault and Performance 
Manager/Proxy Agent server, and what the access information is to remotely access that 
computer 

Remember, if the problem is with equipment or service outside of your own equipment, you need 
to call your vendor or service provider. If you determine that the problem is with your own 
equipment, such as on your own stations, switch, or trunks, give Avaya a call.  

Be ready to talk about: 

• the problem you want to solve 

• a log of the steps you took and the information you gathered while performing your 
diagnosis of the problem 

• if the problem is with a new component or feature 

• if something that used to work now does not work 

• any numbers involved with the problem (for example, extensions or phone numbers, 
trunk group numbers, phone types, or report types) 

• the contents of any recorded messages received 

• error messages from the switch 

• type of ringback tones received on phones 

• the names and numbers of your vendors 

• any other pertinent information 

Related Topics 

• General Contact Information  

• Technical Support  

• Contacting us about documentation  

• Contacting us about training  

• Giving us your feedback  
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General Contact Information 

For… Contact… 

Avaya’s Home Page www.avaya.com  

Avaya products www.avaya.com 
Then click Solutions, Products, & Services. 

Online product catalog www.avaya.com 
Then click How to Buy. 

Security products and services www.avaya.com 
Then click Solutions, Products, & Services. 
Then click VPN and Security. 

International Alliance of Avaya Users (InAAU) www.inaau.org 

Related Topics 

• Technical Support  

• Contacting us about documentation  

• Contacting us about training  

• Giving us your feedback  
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Technical Support 
Before you call, prepare the information that the helpline needs. 

For customers located in the US: 

For help with… Contact this resource: Contact Information 

Fault and Performance 
Manager 

Avaya’s Technical Services 
Organization  

1 800 242 2121,  
ext 4-1080 
or 720 444 1080 

Communication Manager 
software features and 
administration 

Avaya’s Communication 
Manager Helpline 

1 800 225 7585 

Communication Manager 
maintenance and repair 

Avaya’s Technical Services 
Organization 

1 800 242 2121 

Messaging systems Avaya Technical Services 
Organization 

1 800 242 2121 

Toll fraud Avaya’s Technical Services 
Organization 
(Toll Fraud Helpline) 

1 800 643 2353 

Web-based technical support Avaya’s Customer Support 
web site 

www.avaya.com 
Then click Support. 
Then click Online Services. 

For customers located outside the US: 

Contact your local distributor or Avaya representative. 

Related Topics 

• General Contact Information  

• Contacting us about documentation  

• Contacting us about training  

• Giving us your feedback  
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Giving Us Your Feedback 

To… Contact… 

by e-mail document@avaya.com 
Subject line: FPM Help Topic "<Name of topic>" 
feedback.  

Do NOT send product support questions or 
product enhancement requests to this e-mail 
address. 

by fax + 1 732 852 2469 
Attention: FPM Documentation 

Offer comments on the online 
help 

by mail FPM Documentation Team 
Room 3C-313 
307 Middletown Lincroft Road 
Lincroft, NJ 07738-1526 
USA  

Share information with other 
Avaya users 

over the web www.inaau.org 

Related Topics 

• General Contact Information  

• Technical Support  

• Contacting us about documentation  

• Contacting us about training  



Avaya Fault & Performance Manager User Guide 

424 

Contacting Us for Documentation 

To Use this resource Contact Information 

View documentation published 
after December 1, 1999 

Recent Documents www.avaya.com 
Then click Support. 
Then click Product 
Documentation. 

Order documentation by mail Avaya Publications Center Globalware Solutions 
148 Ward Hill Avenue 
Haverhill, MA 01835 
USA 

Order documentation by 
phone or fax 

Avaya Publications Center 1 800 457 1235 (phone) 
1 800 457 1764 (fax) 

If you cannot dial US 1-800 
numbers, then dial: 

+1 410 568 3680 (phone) 
+1 410 891 0207 (fax) 

Related Topics  

• General Contact Information  

• Technical Support  

• Contacting us about training  

• Giving us your feedback  
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Contacting Us About Training 
For customers located in the US: 

To Use this resource Contact Information 

Search an online catalog of 
classes, videotapes, and 
computer-based training 

Avaya training web site www.avaya.com 
Then click Training. 

Register for classes Avaya University 
Registration Center 

1 800 255 8988 

For customers located outside the US: 

Contact your local distributor or Avaya representative. 

Related Topics 

• General Contact Information  

• Technical Support  

• Contacting us about documentation  

• Giving us your feedback  
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Glossary 

A 
AFI: Authority and format identifier. 

Alert: An exception that meets user-defined criteria for signaling an alert on the main 
application window. See also Exception. 

Alt Name: The equipment identifier associated with a voice system alarm or error, for 
example, trunk group and member, or extension. See also Maintenance name. 

ATM: Asynchronous Transmission Mode. 

ATM PNC: ATM Port Network Connectivity. A voice system feature that supports port 
network connections through an ATM network. 

Aux data: Another term for Alt name. 

B 
BRI: Basic Rate Interface 

C 
CBC: Call-by-call. 

CSU: Channel Service Unit. 

D 
DCS: Distributed Communications System 

DS1: Digital Signal 1. 

E 
EI: Expansion Interface. A Port Network board. 

EPN: Expansion Port Network. 

Equipment identifier: Equipment associated with an exception, if any. It may be a voice 
system extension for an alarm or error, or a trunk group number or group and member for 
an exception detected by Fault and Performance Manager. 

Equipment type: Type of equipment associated with an exception, if any. It may be a voice 
system maintenance name for an alarm or error, or for a board, trunk, or trunk group for 
an exception detected by Fault and Performance Manager. 

Exception: A condition in a managed node or in the NMS that requires the attention of a 
network manager. It may be a voice system alarm, a performance exception, or a Fault 
and Performance Manager failure. 

G 
GUI: Graphical User Interface. 



Avaya Fault & Performance Manager User Guide 

428 

H 
Hardware location: A string that locates voice system hardware at one of four levels:Cabinet 

(for example, 02)Cabinet and carrier (for example, 02B)Cabinet, carrier, and slot (for 
example, 02B06, or 01A TAPE)Cabinet, carrier, slot, and port (for example, 02B0602) 

I 
ISDN: Integrated Service Digital Network. 

M 
Maintenance name: The equipment type associated with a voice system alarm or error, for 

example "DIG-LINE"or "PDMODULE". See also Alt Name. 

MCU: Multipoint Conferencing Unit. 

Mtce name: See Maintenance Name 

N 
NMS: Network Management System. A general network management application (for 

example,HP Open View). 

P 
Pane: A rectangular area of a window that contains a logical grouping of data. Many Fault 

and Performance Manager windows show a left-hand pane with a navigation tree, and a 
right-hand pane that contains information corresponding to the selected tree node. 

PNC: Port network connection or port network connectivity. See also ATM PNC, EI. 

PPN: Processor Port Network. 

PRI: Primary Rate Interface. 

Proxy Agent: Avaya Proxy Agent (MPA). The system that fulfills SNMP requests for voice 
system data. 

S 
SNMP: Simple Network Management Protocol. A de facto industry standard, network 

management protocol used by Fault and Performance Manager. 

SPE: Switch Processor Element. 

SRP: Survivable Remote Processor. 

T 
TTI: Teletype Terminal Interface. 
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W 
Window: A self-contained part of a GUI application. A rectangular area of the screen which 

may be enclosed by standard window decorations like a border, a title, and resize 
handles. 
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A 
Alarm Filter Panel ......................48, 156, 290 

alarm levels 
changing...............................................155 

alarm levels..............................................155 

Alarms and Errors............. 48, 156, 290, 297 

C 
Clusters Tab ..............................................16 

contacting us 
about training .......................................452 
Before you call .....................................446 
for documentation ................................451 
General Contact Information................448 
Technical Support ................................449 

contacting us............................................452 

D 
data 

setting collection parameters ...............150 
that you can collect ................................67 

data ..........................................................150 

DCS Trunk Connectivity Tab .....................14 

F 
feedback ..................................................450 

H 
help 

using.....................................................443 

help ..........................................................443 

I 
Important New Features ..........................429 

IP Trunk Connectivity Tab .........................15 

N 
network 

viewing .................................................148 

network ....................................................148 

network views ............................................20 

O 
Overview......................................................1 

R 
reports 

changing settings .................................178 
creating ................................................179 
printing .................................................183 
running .........................................176, 181 

scheduling ........................................... 181 
viewing ................................................ 182 
viewing settings ................................... 178 

reports ............................................... 82, 170 

reports ..................................................... 368 

S 
screens 

Alarms and Errors panel ..................... 297 
Board Display ...................................... 313 
Board Display - ATM ........................... 315 
Boards Display .................................... 317 
Bulletin Board Display ......................... 318 
Busy Out/Release Results Display ..... 319 
Cabinet Display ................................... 321 
Carriers Display................................... 324 
Chart Properties dialog box......... 132, 374 
Configuration Collection panel ............ 299 
Data Modules Display ......................... 325 
DCS Connectivity Display ................... 326 
DCS Link Display ................................ 327 
Detailed Cabinet Display ..................... 322 
Fiber Link Display................................ 353 
FPM Administration Window ............... 288 
LSP Configuration Display .................. 328 
LSP Server Configuration Display....... 329 
main window........................................ 285 
Media Gateway Stack Display ............ 332 
Media Gateway Stacks Display........... 330 
Media Module Configuration and Status 
Display................................................. 334 
Media Modules Display ....................... 335 
Performance Collection panel ............. 300 
PNC Status Display............................. 347 
Port Display - Data Module ................. 338 
Port Display - General ......................... 337 
Port Display - Trunk............................. 341 
Port Network ATM Link Display .......... 343 
Port Network Connectivity Graphical 
Display - ATM...................................... 344 
Port Network Connectivity Graphical 
Display - Center Stage ........................ 345 
Port Network Connectivity Graphical 
Display - Direct Connect ..................... 346 
Port Network Connectivity Table Display - 
ATM..................................................... 348 
Port Network Connectivity Table Display - 
Center Stage ....................................... 349 
Port Network Connectivity Table Display - 
Direct Connect..................................... 351 
Port Network display ........................... 352 
Processor Occupancy Exceptions panel
............................................................. 307 
Report Definitions display ................... 377 
Report Output Window................ 188, 378 
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Routing Pattern Display .......................355 
Routing Patterns Display .....................354 
Schedule Report dialog box 143, 192, 381 
Stations Display ...................................357 
Switch Node Display ............................358 
System Configuration Display..............359 
System Group Graphic Display............360 
System Group Table Display ...............361 
System Groups Administration panel...308 
System Status Display .........................362 
Trunk Exceptions panel .......................309 
Trunk Group Display ............................363 
Trunk Group Exceptions panel ............311 
Trunk Group Lists display ....................383 
Trunk Groups Display ..........................365 

screens ....................................................315 

system groups 
creating ................................................153 
moving a system to a new ...................154 

system groups .........................................153 

System Groups Tab...................................13 

T 
tabs 

Board Type tab...............................95, 388 
Components Tabs................................390 
Destination tab .............................139, 391 
Fields tab......................................135, 394 
Format tab....................................130, 396 

Hunt Groups tab .......................... 101, 398 
IP Codecs tab.............................. 103, 400 
Location tab for Board Report ..... 105, 402 
Location tab for Voice System Exceptions 
Report.......................................... 107, 404 
PN Connections tab for the Inter-Port 
Network Latency Report.............. 110, 407 
Port Networks tab........................ 114, 409 
Routing Patterns tab.................... 116, 411 
Sort tab........................................ 137, 413 
Switch Node Links tab................. 118, 415 
Systems tab................................... 93, 417 
Time tab ...................................... 120, 419 
Time tab for Exception Report .... 122, 421 
Tone Receivers tab ..................... 124, 423 
Trunk Groups tab ........................ 126, 425 
Types tab..................................... 128, 427 

tabs ......................................................... 130 

tabs ......................................................... 396 

trunk groups 
adding to.............................................. 152 
creating new ........................................ 151 

trunk groups ............................................ 152 

V 
viewing 

network .......................................... 20, 148 

viewing .................................................... 148 

 


